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3 1. Présentation

Caractéristiques
Nouveau capteur d’image CMOS plein 
format 8.6K 36 mm × 24 mm (MPC-3628)

Le MPC-3628 est équipé d’un nouveau capteur 
d’image CMOS plein format 8.6K 36 mm × 
24 mm et peut enregistrer des images jusqu’à 
8640×5760 pixels.* En changeant le mode 
d’imageur, l’appareil prend en charge la 
résolution de pixels 5792×3056 standard Super 
35mm 24,1 mm × 12,7 mm, et la résolution 
de pixels 5792×4854 anamorphique 6:5, 
Super 35mm 24,1 mm × 20,2 mm.* Ceci rend 
l’appareil plus efficace non seulement pour la 
production de contenu 8K mais aussi pour le 
compositing VFX. Il est également possible de 
produire un contenu 4K de haute qualité en 
suréchantillonnant à partir d’un contenu de 
résolution 8.6K.
* Les modes plein format et anamorphique requièrent 

des licences vendues séparément.

Capteur d’image CMOS plein format 6K 
36 mm × 24 mm (MPC-3626)

Le MPC-3626 est doté du même capteur 
d’image que le VENICE (MPC-3610) et 
prend en charge la capture d’image à des 
résolutions allant jusqu’à 6048×4032 pixels.* 
En changeant le mode d’imageur, cet appareil 
peut prendre en charge la résolution de pixels 
4096×2160 standard Super 35 mm 24,3 mm 
× 12,8 mm (équivalent à un film cinéma à 
3 perforations) et la résolution de pixels 
4096×3024 anamorphique 4:3, Super 35 mm 
24,3 mm × 18,3 mm (équivalent à un film 
cinéma à 4 perforations).*
* Les modes plein format et anamorphique requièrent 

des licences vendues séparément.

Deux capteurs d’image 
interchangeables

Le capteur d’image 8.6K et le capteur 
d’image 6K sont tous deux compatibles 

avec le système, ce qui permet à l’utilisateur 
d’interchanger le capteur d’image utilisé pour 
l’opération. Le bloc d’imageur VENICE (MPC-
3610) est également compatible et peut être 
fixé sur le MPC-3628/3626.

Latitude étendue

Le MPC-3628 prend en charge 16 paliers de 
latitude, tandis que le MPC-3626 prend en 
charge 15+ paliers de latitude. Il comprend 
très peu de bruit pour fournir des images 
incroyables dans des conditions allant 
d’un ensoleillement intense à une absence 
presque totale de lumière, offrant ainsi une 
liberté créative sans précédent en matière de 
gradation.

Capture d’espace de couleur étendu

Les images peuvent être tournées dans un 
espace de couleur dépassant DCI-P3. Le 
degré de liberté en matière de gradation est 
considérablement amélioré lors de l’utilisation 
des espaces de couleur S-Gamut3 et 
S-Gamut3.Cine de Sony avec S-Log3.

Double Base ISO

Deux types de sensibilité de base sont pris 
en charge. L’utilisation du réglage Base ISO 
faible (MPC-3628 : ISO 800, MPC-3626 : ISO 
500) dans des conditions d’éclairage normales 
ou du réglage Base ISO élevé (MPC-3628 : 
ISO 3200, MPC-3626 : ISO 2500) dans des 
conditions de faible éclairage vous permet 
de maintenir l’équilibre de latitude entre les 
hautes et les basses lumières lors de la prise 
de vue, sans grainage (bruit).

Monture d’objectif PL

Équipé de la monture d’objectif PL standard 
du secteur. La monture de l’objectif prend 
en charge la technologie Cooke/i et les 

informations d’objectif sont enregistrées en 
tant que métadonnées image par image. La 
distorsion de l’objectif et les métadonnées 
d’ombrage sont enregistrées, compatibles 
avec la technologie de métadonnées de 
troisième génération /i (/i3) de Cooke et la 
technologie ZEISS eXtended Data.

Support d’objectif à monture E

Les objectifs à monture E sont pris en charge 
si vous retirez l’adaptateur d’objectif PL. Les 
objectifs à monture E sont plus petits et légers 
que les objectifs PL et sont disponibles dans 
une large gamme, pour élargir vos possibilités 
de reproduction d’image.

Extension de bloc d’imageur

Sur le MPC-3626 équipé d’un capteur d’images 
6K, le bloc d’imageur peut être étendu à 
partir du boîtier de caméra de 2,7 m (8,9 ft) 
ou de 5,5 m (18 ft) en connectant le système 
d’extension de caméra CBK-3610XS, qui 
permet également de réaliser des prises de 
vue avec une tête de caméra plus compacte.

Filtre ND optique à 8 positions

Utilise un filtre ND optique à 8 positions. Il 
offre une plage ND étendue de 0.3ND (1/2 = 
1 diaph) à 2.4ND (1/256 = 8 diaphs) qui permet 
de réduire le temps perdu à changer des filtres 
ND externes sur le tournage. Le mécanisme 
du filtre ND est servocommandé et peut être 
commandé depuis un ordinateur, une tablette 
ou un contrôleur RM/RCP.

Prise de vue à fréquence d’images 
élevée (HFR)

Le capteur d’image 8.6K peut enregistrer 
X-OCN à des fréquences d’images allant 
jusqu’à 90 FPS, tandis que le capteur d’image 
6K peut enregistrer X-OCN jusqu’à 120 FPS.

Formats d’enregistrement 4K ProRes et 
X-OCN

Les vidéos peuvent être enregistrées en 
X-OCN ou 4K ProRes 16 bits, en tant que 
formats d’enregistrement standard, sur des 
cartes mémoire AXS. X-OCN est un format qui 
peut être traité en natif par de nombreux NLE 
et outils d’étalonnage, et il est enregistré à 
la pleine résolution de chaque capteur dans 
chaque mode. 4K ProRes est largement utilisé 
comme format vidéo 4K, et l’image capturée 
par chaque capteur d’image dans chaque 
mode est suréchantillonnée* et enregistrée en 
4K ProRes.
* Lorsque vous utilisez le capteur d’images 6K (MPC-

3626) en mode d’imageur 4K 17:9, 4K 16:9 ou 4K 
2.39:1, l’image 4K capturée est enregistrée telle 
quelle.

Boîtier compact et fonctionnement 
intuitif

Un design relativement compact pour un 
périphérique équipé d’un grand capteur 
d’image plein format, obtenu grâce la 
technologie de miniaturisation de Sony, qui 
permet une prise de vue plus facile dans 
des espaces confinés ou sur des drones. La 
position, la forme et la taille des boutons de 
commande répondent aux exigences des 
opérateurs du caméscope en matière de 
fonctionnement intuitif. Les boutons sont 
également rétroéclairés pour une utilisation 
plus facile dans des endroits sombres.

Conçu pour résister

Le châssis est fabriqué en alliage de 
magnésium pour une grande robustesse et 
grande durabilité. Le système de ventilation 
est complètement isolé de tous les 
composants électroniques pour empêcher 
toute pénétration de poussière, de sable ou de 
liquides.* Le ventilateur silencieux peut être 
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retiré et nettoyé facilement sur le tournage, 
pour maintenir un niveau de redondance 
élevé.
* Le design protège de la poussière et de la pluie, mais 

ne peut pas complètement empêcher la poussière et 
les liquides de pénétrer.

Conception modulaire

La conception entièrement modulaire vous 
permet de prendre en charge de manière 
flexible différents rigs et équipements 
périphériques en fonction de l’application 
de prise de vue. La poignée supérieure et le 
viseur peuvent être facilement réglés pour 
maintenir l’équilibre ergonomique et la facilité 
d’utilisation avec les objectifs.

Utilisation intuitive et familière sur le 
lieu de tournage

L’écran de menu est disponible des deux 
côtés du caméscope, avec l’écran de contrôle 
principal situé sur le côté du caméscope pour 
que l’assistant caméraman puisse accéder 
rapidement aux réglages du caméscope 
pendant le tournage. Un mini-écran OLED 
situé sur le côté de l’opérateur du caméscope 
permet à l’opérateur d’accéder aux fonctions 
courantes, telles que la position de filtre ND, 
l’obturation, la balance des blancs, l’indice 
d’exposition (EI), et la fréquence d’images 
(FPS) permettant ainsi à celui-ci de vérifier de 
manière confortable l’état de l’appareil.

Contrôle de la palette de peinture à 
partir d’une RM/RCP et cet appareil

L’appareil prend en charge la commande à 
partir d’un panneau de télécommande RM/
RCP qui peut être utilisé avec les caméscopes 
de diffusion et les caméras système. Le 
réglage de divers éléments de la palette de 
peinture est pris en charge. Les opérations 
de contrôle de la palette de peinture sont 

également prises en charge à l’aide du menu 
complet de l’appareil. Taille d’image effective

L’appareil prend en charge la prise de vue dans les tailles d’image effective suivantes.

MPC-3628

[Remarque]
Une licence logicielle est nécessaire pour enregistrer en 8.6K 3:2, 8.2K 17:9, 7.6K 16:9 et 5.8K 6:5.

8.6K 3:2 

5.8K 6:5

5.8K 17:9

5.4K 16:9 

7.6K 16:9

8.2K 17:9
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MPC-3626

[Remarque]
Une licence logicielle est nécessaire pour enregistrer en 6K 3:2, 6K 1.85:1, 6K 17:9, 6K 2.39:1, 5.7K 16:9, 4K 6:5, 4K 4:3 et 
4K 4:3 Surround View.

6K 3:2

6K 1.85:1

6K 17:9

4K 6:5

4K 4:3

6K 2.39:1

4K 2.39:1

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

5.7K 16:9

Licences logicielles

Vous pouvez sélectionner les licences logicielles (optionnelles) en fonction de l’utilisation prévue 
de l’appareil.
Les licences logicielles sont installées à l’aide de Maintenance > License Options (page 94) 
dans le menu complet.

MPC-3628

Licence logicielle Mode 
d’imageur

Nombre de pixels 
effectifs 
(Pixels de l’image)

L × H (mm) Fréquence d’images du 
projet

LICENCE PLEIN FORMAT 1) 8.6K 3:2 8640 × 5760 35,9 × 24,0 23, 24, 25, 29

8.2K 17:9 8192 × 4320 34,1 × 18,0 23, 24, 25, 29, 47, 50, 59

7.6K 16:9 7680 × 4320 32,0 × 18,0 23, 24, 25, 29, 50, 59

LICENCE 
ANAMORPHIQUE

5.8K 6:5 5792 × 4854 24,1 × 20,2 23, 24, 25, 29, 47

Licence non requise 1) 5.8K 17:9 5792 × 3056 24,1 × 12,7 23, 24, 25, 29, 47, 50, 59

5.4K 16:9 5434 × 3056 22,6 × 12,7 23, 24, 25, 29, 50, 59

1) La licence anamorphique est requise pour permettre des réglages de rapports, autres que Off(1.0×), pour la 
fonction de décompression.
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MPC-3626

Licence logicielle Mode 
d’imageur

Nombre de pixels 
effectifs 
(Pixels de l’image)

L × H (mm) Fréquence d’images du 
projet

LICENCE PLEIN FORMAT 1) 6K 3:2 6048 × 4032 35,9 × 24,0 23, 24, 25, 29, 47, 50, 59

6K 1.85:1 6054 × 3272 36,0 × 19,4 23, 24, 25, 29, 47, 50, 59

6K 17:9 6054 × 3192 36,0 × 19,0 23, 24, 25, 29, 47, 50, 59

6K 2.39:1 6048 × 2534 35,9 × 15,0 23, 24, 25, 29, 47, 50, 59

5.7K 16:9 5674 × 3192 33,7 × 18,9 23, 24, 25, 29, 50, 59

LICENCE 
ANAMORPHIQUE

4K 6:5 4096 × 3432 24,3 × 20,4 23, 24, 25, 29, 47, 50, 59

4K 4:3 4096 × 3024 24,3 × 18,0 23, 24, 25, 29, 47, 50, 59

4K 4:3 
Surround View

4096 × 3024
(4552 × 3360)

24,3 × 18,0
(27,0 × 20,0)

23, 24, 25, 29

Licence non requise 1) 4K 17:9 4096 × 2160 24,3 × 12,8 23, 24, 25, 29, 47, 50, 59

4K 17:9 
Surround View

4096 × 2160
(4552 × 2400)

24,3 × 12,8
(27,0 × 14,3)

23, 24, 25, 29

4K 2.39:1 4096 × 1716 24,3 × 10,3 23, 24, 25, 29, 47, 50, 59

3.8K 16:9 3840 × 2160 22,8 × 12,8 23, 24, 25, 29, 50, 59

3.8K 16:9 
Surround View

3840 × 2160
(4268 × 2400)

22,8 × 12,8
(25,4 × 14,3)

23, 24, 25, 29

1) La licence anamorphique est requise pour permettre des réglages de rapports, autres que Off(1.0×), pour la 
fonction de décompression.

Fréquence d’images de prise de vue et valeurs De-squeeze prises en 
charge

Le tableau suivant indique les fréquences d’images de prise de vue prises en charge et les 
valeurs De-squeeze (page 74) dans chaque mode d’imageur.

[Remarque]
Le tableau suivant indique les fréquences d’images de prise de vue prises en charge lorsque le format vidéo 
est X-OCN. Pour ProRes, les fréquences d’images de prise de vue maximales prises en charge sont différentes 
(page 44).

LICENCE PLEIN FORMAT LICENCE ANAMORPHIQUE

MPC-3628

Mode d’imageur Fréquence d’images de prise 
de vue

De-Squeeze

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

8.6K 3:2 1 à 30 Oui Oui Oui Oui Oui Oui Oui

8.2K 17:9 1 à 60 Oui Oui Oui – Oui Oui Oui

7.6K 16:9 1 à 60 Oui – – – – – –

5.8K 6:5 1 à 48 Oui – – – – – Oui

5.8K 17:9 1 à 60, 66, 72, 75, 88, 90 Oui Oui Oui – Oui Oui Oui

5.4K 16:9 1 à 60, 66, 72, 75, 88, 90 Oui – – – – – –
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MPC-3626

Mode d’imageur Fréquence d’images de prise 
de vue

De-Squeeze 

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

6K 3:2 1 à 60 Oui Oui Oui Oui Oui Oui Oui

6K 1.85:1 1 à 60, 66, 72 Oui – – – – – –

6K 17:9 1 à 60, 66, 72 Oui Oui Oui – Oui Oui Oui

6K 2.39:1 1 à 60, 66, 72, 75, 88, 90 Oui – – – – – –

5.7K 16:9 1 à 60, 66, 72 Oui – – – – – –

4K 6:5 1 à 60, 66, 72 Oui – – – – – Oui

4K 4:3 Surround 1 à 30 Oui – Oui – Oui Oui Oui

4K 4:3 1 à 60, 66, 72, 75 Oui – Oui – Oui Oui Oui

4K 17:9 Surround 1 à 48 Oui Oui Oui – Oui Oui Oui

4K 17:9 1 à 60, 66, 72, 75, 88, 90, 96, 
100, 110

Oui Oui Oui – Oui Oui Oui

4K 2.39:1 1 à 60, 66, 72, 75, 88, 90, 96, 
100, 110, 120

Oui – – – – – –

3.8K 16:9 Surround 1 à 48 Oui – – – – – –

3.8K 16:9 1 à 60, 66, 72, 75, 88, 90, 96, 
100, 110

Oui – – – – – –

Surround View (MPC-3626)

Le mode Surround View est disponible dans les modes d’imageur suivants et permet d’afficher 
une plage d’image comprenant une zone extérieure de 5%, au-delà de la taille d’image effective 
(haut/bas/gauche/droite), sur la sortie du moniteur SDI et du viseur, pour que vous puissiez 
bénéficier d’une plage d’image plus large pour la prise de vue. La zone d’image enregistrée ne 
comprend pas la zone extérieure.
4K 4:3
4K 17:9
3.8K 16:9

[Remarques]
 • Dans ce mode, il est possible que des limites s’appliquent sur le réglage de fréquence d’images du projet 

maximum.
 • En mode 4K 4:3 avec un rapport de décompression de 2.0×, la zone d’image inclut seulement 5% des zones 

extérieures supérieures et inférieures.
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Configuration du système

* Pris en charge pour le capteur d’image 6K uniquement

MPC-3628/
MPC-3626

Adaptateur d’épaule 
VCT-FSA5

Viseur 
DVF-EL200
(Un câble de viseur A-2203-745-A (fourni avec 
l’appareil) ou 1-912-598-21 est nécessaire)

Microphone 
ECM-680S, ECM-678, ECM-674 
(EC-0.5X3F5M est requis)

Ensemble de base de support de microphone 
(A-2182-620-B)
Attache de tige (A-2182-621-B)
Tige (4-684-612-01)
Ensemble de support de microphone (X-2596-733-2)
Vis P2.6×8 (2) (7-627-556-98)

Pack de batteries 
BP-GL95B

Objectif PL S35 
SCL-PK6, 
SCL-P11X15

LICENCE 
ANAMORPHIQUE 
CBKZ-3620A, 
CBKZ-3620AM, 
CBKZ-3620AW

LICENCE PLEIN 
FORMAT 
CBKZ-3620F, 
CBKZ-3620FM, 
CBKZ-3620FW

Objectif anamorphique
(Monture PL / monture 
E)

Système d’extension de 
caméra  
CBK-3610XS*

Adaptateur LAN sans fil 
5 GHz/2,4 GHz 
CBK-WA02

Objectif plein format
(Monture PL / monture E)

Objectif à monture E 
SELP28135G, SEL1224GM, SEL1635GM, SEL2470GM, SEL70200GM, SEL100400GM, 
SEL24F14GM, SEL35F14GM, SEL50F12GM, SEL85F14GM, SEL100F28GM

Carte mémoire AXS 
AXS-A512S24, 
AXS-A512S48, 
AXS-A1TS48, 
AXS-A1TS66

Lecteur de carte 
mémoire AXS 
AXS-AR3

Unité de télécommande 
RM-B170/B750 
RCP-1000/1500/1530/3100/3500 
RCP-1001/1501/3501
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Nomenclature et fonction des pièces

Côté de l’opérateur

53

8 7910111213

15

16

14

1 2 4

6

Admission d’air

Admission 
d’air

Bloc de fente de carte 
mémoire AXS (page 10)

[Remarque]
Ne faites pas fonctionner si l’entrée d’air est bloquée.

1. Boutons ASSIGN (assignables) 1/2 
(page 48)

Assignez des fonctions à l’aide de la page 
EDIT de l’écran des fonctions d’utilisateur 
(page 48).
La fonction assignée bascule entre on/off 
(activé/désactivé) ou est activée à chaque 
pression.

2. Voyants ASSIGN (assignables) 1/2 
(page 48)

Le voyant s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

3. Haut-parleur intégré
Vous pouvez contrôler l’audio d’entrée 
pendant la prise de vue/l’enregistrement et 
le son de lecture pendant la lecture. Le haut-
parleur fait également retentir des alarmes 
afin de renforcer les avertissements visuels 
(page 97).
Si vous raccordez des écouteurs à la prise 
de casque, le son du haut-parleur est 
automatiquement coupé.

[Remarque]
Si la configuration est telle que le son capturé par le 
microphone interne est audible par le haut-parleur 
intégré, un sifflement peut se produire si le volume du 
moniteur est augmenté.

4. Touches ITEM 1 à 3 du mini-écran
Contrôle le fonctionnement des fonctions sur 
le mini-écran (page 98).

5. Mini-écran
Affiche divers éléments de configuration, tels 
que l’angle d’obturation, que vous pouvez 
vérifier ou modifier (page 98).

6. Voyants ACCESS (SLOT A/B)
Chaque voyant est allumé lorsque le support 
d’enregistrement dans la fente pour carte AXS 
A/B est la cible d’enregistrement/de lecture et 
lorsque les données sont en cours d’écriture 
ou de lecture sur le support d’enregistrement 
dans la fente pour carte AXS A/B (page 26).

7. Bouton CLIPS
Appuyez pour afficher l’écran des plans sur le 
mini-écran pour activer les opérations sur les 
plans (page 101).
Simultanément, l’écran de liste de plans 
s’affiche sur l’affichage auxiliaire et peut 
également être utilisé pour les opérations sur 
les plans.
Pour passer du mode de lecture au mode de 
prise de vue, appuyez sur le bouton HOME.

8. Bouton SLOT SELECT (sélection de carte 
mémoire AXS)

Appuyez pour changer la fente active.

9. Interrupteur d’alimentation
Placez en position Ò (ON) pour mettre 
l’alimentation sous tension. Placez en position 
Æ (OFF) pour mettre l’alimentation hors 
tension.

[Remarques]
 • Cet appareil utilise une petite alimentation de veille 

lorsque l’interrupteur d’alimentation est en position 
OFF. Retirez le pack de batteries en cas de non-
utilisation prolongée de l’appareil.

 • Pour retirer le pack de batteries ou couper 
l’alimentation DC IN, réglez d’abord l’interrupteur 
d’alimentation sur la position OFF. L’interruption 
de l’alimentation pendant l’enregistrement ou 
l’accès de la carte mémoire pourrait provoquer un 
dysfonctionnement.

10. Bouton HOME
Appuyez pour effacer l’affichage de sélection 
d’élément et revenir à l’écran d’accueil sur le 
mini-écran.
S’il est enfoncé lorsque l’appareil est en état 
de lecture, l’appareil passe en mode de prise 
de vue (page 98).

11. Commutateur LOCK
Verrouille le fonctionnement des boutons sur 
le côté opérateur. Lorsqu’il est verrouillé, la 
LED d’arrière-plan du commutateur s’allume 
en orange.

12. Connecteur de casque (mini prise stéréo)
Raccordez les écouteurs pour la surveillance 
audio. Vous pouvez contrôler l’audio d’entrée 
pendant la prise de vue/l’enregistrement et le 
son de lecture pendant la lecture (page 97).

[Remarques]
 • Utilisez des écouteurs de type monaural (2 pôles) ou 

stéréo (3 pôles). L’utilisation d’autres dispositifs risque 
d’endommager l’appareil.

 • Utilisez des écouteurs à impédance de 16 ohms.

13. Voyant REC ACTIVE
Le voyant s’allume en vert lorsque le bouton 
REC est activé.

14. Voyant ASSIGN (assignable) 3 
(page 48)

Le voyant s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

15. Bouton/Voyant REC (démarrer/arrêter 
l’enregistrement)

Appuyez pour démarrer l’enregistrement, 
allumant ainsi le voyant REC. Appuyez à 
nouveau pour arrêter l’enregistrement, 
éteignant ainsi le voyant REC (page 109).
Le voyant REC clignote lorsqu’une erreur ou 
un avertissement du périphérique se produit.

16. Symbole Ф (phi)
Le symbole Ф (phi) se trouve au même niveau 
que le capteur d’image.
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Pour mesurer précisément la distance entre 
l’appareil et le sujet, utilisez le symbole Ф (phi) 
comme référence.

Bloc de fente de carte mémoire AXS 
(page 26)

Les fentes de carte mémoire AXS se trouvent 
derrière le couvercle.

1

1. Fentes de carte mémoire AXS A/B

Côté assistant

1 2 3 4

6

5

7

8

9

1011
12

13
14

15
16

17

18

19
1 2 3

4 5 6

Fente d’aération

1. Bouton ASSIGN (assignable) 4 
(page 48)

Assignez des fonctions à l’aide de la page 
EDIT de l’écran des fonctions d’utilisateur 
(page 48).
La fonction assignée bascule entre on/off 
(activé/désactivé) ou est activée à chaque 
pression.

2. Voyant ASSIGN (assignable) 4 
(page 48)

Le voyant s’allume en orange lorsque la 
fonction assignée est on (activée) et ne 
s’allume pas lorsque la fonction est off 
(désactivée).

3. Affichage auxiliaire
Vous permet de vérifier l’état de 
fonctionnement de l’appareil et d’effectuer 
divers réglages (page 36).
Avec l’écran d’accueil affiché, appuyez sur 
le bouton BACK et maintenez-le enfoncé 
(page 11) puis tournez la molette MENU 
pour ajuster la luminosité de l’affichage 
auxiliaire et du mini-écran.
La luminosité peut également être ajustée à 
l’aide de Technical > Panel Control > Brightness 
level (page 92) dans le menu complet.

4. Touches ITEM 1 à 6 de l’affichage 
auxiliaire

Contrôle le fonctionnement des fonctions sur 
l’affichage auxiliaire (page 55).

5. Crochet pour mètre à ruban
Le crochet pour mètre à ruban se trouve 
au même niveau que le capteur d’image. 
Pour mesurer précisément la distance entre 
l’appareil et le sujet, utilisez le crochet pour 
mètre à ruban comme référence. Vous pouvez 
aussi fixer l’extrémité d’un mètre à ruban au 
crochet et mesurer la distance à partir du 
sujet.

6. Bouton HOME
Appuyez pour effacer l’affichage et revenir 
à l’écran d’accueil sur l’affichage auxiliaire 
(page 38).
S’il est enfoncé lorsque l’appareil est en état 
de lecture, l’appareil passe en mode de prise 
de vue.

7. Bouton MENU (réglage on/off de 
l’affichage du menu) (pages 55, 66)

Appuyez sur le bouton MENU pour afficher 
l’écran de menu sur l’affichage auxiliaire. 
Maintenez le bouton MENU appuyé pendant 
2 secondes ou plus pour afficher l’écran de 
menu complet sur l’affichage auxiliaire.
Vous pouvez également appuyer sur le 
bouton MENU en même temps que la molette 
MENU pour afficher rapidement l’écran du 
menu complet.
Appuyez sur le bouton durant l’affichage 
de l’écran de menu ou de l’écran de menu 
complet pour revenir à l’affichage d’écran 
précédent.

8. Molette SEL/SET (sélection/réglage) 
(molette MENU)

Change la sélection de l’élément ou un réglage 
dans le menu (pages 38, 55, 66).

9. Voyant d’alimentation +48V
S’allume en vert si le commutateur AUDIO IN 
est réglé sur MIC et si l’alimentation fantôme 
+48 V est fournie sur le connecteur AUDIO IN. 
Il n’est pas allumé si l’alimentation fantôme 
n’est pas fournie.
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Vous pouvez activer/désactiver l’alimentation 
fantôme +48 V, à l’aide de la catégorie Audio 
> Audio Details > Audio Configuration > 
Phantom Power +48V (page 86) dans le 
menu.

10. Commutateur AUDIO IN (sélection d’audio)
Sélectionnez le type de signal d’entrée 
correspondant à la source audio connectée au 
connecteur AUDIO IN.
LINE : lors de la connexion d’une source de 

signal audio analogique externe 
AES/EBU : lors de la connexion d’une source 

de signal audio numérique externe
MIC : lors de la connexion d’un microphone

11. Connecteur AUDIO IN (XLR 5 broches)
Entrée du microphone externe ou des signaux 
d’équipement audio.
Lorsque la source audio est réglée sur LINE 
ou MIC à l’aide du commutateur AUDIO IN, ce 
connecteur fonctionne comme un connecteur 
AUDIO IN CH-1 et AUDIO IN CH-2.
Lorsque la source audio est réglée sur AES/
EBU à l’aide du commutateur AUDIO IN, ce 
connecteur fonctionne comme le connecteur 
AUDIO IN CH-1/2 et AUDIO IN CH-3/4.

12. Bouton BACK
Annule le réglage de menu et remonte d’un 
niveau dans la hiérarchie du menu pendant 
l’affichage du menu. Annule le processus 
d’exécution ou le processus en attente pendant 
l’affichage de l’exécution/de la mise en attente 
du processus (pages 38, 55, 66).

13. Commutateur LOCK
Verrouille le fonctionnement des boutons sur 
le côté assistant. Lorsqu’il est verrouillé, la LED 
d’arrière-plan du commutateur s’allume en 
orange.

14. Voyant ACCESS (accès à la carte SD) 
(page 34)

15. Voyant REC ACTIVE
Le voyant s’allume en vert lorsque le bouton 
REC est activé.

16. Bouton/Voyant REC (démarrer/arrêter 
l’enregistrement)

Appuyez pour démarrer l’enregistrement, 
allumant ainsi le voyant REC. Appuyez à 
nouveau pour arrêter l’enregistrement, 
éteignant ainsi le voyant REC (page 109).
Le voyant REC clignote lorsqu’une erreur ou 
un avertissement du périphérique se produit.

17. Bouton CLIPS
Appuyez pour afficher l’écran de liste de 
plans sur l’affichage auxiliaire pour activer les 
opérations sur les plans (page 95).
Simultanément, l’écran des plans s’affiche sur 
le mini-écran.
Pour passer du mode de lecture au mode de 
prise de vue, appuyez sur le bouton HOME.

18. Bouton USER
Appuyez pour afficher la liste de fonction 
d’utilisateur sur l’affichage auxiliaire et pour 
utiliser les touches ITEM 1 à 5 en tant que 
boutons de fonction d’utilisateur.
La touche ITEM 6 correspond au bouton EDIT 
de liste de fonction d’utilisateur. Appuyez sur 
ce bouton pour afficher l’écran de sélection 
de fonction pour les boutons de fonction 
d’utilisateur et les boutons assignables. 
Appuyez à nouveau lorsque l’écran des 
fonctions d’utilisateur s’affiche pour revenir à 
l’affichage précédent (page 48).

19. Microphone interne
Utilisez-le pour enregistrer l’audio.
Sélectionnez le canal d’entrée pour le 
microphone interne à l’aide de Audio > Audio 
Input > Internal Mic Select (page 86) dans le 
menu complet.

Avant

1

23

4

5

1. Bouton ASSIGN (assignable) 3 
(page 48)

Assignez des fonctions à l’aide de la page 
EDIT de l’écran des fonctions d’utilisateur 
(page 48).
La fonction assignée bascule entre on/off 
(activé/désactivé) ou est activée à chaque 
pression.

2. Adaptateur pour monture d’objectif PL 
(page 21)

3. Connecteur VF (sortie du viseur) 
(page 24)

4. Connecteur LENS (12 broches)
Prend en charge la commande du 
diaphragme, de la mise au point et du zoom 
depuis un ordinateur, un smartphone ou une 
tablette connecté au réseau.

5. Connecteur 24V OUT (sortie 24 V CC, 
Fischer 3 broches)

Connecteur de sortie d’alimentation 24 V CC 
(page 123).
La tension de sortie et le courant de sortie 
maximal de ce connecteur varient en fonction 
de la tension d’entrée de l’appareil. Le courant 
maximal comprend le courant de sortie du 
connecteur 24V OUT sur le panneau arrière 
(page 12).
Entrée 11 V à 17 V
Tension de sortie : 24 V
Courant de sortie maximal : 1,0 A
Entrée 22 V à 32 V
Tension de sortie : identique à la tension 
d’entrée
Courant de sortie maximal : 2,0 A
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Arrière

2
1

3

4

5

6

7

8

9

10

11

12

13
14

Admission 
d’air

[Remarque]
Ne faites pas fonctionner si l’entrée d’air est bloquée.

1. Connecteur 24V OUT (sortie 24 V CC, 
Fischer 3 broches)

Connecteur de sortie d’alimentation 24 V CC 
(page 123).
La tension de sortie et le courant de sortie 
maximal de ce connecteur varient en fonction 
de la tension d’entrée de l’appareil. Le courant 
maximal comprend le courant de sortie du 
connecteur 24V OUT sur le panneau avant 
(page 11).
Entrée 11 V à 17 V
Tension de sortie : 24 V
Courant de sortie maximal : 1,0 A
Entrée 22 V à 32 V
Tension de sortie : identique à la tension 
d’entrée
Courant de sortie maximal : 2,0 A

2. Connecteur 12V OUT (sortie 12 V CC, LEMO 
2 broches)

Connecteur de sortie d’alimentation 12 V CC 
(page 123).

La tension de sortie et le courant de sortie 
maximal de ce connecteur varient en fonction 
de la tension d’entrée de l’appareil.
Entrée 11 V à 17 V
Tension de sortie : identique à la tension 
d’entrée
Courant de sortie maximal : 1,0 A
Entrée 22 V à 32 V
Tension de sortie : 16,8 V
Courant de sortie maximal : 1,0 A

3. Connecteur MONITOR OUT (type BNC)
Connecteur de sortie de signal du moniteur 
HD SDI (page 123).

4. Connecteur GENLOCK (entrée de 
verrouillage de synchronisation) (type 
BNC)

Pour effectuer un verrouillage de 
synchronisation de l’appareil sur une source 
externe ou pour verrouiller le code temporel 
de l’appareil sur une source externe, faites 
entrer un signal de référence externe.
L’entrée de signal numérique et de signal 
analogique est prise en charge.

Signal numérique : signal progressif/entrelacé 
1.5G HDSDI
Signal analogique : synchronisation HD, 
synchronisation SD

5. Connecteur TC IN (entrée de code 
temporel) (type BNC)

Pour verrouiller le code temporel de l’appareil 
sur une source externe, faites entrer un signal 
de code temporel de référence.

6. Connecteur AUX (type BNC)
Émet le signal de code temporel (page 123).

7. Connecteur réseau (RJ-45)
Connectez-vous à un réseau LAN filaire 
à l’aide d’un câble LAN (non fourni) de la 
télécommande de l’appareil (page 102).

8. Connecteur REMOTE (télécommande) 
(8 broches)

Permet la connexion à une unité de 
télécommande ou à un autre dispositif de 
contrôle externe.

9. Connecteur 12V/24V (entrée 
d’alimentation CC) (page 17)

Le connecteur d’entrée d’alimentation CC pour 
l’alimentation externe de l’appareil. Prend en 
charge les tensions d’entrée 12 V et 24 V.

N° Signal

1 GND

2 NC

3 NC

4 DC IN (11 V à 17 V ou 22 V à 32 V)

10. Prise de fixation de la batterie 
(page 17)

11. Connecteurs SDI OUT 1 à 4 (sortie 
numérique série) (type BNC) (page 123)

12. Monture du pack de batteries 
(page 17)

13. Levier de déverrouillage de la batterie 
(page 17)

14. Connecteur HDMI OUT (page 123)
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Haut

2 3 41 5

1. Connecteur du périphérique externe
Utilisé pour la télécommande sans fil de 
la caméra (page 102) en connectant un 
adaptateur LAN sans fil CBK-WA02 (en option).

2. Borne d’étalonnage du fabricant
Borne du fabricant pour l’étalonnage et la 
réparation et l’entretien (ne peut pas être 
utilisée par les utilisateurs).

3. Bouton de déverrouillage (page 20)

4. Monture de fixation du viseur/de la 
poignée (page 20)

5. Trous des vis de fixation d’accessoire
Type de vis : 1/4-20UNC (8)
Type de vis : 3/8-16UNC (10)
Longueur d’engagement : 10 mm (13/32 po) ou 
moins

Fond

2

1

Fente d’aération

1. Orifices de fixation de la plaque de 
trépied

Type de vis : 1/4-20UNC (2)
Type de vis : 3/8-16UNC (4)
Longueur d’engagement : 9 mm (3/8 po) ou 
moins

2. Fente pour carte SD (page 34)



1. Présentation : Nomenclature et fonction des pièces14

Écran du viseur/du moniteur

Pendant la prise de vue (enregistrement ou veille) et la lecture, les informations sélectionnées 
dans Monitoring > Overlays/Frame Line > Overlay A/B Setup (page 81) dans le menu complet 
sont affichées.

Informations affichées sur l’écran pendant l’enregistrement

29

1 2 3 64 5 7 8

22232526 242728

10
9

11

14
15
16
17
18
19
21

12 13

20

35

30
31
32

34
33

36

37

1. Indicateur de fréquence d’images 
d’enregistrement

Affiche la fréquence d’images 
d’enregistrement et la fréquence d’images du 
projet.

2. Indicateur de l’angle d’obturation/de la 
vitesse d’obturation

Affiche l’angle d’obturation ou la vitesse 
d’obturation de l’obturateur électronique 
en fonction du réglage Technical > System 
Configuration (page 89) dans le menu 
complet.

3. Indicateur de filtre ND
Affiche la densité du filtre ND. La valeur 
affichée est une valeur LOG (base 10) 
(page 68).

CLEAR
0.3 (1/2)
0.6 (1/4)
0.9 (1/8)
1.2 (1/16)
1.5 (1/32)
1.8 (1/64)
2.1 (1/128)
2.4 (1/256)

4. Icône de thermomètre
S’affiche lorsqu’un message d’avertissement 
de température élevée est émis.
La description s’affiche dans la catégorie Info 
du menu.

5. Icône d’avertissement
S’affiche lorsqu’un message différent d’un 
avertissement de température élevée est 
émis.
La description s’affiche dans la catégorie Info 
du menu.

6. Indicateur d’indice d’exposition (EI)/gain
Affiche la valeur EI ou la valeur de gain (unités 
dB) réglée par une RM-B170 ou une autre unité 
de télécommande.

[Remarque]
La valeur de gain n’est affichée que lorsque Technical 
> Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

7. Indicateur de température de couleur
Affiche la température de couleur et la valeur 
de teinte de la balance des blancs.

8. Indicateur de la capacité/tension de la 
batterie

Affiche les indicateurs suivants selon le type 
de batterie d’alimentation.

Type de batterie Affichage

Batterie Sony Info Capacité restante de la 
batterie et durée 
d’enregistrement restante

Batterie Anton/
Bauer

Capacité restante de la 
batterie (indicateur en %)

Autres batteries Tension d’entrée

9. Indicateur de verrouillage externe du 
code temporel/Indicateur d’état genlock

Affiche l’état de verrouillage lorsque le code 
temporel est verrouillé sur une source externe. 
Affiche l’état de verrouillage à l’état genlock.

10. Indicateur VF LUT
Affiche le LUT du viseur (page 72).

11. Indicateur VF Double Speed Scan
Affiche l’état d’activation/désactivation de la 
fonction permettant de doubler la fréquence 
d’images de l’affichage du viseur.

12. Indicateur VF Peaking
Affiche l’état d’activation/désactivation de la 
fonction de contour de l’affichage du viseur.

13. Indicateur VF Zebra
Affiche l’état d’activation/désactivation de 
la fonction de motif zébré de l’affichage du 
viseur (page 53).

14. Indicateur de LUT de connecteur SDI OUT 
1/2

Affiche le réglage LUT des connecteurs SDI 
OUT 1/2 (page 70).

15. Indicateur de LUT de connecteur SDI OUT 
3/4

Affiche le réglage LUT des connecteurs SDI 
OUT 3/4 (page 71).

16. Indicateur de LUT Monitor
Affiche le réglage LUT de la sortie Monitor 
(page 71).

17. Indicateur de LUT HDMI
Affiche le réglage LUT de la sortie HDMI 
(page 72).
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18. Indicateur de déclenchement REC de sortie SDI
Affiche l’état de déclenchement REC de la sortie SDI.

État Affichage

Technical > System Configuration > SDI Rec 
Remote Trigger dans le menu complet

Commande d’enregistrement 
superposée sur la sortie SDI

Off – (Vide)

HD SDI Remote I/F Commande Stop Haut : SDI
Bas : Stop

Commande Rec Haut : SDI
Bas : REC

Parallel Rec Commande Stop Haut : SDI-P
Bas : Stop

Commande Rec Haut : SDI-P
Bas : REC

19. Indicateur d’état de connexion au réseau
Affiche l’état de connexion du réseau (LAN ou 
Wi-Fi).

État Affichage

Déconnecté ou autre erreur (réglages 
de la connexion réseau valide)

Clignotant

Connecté (réglages de la connexion 
réseau valide)

Allumé

La fonction de connexion réseau 
n’est pas utilisée

Vide

20. Indicateur High Key/Low Key (sortie 
Monitor)

Affiché lorsque la sortie Monitor est High Key 
(écran de vérification des hautes lumières 
accentuées) ou Low Key (écran de vérification 
des ombres bloquées) (affiché pour la sortie 
Monitor Out).

21. Indicateurs de vu-mètre audio
Affiche les niveaux des canaux audio 1 et 2 
pendant l’enregistrement.

22. Indicateur d’état/de capacité restante du 
support d’enregistrement pour chaque 
fente de support

Affiche l’état et la capacité restante du support 
dans les fentes de carte mémoire AXS A/B.

Une icône  (enregistrement actif) à gauche 
de « AXS » indique le support cible de 
l’enregistrement.
Un indicateur  (icône fente active) en haut à 
droite de l’icône de fente A/B située à droite 
de « AXS » indique le support de lecture cible 
(un indicateur vert indique que le support est 
en cours de lecture).
Une icône  (avertissement) s’affiche pour le 
support si une condition pouvant avoir un 
impact sur l’enregistrement se produit.

23. Indicateur graphique de la jauge de 
niveau à bulle

Affiche l’inclinaison horizontale de l’appareil 
par incréments de ±0,1° à ±10°.
Vous pouvez régler l’alignement de l’angle 
zéro de la jauge de niveau à bulle en 
exécutant Technical > Special Configuration > 
Level Gauge Adjust (page 89) dans le menu 
complet.

24. Affichage du nom de plan
Affiche les 8 premiers caractères du nom du 
prochain plan à enregistrer en mode de veille 
d’enregistrement.
Affiche les 8 premiers caractères du nom 
du plan en cours d’enregistrement pendant 
l’enregistrement.

25. Indicateur de l’état d’enregistrement
Affiche les états d’opération d’enregistrement 
suivants de l’appareil.

Affichage Description

Ć Rec   (Rec) Enregistrement

    Stby   (Stby) Veille d’enregistrement

Ć Cache   (Cache) Veille d’enregistrement 
en cache d’image

    CALL   (CALL) Commande CALL 
entrant

Lorsque Monitoring > Overlays/Frame Line 
> VF, SDI 1/2, SDI 3/4, Monitor, ou HDMI 
> Overlay (page 81) est réglé sur Rec 
Ind. dans le menu complet, l’affichage des 
informations pour la destination de sortie 
configurée est réglé pour afficher uniquement 
l’état de l’opération d’enregistrement.

26. Affichage d’informations sur le Look
Affiche le Look sélectionné (page 69).

27. Indicateur High Key/Low Key (sortie du 
viseur)

Affiché lorsque la sortie du viseur est High 
Key (écran de vérification des hautes lumières 
accentuées) ou Low Key (écran de vérification 
des ombres bloquées) (affiché pour la sortie 
du viseur).

28. Affichage des données temporelles
Affiche la durée ou le code temporel, en 
fonction du réglage de la catégorie TC/Media 
> TC Display dans le menu (page 57).

29. Indicateur de position du diaphragme
Affiche la position du diaphragme 
(uniquement lorsqu’un objectif compatible 
avec la fonction d’affichage du réglage de 
diaphragme est fixé).  
L’indicateur de position du diaphragme 
s’affiche par paliers de 1/3 de diaphragme lors 
de l’utilisation d’un objectif à monture E.

[Remarque]
La valeur F-stop s’affiche au lieu de la valeur T-stop si la 
valeur T-stop ne peut être obtenue.

30. Indicateur de position de mise au point
Affiche la position de mise au point 
(uniquement lorsqu’un objectif compatible 
avec la fonction d’affichage du réglage de 
mise au point est fixé).

31. Indicateur de position de zoom
Affiche la longueur focale du zoom (affiché 
uniquement lorsqu’un objectif prenant en 
charge l’indicateur de réglage de zoom est 
fixé).

32. Indicateur de niveau à bulle
Affiche les informations de niveau horizontal 
sous forme numérique.
R (Roll) indique l’inclinaison horizontale de 
gauche à droite de l’appareil.
T (Tilt) indique l’inclinaison verticale d’avant à 
arrière de l’appareil.
Vous pouvez régler l’alignement de l’angle 
zéro de la jauge de niveau à bulle en 
exécutant Technical > Special Configuration > 
Level Gauge Adjust (page 89) dans le menu 
complet.

33. Indicateur de LUT d’enregistrement
Affiche le réglage LUT pour l’enregistrement.

34. Indicateur du format du support 
d’enregistrement (codec)

Affiche le format d’enregistrement sur une 
carte mémoire AXS.

35. Indicateur Base ISO
Affiche la sensibilité de base configurée.

36. Indicateur de taille d’image effective
Affiche la taille d’image effective et 
indique si la conversion de décompression 
anamorphique est appliquée, réglée à l’aide 
de la catégorie Project > Imager Mode dans 
le menu. En mode Surround View, une icône 
« Sur.V » s’affiche sous l’icône de rapport de 
conversion anamorphique (page 56).
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Une icône « Z 17:9 » s’affiche lorsque la 
catégorie Project > Zoom to Fit (page 57) 
est réglée sur 17:9 dans le menu. Une icône « Z 
16:9 » s’affiche lorsque Zoom to Fit est réglé 
sur 16:9.

37. Indicateur Camera ID
Affiche le réglage Camera ID (page 78).

Affichage et réglages du menu sur 
l’écran du viseur

Lorsqu’un DVF-EL200 est fixée à l’appareil, 
appuyez sur le bouton Menu du DVF-EL200 et 
maintenez-le enfoncé pour afficher les menus 
de configuration Monitoring > VF Display 
(page 80) et VF Function (page 80) 
sur l’écran du viseur. Cela vous permet de 
configurer ces fonctions tout en regardant 
l’écran du viseur.

Informations affichées sur l’écran de lecture

Les informations suivantes sont affichées sur l’image de lecture.

98
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2 4 53

1. Indicateur du format du support de 
lecture (codec)

Affiche le format d’enregistrement (codec) du 
plan lu.

2. Affichage des données temporelles
Affiche la durée ou le code temporel, en 
fonction du réglage de la catégorie TC/Media 
> TC Display dans le menu (page 57).

3. Indicateur de l’état de lecture
Affiche l’état de lecture.
Affiche « CALL » lorsqu’une commande CALL 
est reçue.

4. Affichage du nom de plan lu
Affiche les 8 premiers caractères du nom du 
plan lu.

5. Indicateur du support de lecture
Affiche le type de support d’enregistrement 
en cours de lecture.
Une icône  (protection) s’affiche sur la droite 
si la carte mémoire est protégée en écriture.

6. Indicateurs de vu-mètre audio
Affiche les niveaux des canaux audio 1 et 2 
pendant la lecture.

7. Indicateur d’état de connexion au réseau
Affiche l’état de connexion du réseau (LAN ou 
Wi-Fi).

État Affichage

Déconnecté ou autre erreur 
(réglages de la connexion réseau 
valide)

Clignotant

Connecté (réglages de la connexion 
réseau valide)

Allumé

La fonction de connexion réseau 
n’est pas utilisée

Vide

8. Icône de thermomètre
S’affiche lorsqu’un message d’avertissement 
de température élevée est émis.
La description s’affiche dans la catégorie Info 
du menu.

9. Icône d’avertissement
S’affiche lorsqu’un message différent d’un 
avertissement de température élevée est 
émis.
La description s’affiche dans la catégorie Info 
du menu.
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Préparation de l’alimentation
Vous pouvez utiliser un pack de batteries 
ou l’alimentation secteur par le biais d’un 
adaptateur CA.
Pour votre sécurité, n’utilisez que les packs de 
batterie Sony énumérés ci-dessous.

Pack de batteries Lithium-ion
BP-GL95B

Adaptateur CA
Adaptateur dont la puissance est de 120 W ou 
plus.

Utilisation d’un pack de batteries

Insérez le pack de batteries dans la monture 
du pack de batteries (page 12) sur 
l’adaptateur de batterie, puis faites glisser le 
pack de batteries vers le bas pour le bloquer 
en position.
Pour le retirer, déverrouillez le pack de 
batteries en le faisant glisser vers le haut 
pendant que vous appuyez sur le levier de 
déverrouillage de la batterie (page 12), puis 
retirez le pack de batteries.

[Remarques]
 • Avant toute utilisation, chargez le pack de batteries à 

l’aide du chargeur de batterie.
 • Juste après utilisation, le pack de batteries est chaud 

et ne pourra pas être rechargé complètement.
 • Retirez l’adaptateur de batterie tout en soutenant 

l’appareil avec la main.

Contrôle de la capacité restante de la 
batterie

Si le caméscope fonctionne à l’aide du 
pack de batteries pendant une opération 
d’enregistrement ou de lecture, la durée 
restante d’utilisation de batterie et la tension 
de batterie s’affichent sur l’écran de l’affichage 

auxiliaire (page 36) et sur l’écran du viseur/
du moniteur (page 14).
L’appareil indique le temps d’utilisation 
restant en minutes en calculant l’autonomie 
du pack de batteries si l’appareil continue 
de fonctionner avec son niveau de 
consommation électrique actuel.

Si la capacité restante de la batterie 
devient insuffisante

Si la capacité restante de la batterie passe 
en dessous d’un certain niveau pendant le 
fonctionnement, l’indicateur de capacité 
restante de la batterie clignote et le voyant 
REC clignote pour vous prévenir.
Si la capacité restante continue de diminuer 
jusqu’à un niveau empêchant toute poursuite 
du fonctionnement, un message de batterie 
déchargée s’affiche.
Remplacez-le par un pack de batteries 
totalement chargé.

Pour modifier les niveaux des messages

Modifiez les niveaux à l’aide de Technical 
> Batt./Voltage Alarm (page 91) dans le 
menu complet.

Utilisation de l’alimentation 
secteur (Alimentation DC IN) 

L’appareil fonctionne sur l’alimentation secteur 
à l’aide d’un adaptateur CA 120 W.
Des plages de tension d’entrée de 11 V à 17 V 
et de 22 V à 32 V sont prises en charge.

[Remarques]
 • Lors du passage à l’alimentation électrique DC IN 

pendant le fonctionnement de la batterie, utilisez une 
alimentation électrique dont la tension se trouve dans 
une plage de 12 V à 17 V pour une commutation de 
l’alimentation électrique plus sûre.

 • Lors de l’utilisation d’une alimentation électrique 
de 22 V à 32 V, il est recommandé de d’abord régler 
l’interrupteur d’alimentation sur la position OFF avant 
de raccorder l’alimentation électrique.

 • Ne basculez pas directement l’alimentation électrique 
DC IN d’une alimentation électrique dont la tension 
se situe entre 11 V et 17 V à une qui se situe entre 
22 V et 32 V, ou vice versa. Cela peut provoquer un 
dysfonctionnement.

Utilisation conjointe d’un pack de 
batteries et d’une alimentation DC 
IN

À chaque fois qu’une alimentation électrique 
active est utilisée à l’aide d’un pack de 
batteries et d’une alimentation DC IN, 
l’alimentation DC IN prend le dessus.

[Remarque]
Lorsque l’alimentation électrique bascule entre le 
fonctionnement de la batterie et l’alimentation DC IN, le 
fonctionnement de l’appareil peut s’arrêter si ce qui suit 
se produit.
 • Broutage des contacts du connecteur lors de 

l’insertion du connecteur DC
 • Chute de tension lors du basculement entre 

alimentations électriques (plus fréquente lorsque la 
charge externe est plus importante)
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Réglage de l’horloge
Lorsque vous utilisez l’appareil pour la 
première fois, l’écran de configuration initiale 
apparaît sur l’affichage auxiliaire lors de la 
mise sous tension.
À l’aide de cet affichage, réglez la date et 
l’heure de l’horloge intégrée.

Fuseau horaire

La valeur indique le décalage horaire par 
rapport à UTC (temps universel coordonné). 
Modifiez le réglage si nécessaire.

[Remarque]
Lorsque Time Zone est modifié, le réglage de l’horloge 
change en fonction de la différence horaire.

Réglage de la date et de l’heure

Tournez la molette MENU (page 10) pour 
déplacer le curseur, puis appuyez sur la 
molette MENU pour définir chaque paramètre 
de menu. Si vous appuyez sur la molette 
MENU quand le curseur se trouve sur « Set », 
l’affichage du réglage disparaît et le réglage 
de l’horloge est terminé.
Une fois que l’affichage de configuration 
initiale disparaît, vous pouvez changer Time 
Zone et les réglages de la date et de l’heure à 
l’aide de Maintenance > Clock Set (page 94) 
dans le menu complet.

[Remarques]
 • Si le réglage de l’heure disparaît suite à l’épuisement 

de la batterie de secours et qu’aucune alimentation 
n’est fournie à l’appareil (absence de pack de 
batteries et d’alimentation via le connecteur DC IN), 
l’affichage de la configuration initiale s’affichera lors 
de la prochaine mise sous tension de l’appareil.

 • Lorsque l’affichage de la configuration initiale est 
affiché, aucune autre opération n’est autorisée, à 
l’exception de la mise hors tension de l’appareil, 

jusqu’à ce que vous ayez terminé le réglage de cet 
affichage.
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Remplacement du bloc d’imageur
Vous pouvez remplacer le bloc de l’imageur.
Cette section décrit la procédure de 
remplacement d’un bloc d’imageur 8K par un 
bloc d’imageur 6K à titre d’exemple.
Lorsque vous fixez le bloc de l’imageur 6K, 
fixez le couvercle (MPC-3628 : accessoire, MPC-
3626 : déjà fixé) pour le bloc d’imageur 6K.

[Remarque]
Avant de remplacer le bloc d’imageur, mettez l’appareil 
hors tension pendant au moins 10 minutes pour qu’il 
refroidisse. Faites également attention aux bords 
tranchants lorsque vous remplacez le bloc d’imageur.

1 Retirez les deux vis hexagonales du 
dessous et les quatre vis hexagonales de 
l’avant, puis retirez le bloc d’imageur 8K.

Bloc d’imageur

2 Fixez le couvercle du bloc d’imageur 6K 
en orientant le côté avec le texte gravé 
vers l’avant, et serrez-le avec deux vis 
(couple de serrage : 0,19 N·m).

Cache pour bloc 
d’imageur 6K

 [Remarques]
 • Si le couvercle du bloc d’imageur 6K n’est 

pas fixé, la dissipation de la chaleur du bloc 
d’imageur 6K sera mauvaise.

 • Retirez le couvercle du bloc d’imageur 6K 
lorsque vous fixez le bloc d’imageur 8K.

3 Fixez le bloc d’imageur 6K.

Assurez-vous que le bloc d’imageur est 
droit, et serrez les six vis hexagonales 
retirées à l’étape 1 (couple de serrage : 
1,4 N·m).

Redémarrage après le 
remplacement du bloc d’imageur

Lorsque l’appareil est mis sous tension pour 
la première fois après avoir remplacé le bloc 
d’imageur, le démarrage prendra un peu plus 
de temps car l’appareil doit recharger les 
données spécifiques au capteur.
L’appareil redémarre automatiquement 
quelques minutes après avoir mis sous 
tension, lorsque le chargement des données 
spécifiques au capteur est terminé.
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Fixation de la fixation du viseur

1 Faites glisser la fixation du viseur en 
direction de la flèche pour la fixer.

2 Positionnez la fixation du viseur dans la 
position avant/arrière souhaitée, puis 
tournez le levier de verrouillage pour la 
bloquer en position.

1

2

Levier de 
verrouillage

 [Remarques]
 • Vous pouvez également fixer la fixation du 

viseur à l’avant/arrière ou sur la gauche/droite.
 • Si le levier de verrouillage est difficile à serrer 

ou desserrer, vous pouvez utiliser une clé 
hexagonale (3 mm) sur la vis de verrouillage au-
dessus du levier de verrouillage.

Pour retirer la fixation du viseur

Tournez le levier de verrouillage pour 
desserrer, appuyez sur le bouton de 
déverrouillage et retirez la fixation du viseur 
en la faisant glisser dans le sens inverse à 
celui utilisé pour la fixation.

Fixation de la poignée

1 Faites glisser la poignée en direction de la 
flèche pour la fixer.

2 Positionnez la poignée dans la position 
avant/arrière souhaitée, puis tournez le 
levier de verrouillage pour la bloquer en 
position.

2

1

Vis de 
verrouillage

Boulon à pans 
hexagonaux

Levier de 
verrouillage

 [Remarques]
 • Vous pouvez également fixer une vis de 

verrouillage en utilisant une clé hexagonale 
(5 mm) pour la bloquer en position.

 • Si le levier de verrouillage sur la poignée se 
desserre pendant l’utilisation, vous pouvez 
fixer la poignée en serrant le boulon à pans 
hexagonaux (2 mm) à côté de la vis de 
verrouillage.

 • Vous pouvez également fixer la poignée en sens 
inverse.

Pour retirer la poignée

Tournez le levier de verrouillage pour 
desserrer, appuyez sur le bouton de 
déverrouillage et retirez la poignée en la 
faisant glisser dans le sens inverse à celui 
utilisé pour la fixation.

Fixation de la fixation du viseur et de la poignée
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Objectif à monture PL recommandé (taille 
Super 35mm)
SCL-PK6/F, SCL-PK6/M (jeu de 6 objectifs, 
20 mm/25 mm/35 mm/50 mm/85 mm/ 
135 mm)
SCL-PK3/F, SCL-PK3/M (jeu de 3 objectifs, 
20 mm/25 mm/135 mm)
SCL-P11X15

Objectif à monture E recommandé
SELP28135G, SEL1635GM, SEL2470GM, 
SEL70200GM, SEL100400GM, SEL1224G, 
SEL35F14Z, SEL50F14Z, SEL85F14GM, 
SEL90M28G, SEL100F28GM

[Remarque]
Le contrôle peut ne pas être pris en charge avec certains 
objectifs à monture E. Utilisez un objectif recommandé.

Pour plus de détails sur les objectifs disponibles avec 
l’appareil, contactez un représentant du service après-
vente Sony.

[ATTENTION]
Ne laissez pas l’objectif face au soleil. La 
lumière directe du soleil peut entrer dans 
l’objectif, se concentrer dans l’appareil et 
provoquer un incendie.

[Remarques]
 • Éteignez l’appareil avant de fixer ou de retirer 

l’objectif et l’adaptateur.
 • L’objectif est un composant de précision. Ne placez 

pas l’objectif en bas avec le côté de la monture 
orienté vers le bas. Fixez le capuchon fourni avec 
l’objectif.

 • L’interface d’objectif de l’appareil est configurée selon 
la configuration par défaut pour un SCL-P11X15 et des 
objectifs équipés d’un connecteur de type Cooke. 
Pour utiliser un SCL-PK6, SCL-PK3 ou d’autres objectifs 
non équipés d’un connecteur de type Cooke, réglez 
Technical > Lens Configuration > PL-Mt Interface 
Position (page 89) sur Off dans le menu complet.

Fixation d’un objectif à monture 
PL

1 Retirez le cache de la monture de l’objectif 
en faisant tourner le levier de la monture 
PL dans le sens contraire des aiguilles 
d’une montre.

Levier de 
la monture 
PL

 [Remarque]
Tournez le levier de la monture PL dans le sens 
contraire des aiguilles d’une montre jusqu’à la 
butée.

2 Insérez l’objectif dans la monture de 
l’objectif en alignant la partie concave de 
l’objectif avec la broche de 
positionnement dans le coin supérieur 
droit de la monture de l’objectif.

3 Fixez fermement l’objectif en faisant 
tourner le levier de la monture PL dans le 
sens des aiguilles d’une montre en 
soutenant l’objectif.

 [Remarque]
Ne tournez pas l’objectif lorsque vous fixez 
l’objectif à monture PL. Cela risquerait 
d’endommager la broche du sabot.

Pour fixer un objectif Cooke /i

Alignez les contacts de l’objectif avec la griffe 
de l’appareil. Il y a deux connecteurs sur le 
côté de l’adaptateur d’objectif, et n’importe 
lequel peut être utilisé.

Pour retirer l’objectif

1 Tournez le levier de la monture PL dans le 
sens contraire des aiguilles d’une montre 
en soutenant le dessous de l’objectif.

2 Tirez l’objectif vers l’avant.

 [Remarques]
 • Si vous ne fixez pas rapidement un autre 

objectif, alignez avec soin la partie concave du 
cache de la monture, puis fixez fermement le 
cache de la monture en tournant le levier de 
la monture PL dans le sens des aiguilles d’une 
montre.

 • Pour une communication I/F correcte avec 
l’objectif, réglez les réglages Technical > Lens 
Configuration (page 89) dans le menu pour 
qu’ils correspondent à l’objectif utilisé.

Réglage de la longueur focale de 
collerette

L’appareil est expédié avec la longueur focale 
de collerette déjà réglée. Si vous avez besoin 
de régler la longueur focale de collerette, 
retirez la monture de l’objectif et remplacez les 
cales par d’autres de l’épaisseur appropriée. 
Vous pouvez régler l’épaisseur de ±0,1 mm, 
par incréments de 0,01 mm.

Cales

Les cales suivantes sont fournies avec 
l’appareil.
0,05 mm × 1 (circulaire)
0,01 mm × 15 (tiers de cercle)
Les cales en tiers de cercle doivent toujours 
être utilisées par trois. Insérez les cales pour 
augmenter la longueur focale de collerette. 
L’appareil est expédié avec la longueur focale 
de collerette déjà réglée à l’aide des trois 
types de cales suivants.
0,10 mm (circulaire)
0,05 mm (circulaire)
0,01 mm (tiers de cercle)
Un sceau indiquant l’épaisseur de la cale est 
fixé lors de l’expédition.

Montage d’un objectif et réglage de la longueur focale de collerette
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Réglage de la longueur focale de 
collerette

1 Retirez les six vis Torx et retirez la 
collerette de la monture PL.

1

Collerette de la 
monture PL

2 Desserrez les quatre vis cruciformes des 
deux côtés des connecteurs PL (deux 
emplacements) et retirez les connecteurs 
PL et les plaques de connecteur PL.

3 Fixez les cales à l’adaptateur de la 
monture PL (trois emplacements).

33

33
33

22
22

Connecteurs 
PL

Plaques de 
connecteur PL

Lors de l’utilisation de cales en tiers de 
cercle
Fixez des cales de façon à ce qu’ils aient la 
même épaisseur aux trois emplacements.

Cales

Lors de l’utilisation de cales circulaires
Fixez-les à la surface portant des repères 
vers l’avant.

Repères

Repères

4 Fixez à nouveau les connecteurs PL (deux 
emplacements) à leurs positions d’origine 
et serrez les quatre vis cruciformes à un 
couple de serrage de 0,18 N·m.

5 Fixez à nouveau la collerette de la 
monture PL à sa position d’origine et 
serrez les six vis Torx à un couple de 
serrage de 0,35 N·m en utilisant une clé 
dynamométrique T8.

Nettoyage du filtre

Pour nettoyer le filtre, commencez par retirer 
l’adaptateur. Faites attention lorsque vous 
essuyez la partie centrale de l’adaptateur 
(partie ombrée) avec un tissu ou une autre 
matière, pour éviter que des fibres adhèrent à 
la surface. Si des fibres adhèrent, essuyez-les 
avec une brosse douce.

Adaptateur

Retrait de l’adaptateur d’objectif 
PL

Retirez l’adaptateur d’objectif PL lorsque vous 
souhaitez monter un objectif à monture E sur 
l’appareil. La fixation/le retrait s’effectue avec 
le côté arrière de l’appareil orienté vers le bas.
Desserrez les six vis hexagonales (2,5 mm) et 
retirez l’adaptateur de monture PL.

Adaptateur 
d’objectif PL

[Remarques]
 • Retirer la batterie et placer le côté arrière de l’appareil 

vers le bas permet d’améliorer la stabilité.
 • Lorsque vous fixez/retirez l’adaptateur, veillez à ne 

pas toucher les contacts du connecteur de l’appareil 
et de l’adaptateur d’objectif PL.



2. Préparatifs : Montage d’un objectif et réglage de la longueur focale de collerette23

Pour fixer l’adaptateur d’objectif PL

1 Vérifiez que le levier de la monture est en 
position verrouillée.

Levier de 
la monture

2 Placez l’adaptateur d’objectif PL dans sa 
position d’origine, insérez les six vis 
hexagonales (2,5 mm) et serrez les vis à 
un couple de serrage de 0,8 ± 0,12 N·m à 
l’aide d’une clé hexagonale (2,5 mm).

Fixation d’un objectif à monture E

1 Retirez l’adaptateur d’objectif PL 
(page 22).

2 Appuyez sur le commutateur de 
verrouillage vers le haut, puis tournez le 
levier de la monture dans le sens des 
aiguilles d’une montre pour déverrouiller.

Levier de la 
monture

Commutateur de 
verrouillage

3 Alignez les repères de monture (blancs) 
de l’appareil et de la monture d’objectif, 
puis enfoncez l’objectif dans la monture.

4 Fixez l’objectif en faisant tourner le levier 
de la monture dans le sens inverse des 
aiguilles d’une montre pendant que vous 
soutenez l’objectif.

 

Repères de monture 
(blancs)

[Remarque]
Lorsqu’un objectif à monture E est raccordé, le 
fonctionnement à l’aide d’un connecteur d’objectif à 
12 broches n’est pas garanti.

Pour retirer l’objectif

1 Appuyez sur le commutateur de 
verrouillage vers le haut, puis tournez le 
levier de la monture dans le sens des 
aiguilles d’une montre pour déverrouiller.

2 Tirez l’objectif vers l’avant.

 [Remarque]
Si vous ne fixez pas rapidement un autre objectif, 
alignez avec soin la partie concave du cache de 
la monture, puis fixez le cache de la monture 
en tournant le levier de la monture dans le sens 
inverse des aiguilles d’une montre.
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Fixation d’un viseur
Viseurs disponibles pour l’appareil
DVF-EL200 : Viseur couleur OLED

Les viseurs sont disponibles séparément.
Cette section décrit la fixation du DVF-EL200 à 
titre d’exemple.

Pour plus de détails sur la fixation de chaque viseur, 
consultez le mode d’emploi du viseur.

[ATTENTION]
Ne laissez pas l’appareil avec l’oculaire du 
viseur face au soleil. Les rayons du soleil 
risqueraient de passer directement à travers 
l’oculaire, d’être concentrés par le viseur et de 
causer un incendie.

[Remarques]
Fixez/retirez le viseur quand l’appareil est hors tension.

Fixation d’un viseur

1 Alignez la griffe du viseur sur la rainure de 
la monture du viseur sur la fixation du 
viseur, puis fixez le viseur.

2 Tournez le levier de verrouillage du viseur 
dans le sens LOCK pour le verrouiller en 
place.

2

1

Levier de 
verrouillage

3 Connectez le viseur et l’appareil à l’aide 
du câble de connexion du viseur.
Côté viseur :
Positionnez le connecteur avec le repère 
(rouge) en haut, puis insérez 
complètement le connecteur.
Côté caméscope :
Alignez la partie concave du connecteur 
VF sur le repère (rouge), puis insérez 
complètement le connecteur.

Attache

 [Remarque]
Fixez bien le câble dans l’attache si nécessaire.

Pour retirer le viseur

1 Débranchez le câble de connexion du 
viseur de l’appareil et du viseur.

2 Tournez le levier de verrouillage dans la 
direction opposée à LOCK, puis retirez le 
viseur de la fixation du viseur.

Réglage de la position du viseur

Pour régler la position avant/arrière

1 Desserrez un ou les deux leviers de 
verrouillage de tige avant/arrière de la 
fixation du viseur.

2 Faites glisser la fixation du viseur vers 
l’avant/arrière pour régler la position du 
viseur.

11
11

22

Leviers de 
verrouillage 
de tige

3 Serrez les leviers de verrouillage de tige.

 [Remarque]
Si vous rencontrez des difficultés pour tourner 
un levier de verrouillage de tige, tirez-le vers 
l’extérieur et tournez-le pour le placer dans une 
position plus aisée, puis repoussez-le pour le 
remettre en place.
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Pour régler la position gauche/droite et 
la hauteur (angle)

1 Desserrez le levier de verrouillage de tige 
à l’avant de la fixation du viseur.

2 Faites glisser la tige de fixation du viseur 
vers la gauche/droite et tournez la tige 
vers le haut/bas pour régler la position du 
viseur.

11

22
22

Vis de 
verrouillage

Levier de 
verrouillage 
de tige

3 Serrez le levier de verrouillage de tige.

 [Remarque]
Lorsque le levier de verrouillage de tige est 
desserré, réglez la vis de verrouillage à l’aide du 
clé hexagonale (3 mm) pour éviter que le viseur ne 
tombe.

Pour régler l’angle du viseur

Vous pouvez régler l’angle du viseur pendant 
la prise de vue.

1 Desserrez le levier de verrouillage de 
rotation sur la monture du viseur.

2 Tournez le viseur vers le haut/bas pour 
régler l’angle.

11

22

Levier de verrouillage de rotation

3 Serrez le levier de verrouillage de rotation.
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Cet appareil permet d’effectuer des 
enregistrements audio et vidéo sur des cartes 
mémoire AXS (optionnelles) chargées dans les 
fentes prévues à cet effet.

À propos des cartes mémoire AXS

Utilisez les cartes mémoire AXS Sony suivantes 
avec cet appareil.

S24

AXS-A1TS24 (1 To/2,4 Gbps)
AXS-A256S24 (256 Go/2,4 Gbps)
AXS-A512S24 (512 Go/2,4 Gbps)

S48

AXS-A1TS48 (1 To/4,8 Gbps)
AXS-A512S48 (512 Go/4,8 Gbps)

S66

AXS-A1TS66 (1 To/6,6 Gbps)

Insertion d’une carte mémoire 
AXS

1 Ouvrez le couvercle du bloc de fentes de 
la carte (page 10).

2 Insérez la carte mémoire AXS dans la 
fente en orientant l’étiquette vers la 
droite.
Le voyant ACCESS (page 9) s’allume 
en rouge, puis en vert une fois la carte 
mémoire opérationnelle.

3 Fermez le couvercle.

État du voyant ACCESS

Chacune des fentes pour carte A et B dispose 
d’un voyant ACCESS pour indiquer l’état de la 
fente.

Voyant État de la fente

S’allume en 
rouge

Accès à la carte mémoire AXS 
(données d’écriture/lecture)

S’allume en vert Veille (possibilité d’effectuer 
une opération 
d’enregistrement ou de 
lecture à l’aide de la carte 
mémoire AXS)

Éteint  • Aucune carte mémoire AXS 
n’est chargée. 

 • La carte insérée est 
incorrecte. 

 • Une carte mémoire AXS est 
chargée mais l’autre fente 
est sélectionnée.

Retrait d’une carte mémoire AXS

1 Ouvrez le couvercle du bloc de fentes de 
carte.

2 Extrayez la carte mémoire AXS.

[Remarque]
L’intégrité des données ne sera pas garantie en cas de 
mise hors tension de l’appareil ou de retrait de la carte 
mémoire pendant son utilisation. Toutes les données de 
la carte risquent d’être détruites. Assurez-vous que le 
voyant ACCESS est allumé en vert ou est éteint lorsque 
vous mettez l’appareil hors tension ou retirez une carte 
mémoire.

Passage d’une carte mémoire AXS 
à l’autre

Lorsque des cartes mémoire AXS sont 
chargées en même temps dans la fente A 
et dans la fente B, vous pouvez appuyer sur 
le bouton SLOT SELECT (page 9) pour 
sélectionner la carte mémoire à utiliser.
Lorsqu’une carte est pleine, l’enregistrement 
se poursuit après avoir basculé 
automatiquement vers la deuxième carte.

[Remarque]
Le bouton SLOT SELECT est désactivé lorsqu’une 
opération d’enregistrement/lecture est en cours. Les 
cartes mémoire ne sont pas commutées même si vous 
appuyez sur le bouton.

Formatage (Initialisation) d’une 
carte mémoire AXS

Quand une carte mémoire AXS non formatée 
ou une carte mémoire AXS formatée sous 
d’autres spécifications est chargée, un 
message vous notifiant que le support a un 
système de fichier différent s’affiche. Dans ce 
cas, formatez la carte mémoire en utilisant la 
procédure suivante.

1 Sélectionnez la catégorie TC/Media > 
Format Media dans le menu.

2 Sélectionnez AXS Slot A (fente A) ou AXS 
Slot B (fente B), puis appuyez sur la 
molette MENU.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

3 Appuyez sur la touche ITEM 1 et la touche 
ITEM 3 et maintenez-les enfoncées 
pendant 3 secondes pour exécuter le 
formatage.
Le formatage démarre, un message est 
affiché pendant l’exécution et le voyant 
ACCESS s’allume en rouge.
À la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur la 
molette MENU pour ignorer le message.

En cas d’échec du formatage

Une carte mémoire AXS protégée en écriture 
ou qui ne peut pas être utilisée avec cet 
appareil ne sera pas formatée.
Un message d’avertissement est affiché. 
Remplacez la carte par une carte mémoire AXS 
appropriée, en accord avec les instructions du 
message.

Manipulation des cartes mémoire AXS
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[Remarque]
Toutes les données, y compris les images et fichiers 
de configuration enregistrés, sont effacées lors du 
formatage d’une carte mémoire.

Vérification de la durée 
d’enregistrement restante

Pendant la prise de vue (veille ou 
enregistrement), vous pouvez vérifier la 
capacité restante sur les cartes mémoire 
AXS chargées dans chaque fente en utilisant 
l’indicateur de la capacité restante du support 
d’enregistrement sur l’écran d’accueil de 
l’affichage auxiliaire (page 36) ou l’écran du 
viseur/du moniteur (page 14).
La durée d’enregistrement disponible 
dans le format vidéo actuel (débit binaire 
d’enregistrement) est calculée en fonction de 
l’espace restant sur chaque carte et s’affiche 
en minutes.

[Remarque]
L’icône  (protection) apparaît si une carte mémoire est 
protégée en écriture.

Échange d’une carte mémoire AXS

 • Si la durée restante totale sur les cartes 
mémoire insérées pendant l’enregistrement 
est inférieure au temps défini en utilisant 
Technical > Alerts & Tally > Media Near Full 
Alarm (page 91) dans le menu complet, 
l’indicateur de capacité restante du support 
clignote, le voyant REC clignote et un 
bip sonore est émis pour vous prévenir. 
Remplacez les cartes par des cartes 
disposant d’un espace suffisant.

 • Si vous continuez l’enregistrement, 
le message « Media Full » apparaît et 
l’enregistrement s’arrête lorsque la durée 
d’enregistrement totale restante passe à 0.

[Remarques]
 • Le nombre maximum de plans pouvant être 

enregistrés sur une seule carte mémoire AXS est 
indiqué ci-dessous.

 S24/S48 : environ 600
 S66 : de 430 à 440 environ
 • L’affichage de la durée d’enregistrement restante 

passe à « 0 » et le message « Media Full » apparaît 
lorsque la limite de plans est atteinte.

Restauration d’une carte mémoire 
AXS

Si, pour quelque raison que ce soit, une erreur 
se produit dans une carte mémoire, celle-ci 
doit être restaurée avant l’utilisation.
Si une carte mémoire AXS nécessitant une 
restauration est insérée dans l’appareil, 
un message vous invitant à exécuter une 
opération de restauration s’affiche sur 
l’affichage auxiliaire.
Pour démarrer le processus de restauration, 
sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.
La restauration démarre.
Pendant l’exécution, un message est affiché et 
le voyant ACCESS s’allume en rouge.
À la fin de la restauration, un message 
d’achèvement apparaît. Appuyez sur la 
molette MENU pour ignorer le message.

En cas d’échec de la restauration

 • Une carte mémoire AXS protégée en 
écriture ou une carte sur laquelle une erreur 
s’est produite ne peut pas être restaurée. 
Dans ce cas, un message d’avertissement 
s’affiche. Désactivez la protection en 
écriture ou remplacez la carte AXS, selon les 
instructions fournies dans le message.

 • Une carte mémoire AXS sur laquelle est 
survenue une erreur pourra être réutilisée 
une fois formatée.

 • Dans certains cas, certains plans peuvent 
être restaurés et d’autres non. Il est alors 
possible de lire à nouveau les plans 
restaurés.

[Remarque]
Veillez à utiliser cet appareil pour restaurer un support 
enregistré sur celui-ci.
Un support enregistré sur un autre appareil ou sur un 
appareil d’une autre version (même s’il s’agit du même 
modèle) risque de ne pas pouvoir être restauré à l’aide 
du présent appareil.
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Enregistrement sur une carte mémoire AXS

Vous pouvez sélectionner le format pour l’enregistrement sur une carte mémoire AXS à l’aide de la catégorie Project > Recording Format (page 56) dans le menu.
Pendant l’enregistrement autonome AXS, l’enregistrement passe automatiquement à la seconde carte mémoire AXS lorsque la première carte est pleine.

Si vous utilisez une carte mémoire AXS S24, S48 ou S66, les restrictions suivantes s’appliquent en fonction des réglages Recording Format et Imager Mode. Si une carte mémoire AXS S24 ou S48 est 
détectée pour un réglage où les cartes mémoire AXS S24 ou S48 ne sont pas prises en charge, une invite pour utiliser une carte AXS S66 s’affiche.

MPC-3628

Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X-OCN XT 8.6K 3:2 S66 S66 S66 – – – – – – – – – – – –

8.2K 17:9
7.6K 16:9

S48/S66 S48/S66 S48/S66 –1) –1) –1) – – – – – – – – –

5.8K 6:5 S48/S66 S48/S66 S48/S66 S66 – – – – – – – – – – –

5.8K 17:9
5.4K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 –1) –1) – – – –

X-OCN ST 8.6K 3:2 S48/S66 S48/S66 S48/S66 – – – – – – – – – – – –

8.2K 17:9
7.6K 16:9

S48/S66 S48/S66 S48/S66 S66 S66 S66 – – – – – – – – –

5.8K 6:5 S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 – – – – – – – – – – –

5.8K 17:9
5.4K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S66 S66 – – – –

X-OCN LT 8.6K 3:2 S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – – – – –

8.2K 17:9
7.6K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

5.8K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

5.8K 17:9
5.4K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 – – – –

4K ProRes 4444 8.2K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

5.8K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – – – –

5.8K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –
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Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

4K ProRes 422 
HQ

8.2K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – –

5.8K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

5.8K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 – – – – – –

QFHD ProRes 
4444

7.6K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – –

5.4K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – –

QFHD ProRes 422 
HQ

7.6K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – –

5.4K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – –

1) Lorsque vous utilisez des cartes mémoire AXS S66, l’enregistrement est pris en charge en changeant le format d’enregistrement sur X-OCN ST ou LT. Lorsque vous utilisez des cartes mémoire AXS S48, l’enregistrement est pris en charge en 
changeant le format d’enregistrement sur X-OCN LT.



2. Préparatifs : Manipulation des cartes mémoire AXS30

MPC-3626

Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X-OCN XT 6K 3:2 S48/S66 S48/S66 S48/S66 S66 S66 S66 – – – – – – – – –

6K 1.85:1 S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 – – – – – – –

6K 17:9
5.7K 16:9

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 – – – – – – –

6K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S66 S66 S66 S66 – – – –

4K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 – – – – – – –

4K 4:3 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – – –

4K 4:3 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 – – – – – –

4K 17:9 
Surround View
3.8K 16:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

4K 17:9
3.8K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 –

4K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66
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Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X-OCN ST 6K 3:2 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

6K 1.85:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 – – – – – – –

6K 17:9
5.7K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 – – – – – – –

6K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 – – – –

4K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – –

4K 4:3 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – – –

4K 4:3 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – –

4K 17:9 
Surround View
3.8K 16:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

4K 17:9
3.8K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 –

4K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66
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Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X-OCN LT 6K 3:2 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – –

6K 1.85:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – –

6K 17:9
5.7K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – –

6K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – –

4K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – –

4K 4:3 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – – –

4K 4:3 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – –

4K 17:9 
Surround View
3.8K 16:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

4K 17:9
3.8K 16:9

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

–

4K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

4K ProRes 4444 6K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

6K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

4K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

4K 17:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – – – –

4K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –

4K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 – – – – – – – – –
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Format 
d’enregistrement

Imager Mode Fréquence d’images de prise de vue et prise en charge des cartes mémoire AXS S24/S48/S66

24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

4K ProRes 422 
HQ

6K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – –

6K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 – – – – – –

4K 6:5 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – –

4K 17:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

4K 17:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 – – – –

4K 2.39:1 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 S48/S66 S48/S66 – – – –

QFHD ProRes 
4444

5.7K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – –

3.8K 16:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

3.8K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 – – – – – – – – –

QFHD ProRes 422 
HQ

5.7K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – –

3.8K 16:9 
Surround View

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

– – – – – – – – – – –

3.8K 16:9 S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S24/S48/
S66

S48/S66 S48/S66 – – – –
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Manipulation des cartes SD pour sauvegarder des données de configuration
Vous pouvez stocker le fichier de configuration 
du caméscope sur une carte SD (en option). 
Le fichier stocké peut être chargé à partir de la 
carte SD.

Cartes SD prises en charge

Cartes mémoire SDXC* (système de fichiers : 
exFAT, classe de vitesse : 4 à 10, non UHS, 
capacité : 64 Go à 2 To)
Cartes mémoire SDHC* (système de fichiers : 
FAT32, classe de vitesse : 4 à 10, non UHS, 
capacité : 4 Go à 32 Go)
Cartes mémoire SD* (Système de fichiers : 
FAT16, capacité : jusqu’à 2 Go)
* Désignées sous le nom de « Cartes SD » dans ce 

manuel.

Insertion d’une carte SD

Insérez une carte SD dans la fente de carte SD 
(page 13).
Le voyant ACCESS (page 11) s’allume en 
rouge, puis en vert une fois la carte mémoire 
opérationnelle.

État du voyant ACCESS

Voyant État de la fente

S’allume en 
rouge

Accès à la carte SD (écriture/
lecture de données)

Éteint  • Aucune carte SD n’est 
insérée.

 • La carte insérée est 
incorrecte.

Retrait d’une carte SD

Enfoncez la carte SD légèrement, puis enlevez 
la carte.

[Remarques]
 • L’intégrité des données ne sera pas garantie en cas 

de mise hors tension de l’appareil ou de retrait de 
la carte mémoire pendant son utilisation. Toutes les 
données de la carte risquent d’être détruites. Assurez-
vous que le voyant ACCESS est allumé en vert ou est 
éteint lorsque vous mettez l’appareil hors tension ou 
retirez une carte mémoire.

 • Assurez-vous que la carte ne s’éjecte pas quand vous 
l’insérez ou que vous la retirez.

Formatage (initialisation) d’une 
carte SD

Les cartes SD doivent être formatées lors de 
leur première utilisation dans l’appareil.
Les cartes SD devant être utilisées dans 
l’appareil doivent être formatées à l’aide de 
la fonction de formatage de l’appareil. Vous 
devez aussi formater une carte mémoire SD 
si un message d’avertissement s’affiche au 
moment de son insertion.
Si une carte SD qui a été formatée dans 
un format non pris en charge est insérée 
dans l’appareil, un message de disparité du 
système de fichier s’affiche.

1 Sélectionnez la catégorie TC/Media > 
Format Media > SD Card dans le menu, 
puis appuyez sur la molette MENU.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

2 Appuyez sur la touche ITEM 1 et la touche 
ITEM 3 et maintenez-les enfoncées 
pendant 3 secondes pour exécuter le 
formatage.

Le formatage démarre, un message est 
affiché pendant l’exécution et le voyant 
ACCESS s’allume en rouge.
À la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur la 
molette MENU pour ignorer le message.

[Remarque]
Lors du formatage d’une carte SD, toutes les données 
sont effacées et ne peuvent plus être restaurées.

Pour utiliser un support formaté avec cet 
appareil dans les fentes d’autres 
périphériques

Effectuez une sauvegarde du support, puis 
formatez-le à l’aide de l’autre périphérique.
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Affichage auxiliaire
L’affichage auxiliaire affiche l’écran d’accueil, l’écran de liste de plans, l’écran de lecture, l’écran de menu, l’écran de menu complet et l’écran des 
fonctions d’utilisateur.
Vous pouvez passer entre les écrans sur l’affichage auxiliaire à l’aide des boutons sur le côté assistant de l’appareil.

Écran des fonctions d’utilisateur

Écran d’accueil Écran de liste de plans

Écran de menu Écran de menu complet

Écran de lecture

Bouton USER

Bouton USER

Bouton MENU

Bouton HOME

Bouton HOME

Bouton HOME

Bouton CLIPS

Bouton CLIPS

Bouton CLIPS

Bouton USER

Bouton MENU

Bouton MENU



3. Opérations du caméscope : Affichage auxiliaire36

Écran d’accueil

Appuyez sur le bouton HOME du côté assistant pour afficher l’écran d’accueil. Vous pouvez 
contrôler l’état de l’appareil et définir ses réglages de base sur l’écran d’accueil.

Zone d’affichage 
Nom d’élément/
Valeur de 
réglage/Fonction

Zone 
d’affichage 
d’état

Zone d’affichage Nom d’élément/Valeur de réglage/Fonction

1 2 3

4 5 6

Touche ITEM 4 Touche ITEM 5 Touche ITEM 6

Touche ITEM 3Touche ITEM 2Touche ITEM 1

[Remarque]
Les zones étiquetées 1 à 6 correspondent aux touches 
ITEM 1 à 6 (page 48). Appuyez sur une touche ITEM 
pour sélectionner l’élément correspondant. Les touches 
ITEM pour les fonctions affichées en orange sont 
activées.

1. FPS
Affiche et règle la fréquence d’images vidéo.

2. Exposure Index/Gain
Affiche et règle l’indice d’exposition (EI) ou le 
gain réglé par une RM-B170 ou une autre unité 
de télécommande (l’icône supérieure affiche 
la sensibilité de base).

[Remarque]
La valeur de gain n’est affichée que lorsque Technical 
> Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

3. Shutter
Affiche et règle la vitesse d’obturation/l’angle 
d’obturation de l’obturateur électronique.

4. ND Filter
Affiche et règle la position du filtre ND.

5. LUT
Affiche et règle le LUT du moniteur.

6. WB (White Balance)
Affiche et règle la balance des blancs.
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Zone d’affichage d’état

1 2 3 4 6 7

91011

5

8
14
13
12

1. Affichage des données temporelles
Affiche la durée ou le code temporel, en 
fonction du réglage de la catégorie TC/Media 
> TC Display dans le menu (page 57).
Affiche le type de données actuellement 
affichées sur l’affichage des données 
temporelles, comme suit.
TCG : code temporel enregistré
TCR : code temporel de lecture
Dur : durée

2. Icône Ext-LK
S’affiche lorsque le générateur de code 
temporel interne est verrouillé sur une entrée 
de signal externe via le connecteur TC IN 
(entrée de code temporel).

3. Indicateur de fréquence d’images
Affiche la valeur du réglage de la catégorie 
Project > Project Frame Rate dans le menu 
(page 56).

4. Icône Genlock
Affiche l’état de verrouillage à l’état genlock.

5. Indicateur de mode d’imageur
Affiche le réglage de la catégorie Project > 
Imager Mode dans le menu, ainsi que les 
informations de décompression.

6. Indicateur de tension d’alimentation/
capacité restante de la batterie

Affiche la tension d’alimentation ou la 
capacité restante de la batterie.

7. Affichage du nom de plan
Affiche « Reel: Camera ID + Reel Number » et 
« ShotNumber ».

8. Vu-mètres audio
Affiche les niveaux d’enregistrement ou de 
lecture audio. Les numéros 1 et 2 indiquent les 
canaux 1 et 2.

9. Indicateur du format d’enregistrement 
(codec)

Affiche le format d’enregistrement sur une 
carte mémoire AXS (page 61).

10. Indicateur de réglage Zoom to Fit
Affiche le réglage Project > Basic Setting 
> Zoom to Fit (page 75) dans le menu 
complet.

[Remarque]
Ne s’affiche pas lorsque Zoom to Fit est réglé sur Off ou 
n’est pas disponible.

11. Indicateur de capacité restante du 
support

Affiche l’icône du support actif, le type 
de support, le type de fente (A/B) et la 
durée d’enregistrement restante (lors 
de l’enregistrement dans le format 
d’enregistrement actuel).
Il affiche également le nom du plan pendant 
la lecture.

12. Indicateur de l’état d’enregistrement
Affiche les états d’opération d’enregistrement 
suivants de l’appareil.

Affichage Description

   Stby Veille d’enregistrement

ĆRec Enregistrement

ĆCache Veille d’enregistrement en 
cache d’image

   CALL Commande CALL entrant

13. Icône de thermomètre
S’affiche lorsqu’un message d’avertissement 
de température élevée est émis.
La description s’affiche dans la catégorie Info 
du menu.

14. Icône d’avertissement
S’affiche lorsqu’un message différent d’un 
avertissement de température élevée est 
émis.
La description s’affiche dans la catégorie Info 
du menu.
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Opérations sur l’écran d’accueil de l’affichage auxiliaire

Fonctionnement de base

1 Appuyez sur le bouton HOME.
L’écran d’accueil apparaît.

2 Sélectionnez l’élément à régler en utilisant 
les touches ITEM 1 à 6.
La valeur de réglage pour les éléments 
pouvant être modifiés est affichée en 
orange.
Le diagramme suivant montre un exemple 
lorsque la touche ITEM 3 est enfoncée.

3 Déplacez le curseur vers l’élément ou la 
valeur de réglage à sélectionner en 
utilisant le bouton  (touche ITEM 2), le 
bouton  (touche ITEM 5) ou la molette 
MENU.

4 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Changement de la luminosité de 
l’affichage auxiliaire

Vous pouvez changer la luminosité de 
l’affichage auxiliaire à l’aide de Technical > 
Panel Control > Brightness level (page 92) 
dans le menu complet.
Sur l’écran d’accueil, vous pouvez également 
appuyer et maintenir le bouton BACK enfoncé 
et tourner la molette MENU dans le sens 
des aiguilles d’une montre pour modifier la 
luminosité de l’affichage auxiliaire dans l’ordre 
Minimum � Low � Mid � High avec le 
réglage actuel défini comme point de base.
Vous pouvez également appuyer et maintenir 
le bouton BACK enfoncé et tourner la molette 
MENU dans le sens inverse des aiguilles 
d’une montre pour modifier la luminosité de 
l’affichage auxiliaire dans l’ordre High � Mid 
� Low � Minimum avec le réglage actuel 
défini comme point de base.

[Remarque]
Le réglage de luminosité de l’affichage est commun 
à l’affichage auxiliaire et au mini-écran, et se reflète 
simultanément sur les deux affichages.

Affichage et fonctionnement quand RM/
RCP Paint Control est activé

 • La valeur de gain s’affiche dans la zone 
de contrôle EI lorsque Technical > Special 
Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet. Dans ce mode, la valeur EI ne peut 
pas être modifiée, mais la valeur de gain 
peut être modifiée (page 39). Cependant, 
le réglage Base ISO peut être commuté.

 • Les zones de contrôle suivantes sont 
grisées et ne peuvent pas être utilisées 
lorsqu’une RM-B170 ou une autre unité de 
télécommande est connectée et Technical 
> Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le 
menu complet. Réglez ces options à l’aide 
de l’unité de télécommande (page 118).

 • Zone de contrôle d’obturation
 • Zone de contrôle de balance des blancs
 • Zone de contrôle de gain

Opération Step Edit

Vous pouvez changer les réglages pouvant 
être sélectionnés lorsque « Step Edit » 
s’affiche pour la touche ITEM 4 à l’étape 2 du 
fonctionnement de base. Vous pouvez ajouter 
et supprimer les réglages sur l’écran de 
modification des réglages.

1 Sur l’écran de sélection des réglages, 
déplacez le curseur sur le réglage que 
vous souhaitez modifier ou supprimer, 
puis appuyez sur le bouton Step Edit 
(touche ITEM 4).
L’écran de modification des réglages 
apparaît.

2 Pour supprimer un réglage, appuyez sur le 
bouton Delete (touche ITEM 4).

 [Remarque]
Le réglage sélectionné peut être supprimé si la 
chaîne de caractères « Delete » s’affiche en orange.

3 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer un réglage.

4 Une fois terminé, appuyez sur le bouton 
Add (touche ITEM 4).

Le réglage est ajouté et l’affichage revient 
à l’écran de sélection de réglage.

 [Remarque]
Un réglage peut être ajouté si la chaîne de 
caractères « Add » s’affiche en orange.

Lors du réglage de White Balance

Lors du réglage de White Balance vous pouvez 
appuyer sur le bouton Coarse/Fine (touche 
ITEM 1) pour changer la variation sur grossier 
ou précis, par incréments de 1. Vous pouvez 
également appuyer sur le bouton Temp/Tint 
(touche ITEM 3) pour changer la valeur entre 
température de couleur (Temp) et teinte de 
couleur (Tint).

Opération FPS

Appuyez sur la touche ITEM 1 sur l’écran 
d’accueil pour afficher l’écran d’opération FPS. 
Vous pouvez appuyer sur le bouton Variable/
Fixed (touche ITEM 4) pour passer de « Fixed » 
pour la prise de vue à vitesse constante à 
« Variable (Select FPS) » pour la prise de vue à 
vitesse variable.
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[Remarque]
L’audio n’est pas enregistré en mode « Select FPS ».

Opération EI/Opération Gain

Vous pouvez modifier la valeur EI. La valeur 
de gain s’affiche au lieu de la valeur EI lorsque 
Technical > Special Configuration > RM/RCP 
Paint Control (page 93) est réglé sur On 
dans le menu complet. Vous pouvez modifier 
la valeur du gain lorsqu’une RM-B170 ou une 
autre télécommande n’est pas connectée.

Modification de la valeur EI ou de la 
valeur de gain

[Remarque]
Cette section montre l’affichage pour la modification de 
la valeur EI en tant qu’exemple.

Vous pouvez modifier la valeur EI ou la valeur 
de gain en utilisant la touche ITEM 2 sur 
l’écran d’accueil.

1 Appuyez sur la touche ITEM 2 sur l’écran 
d’accueil.
L’écran de configuration EI ou l’écran de 
configuration Gain apparaît.

2 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer un réglage.

3 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Commutation de Base ISO

Vous pouvez commuter Base ISO en 
appuyant sur la touche ITEM 4 sur l’écran de 
configuration EI ou l’écran de configuration 
Gain.

1 Appuyez sur la touche ITEM 4 sur l’écran 
de configuration EI ou l’écran de 
configuration Gain.
L’écran de commutation de Base ISO 
apparaît.

2 Appuyez simultanément sur les deux 
boutons Change (touche ITEM 1 et touche 
ITEM 3).

Base ISO est changé (page 46).

Opération AWB

Appuyez sur la touche ITEM 6 sur l’écran 
d’accueil pour afficher l’écran d’opération de 
la balance des blancs. Appuyez sur le bouton 
Auto White Bal. (touche ITEM 1) pour exécuter 
la balance des blancs. Après l’exécution, 
appuyez sur le bouton Add (touche ITEM 4) 
pour ajouter le réglage à une étape. Vous 
pouvez également appuyer sur le bouton 
Temp/Tint (touche ITEM 3) pour changer 
la valeur entre la température de couleur 
(Temp) et la teinte de couleur (Tint) pour faire 
des ajustements précis sur la valeur avant 
d’ajouter une valeur à l’étape.

[Remarque]
Pendant l’opération AWB, filmez une cible blanche sous 
des conditions d’éclairage uniformes.

Opération LUT

Réglage d’un LUT

Vous pouvez régler un LUT pour chaque 
système de sortie en utilisant la touche ITEM 5 
sur l’écran d’accueil.

1 Appuyez sur la touche ITEM 5 sur l’écran 
d’accueil.
L’écran de sélection du LUT s’affiche.

 [Remarque]
Les informations de gamma utilisateur s’affichent 
sur l’écran de sélection du LUT lorsque Project > 
Basic Setting > Input Color Space (page 74) est 
réglé sur Rec.2020/User Gamma ou Rec.709/User 
Gamma dans le menu complet.

2 Sélectionnez la sortie à régler à l’aide des 
touches ITEM 1, 2, 3 et 6.
L’écran de modification des réglages 
apparaît.

3 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer un réglage.

4 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.
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Éléments d’affichage de l’écran de sélection du LUT

Les éléments affichés varient selon le réglage du format de sortie.

1 2 3

54 6

Touche ITEM 5Touche ITEM 4 Touche ITEM 6

Touche ITEM 3Touche ITEM 2Touche ITEM 1

Output Format Indication d’affichage

SDI1/2 SDI3/4 Monitor HDMI VF Touche 
ITEM 1

Touche 
ITEM 2

Touche 
ITEM 3

Touche 
ITEM 5

Touche 
ITEM 6

4K/QFHD
12G/6G

FHD FHD 4K/
QFHD

FHD SDI 1/2, 
HDMI

SDI 3/4, 
Monitor

Viewfinder Vide ProRes1)

FHD SDI 1/2 SDI 3/4, 
Moni, HDMI

Viewfinder Vide ProRes1)

4K/QFHD Square 
Quad

FHD SDI 1/2/3/4 Vide Viewfinder Monitor, 
HDMI

ProRes1)

4K/QFHD 2SI Quad 4K/
QFHD

SDI 1-4, 
HDMI

Vide Viewfinder Monitor ProRes1)

FHD SDI 1/2/3/4 Vide Viewfinder Monitor, 
HDMI

ProRes1)

Output Format Indication d’affichage

SDI1/2 SDI3/4 Monitor HDMI VF Touche 
ITEM 1

Touche 
ITEM 2

Touche 
ITEM 3

Touche 
ITEM 5

Touche 
ITEM 6

4K/QFHD 
Square 
Dual

FHD FHD FHD FHD SDI 1/2 SDI 3/4, 
Moni, HDMI

Viewfinder Vide ProRes1)

4K/QFHD 
2SI Dual

FHD 4K/
QFHD

SDI 1/2, 
HDMI

SDI 3/4, 
Monitor

Viewfinder Vide ProRes1)

FHD SDI 1/2 SDI 3/4, 
Moni, HDMI

Viewfinder Vide ProRes1)

2K/FHD FHD FHD SDI 1/2 SDI 3/4 Viewfinder Monitor, 
HDMI

ProRes1)

FHD FHD – SD SDI 1/2 SDI 3/4 Viewfinder Monitor HDMI

1) Vide lorsque Project > Basic Setting > Recording Format est réglé sur le format X-OCN dans le menu complet

Modification de Preset Look

Vous pouvez régler un LUT lorsque Look est 
sélectionné sur l’écran de sélection du LUT à 
l’aide du bouton Edit Look (touche ITEM 4) sur 
l’écran de sélection du LUT.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Sélectionnez Category > Preset Look, 
utilisez le bouton  (touche ITEM 5) ou la 
molette MENU pour déplacer le curseur 
sur Preset Look, puis appuyez sur le 
bouton Select (touche ITEM 3).
Les éléments qui peuvent être 
sélectionnés s’affichent.

3 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer un réglage.

4 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Modification de la catégorie LUT

Vous pouvez modifier la catégorie cible des 
opérations LUT sur User 3D LUT, ART, ACES ou 
Preset Look (page 68).

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur Category, et 
appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).

3 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner une catégorie 
(User 3D LUT, ART, ACES ou Preset Look).
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 [Remarque]
Les options de sélection changent de la manière 
suivante, en fonction du réglage Project > Basic 
Setting > Input Color Space (page 74) dans le 
menu complet.
 – S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 : 

Preset Look / User 3D LUT / ART
 – ACEScct : Preset Look / ACEScct with User 3D / 

ACESproxy with User 3D / ACES with ART

4 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Chargement d’un fichier User 3D LUT

Vous pouvez charger un fichier User 3D LUT 
stocké sur une carte SD dans l’appareil.
Vous pouvez également charger un fichier 
User 3D LUT dans l’appareil via un réseau 
(page 106).

[Remarque]
Enregistrez le fichier User 3D LUT dans le répertoire 
suivant sur la carte SD (page 112).
PRIVATE\SONY\PRO\LUT\

1 Insérez la carte SD dans la fente de carte 
SD (page 13).

2 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

3 Appuyez sur le bouton Load File (touche 
ITEM 4).
L’écran de sélection de type de fichier 
apparaît.

4 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner Load User 3D LUT 
File.

5 Appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).
Les numéros de destination de 
chargement (01 à 16) s’affichent.
Un nom de fichier s’affiche pour les 
numéros chargés.

6 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un numéro de 
destination de chargement.

7 Appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).
Le nom de fichier du fichier User 3D LUT 
stocké sur la carte SD s’affiche.

8 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un fichier.

9 Appuyez sur la molette MENU ou sur le 
bouton Load (touche ITEM 3).
Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

10 Appuyez sur le bouton OK (touche ITEM 
6).

Chargement d’un fichier ART

Vous pouvez charger un fichier ART stocké sur 
une carte SD dans l’appareil.
Vous pouvez également charger un fichier ART 
dans l’appareil via un réseau (page 107).

[Remarque]
Enregistrez le fichier ART dans le répertoire suivant sur la 
carte SD (page 112).
MPC-3628 : 
PRIVATE\SONY\PRO\CAMERA\MPC3628
MPC-3626 : 
PRIVATE\SONY\PRO\CAMERA\MPC3626

1 Insérez la carte SD dans la fente de carte 
SD (page 13).

2 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

3 Appuyez sur le bouton Load File (touche 
ITEM 4).
L’écran de sélection de type de fichier 
apparaît.

4 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner Load ART File.

5 Appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).
Les numéros de destination de 
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chargement (01 à 16) s’affichent.
Un nom de fichier s’affiche pour les 
numéros chargés.

6 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un numéro de 
destination de chargement.

7 Appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).
Le nom de fichier du fichier ART stocké 
sur la carte SD s’affiche.

8 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un fichier.

9 Appuyez sur la molette MENU ou sur le 
bouton Load (touche ITEM 3).
Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

10 Appuyez sur le bouton OK (touche ITEM 
6).

Chargement d’un fichier ASC CDL

Vous pouvez charger un fichier ASC CDL 
stocké sur une carte SD dans l’appareil.
Vous pouvez également charger un fichier ASC 
CDL dans l’appareil via un réseau (page 107).

[Remarque]
Enregistrez le fichier ASC CDL dans le répertoire suivant 
sur la carte SD (page 112).
PRIVATE\SONY\PRO\CDL\

1 Insérez la carte SD dans la fente de carte 
SD (page 13).

2 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

3 Appuyez sur le bouton Load File (touche 
ITEM 4).
L’écran de sélection de type de fichier 
apparaît.

4 Sélectionnez Load ASC CDL File et 
appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).

Le nom de fichier du fichier ASC CDL 
stocké sur la carte SD s’affiche.

5 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un fichier.

6 Appuyez sur la molette MENU ou sur le 
bouton Load (touche ITEM 3).
Vous pouvez appuyer sur le bouton Load 
All Files (touche ITEM 1) pour charger tous 
les fichiers.
Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

7 Appuyez sur le bouton OK (touche ITEM 
6).

Modification d’un fichier User 3D 
LUT

Vous pouvez modifier le fichier User 3D LUT 
actuellement sélectionné.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur Category, et 
appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3) pour 
sélectionner User 3D LUT.

3 Déplacez le curseur sur User 3D LUT, et 
appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3).

4 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer le fichier User 3D LUT.
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5 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Modification du fichier ART

Vous pouvez modifier le fichier ART 
actuellement sélectionné.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur Category, et 
appuyez sur la molette MENU ou sur le 
bouton Select (touche ITEM 3) pour 
sélectionner ART.

3 Déplacez le curseur sur ART, et appuyez 
sur la molette MENU ou sur le bouton 
Select (touche ITEM 3).

4 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour modifier le fichier ART.

5 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Affichage des informations du fichier 
ART

Vous pouvez afficher des informations pour le 
fichier ART actuellement sélectionné.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur ART, et appuyez 
sur le bouton CDL / ART Info (touche ITEM 
1).

Les informations du fichier ART 
s’affichent.

Modification du fichier ASC CDL

Vous pouvez modifier le fichier ASC CDL 
actuellement sélectionné.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Sélectionnez ASC CDL Select et appuyez 
sur la molette MENU ou sur le bouton 
Select (touche ITEM 3).

3 Utilisez le bouton  (touche ITEM 2), le 
bouton  (touche ITEM 5) ou la molette 
MENU pour modifier le fichier ASC CDL.

 [Remarque]
Les fichiers qui ne peuvent pas être appliqués sur 
l’appareil sont grisés.

4 Appuyez sur la molette MENU ou sur le 
bouton Set (touche ITEM 3) pour appliquer 
le réglage.

Spécifier l’ordre de traitement du fichier 
ASC CDL

Vous pouvez spécifier l’ordre de traitement 
ASC CDL à l’aide de ASC CDL Process sur 
l’écran de sélection Look.
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Affichage des informations du fichier 
ASC CDL

Vous pouvez afficher des informations pour le 
fichier ASC CDL actuellement sélectionné.

1 Appuyez sur le bouton Edit Look (touche 
ITEM 4) sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur ASC CDL Select, et 
appuyez sur le bouton CDL / ART Info 
(touche ITEM 1).
L’écran d’information du fichier ASC CDL 
apparaît.

Vous pouvez modifier le réglage 
Saturation sur l’écran d’information du 
fichier ASC CDL.

Modifier la saturation

1 Appuyez sur le bouton Edit (touche ITEM 
4) sur l’écran d’information du fichier ASC 
CDL.
L’écran de modification Saturation 
apparaît.

2 Déplacez le curseur sur le chiffre à 
modifier à l’aide de la molette MENU, puis 
appuyez sur la molette MENU.

3 Utilisez la molette MENU pour modifier le 
réglage, puis appuyez sur molette MENU.
La plage du réglage Saturation est 
comprise entre 0.000 et 3.999.

 [Remarque]
Si vous saisissez une valeur qui dépasse la plage 
de réglage et appuyez sur la molette MENU, la 
valeur précédente est rétablie.

4 Déplacez le curseur sur le bouton Set à 
l’aide de la molette MENU, puis appuyez 
sur la molette MENU.

À propos des plages de réglage du 
fichier ASC CDL

Les plages de réglage du fichier ASC CDL sont 
indiquées ci-dessous. Les fichiers dépassant les 
plages ne peuvent pas être chargés.
Slope : 0.000 à 3.999
Offset : –1.000 à 1.000
Power : 0.400 à 4.000
Saturation : 0.000 à 3.999

Éléments de l’écran d’accueil sur l’affichage auxiliaire

Les noms des éléments et les valeurs de réglage correspondantes sont indiqués ci-dessous.
Les valeurs par défaut sont soulignées et affichées en gras.

Élément Description

FPS Permet de régler la fréquence d’images de prise de vue.
Variable/Fixed : permet de basculer entre la prise de vue à vitesse variable 
et à vitesse constante.
Lorsque « Fixed » est sélectionné, le réglage est déterminé par le réglage 
de la catégorie Project > Project Frame Rate (page 56) dans le menu.

Project Frame Rate Affichage

23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94
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Élément Description

Lorsque « Variable » est sélectionné, les réglages changent de la manière 
suivante, en fonction des réglages de la catégorie Project > Imager Mode 
(page 74) et Recording Format (page 74) dans le menu.
Enregistrement X-OCN
MPC-3628

Imager Mode Fréquence d’images de prise de 
vue

8.6K 3:2 1 à 30 IPS

8.2K 17:9
7.6K 16:9

1 à 60 IPS

5.8K 6:5 1 à 48 IPS

5.8K 17:9
5.4K 16:9

1 à 60, 66, 72, 75, 88, 90 IPS

MPC-3626

Imager Mode Fréquence d’images de prise de 
vue

6K 3:2 1 à 60 IPS

6K 1.85:1
6K 17:9
5.7K 16:9

1 à 60, 66, 72 IPS

6K 2.39:1 1 à 60, 66, 72, 75, 88, 90 IPS

4K 6:5 1 à 60, 66, 72 IPS

4K 4:3 1 à 60, 66, 72, 75 IPS

4K 4:3 Surround View 1 à 30 IPS

4K 17:9
3.8K 16:9

1 à 60, 66, 72, 75, 88, 90, 96, 100, 
110 IPS

4K 17:9 Surround View
3.8K 16:9 Surround View

1 à 48 IPS

4K 2.39:1 1 à 60, 66, 72, 75, 88, 90, 96, 100, 
110, 120 IPS

Élément Description

Enregistrement ProRes
MPC-3628

Imager Mode Fréquence d’images de prise de vue

ProRes 4K / QFHD

4444 422 HQ

8.2K 17:9
7.6K 16:9

1 à 60 IPS 1 à 60 IPS

5.8K 6:5 1 à 48 IPS 1 à 48 IPS

5.8K 17:9
5.4K 16:9

1 à 60 IPS 1 à 60, 66, 72, 75 IPS

MPC-3626

Imager Mode Fréquence d’images de prise de vue

ProRes 4K / QFHD

4444 422 HQ

6K 17:9
5.7K 16:9

1 à 60 IPS 1 à 60, 66, 72 IPS

6K 2.39:1 1 à 60 IPS 1 à 60, 66, 72, 75 IPS

4K 6:5 1 à 60 IPS 1 à 60, 66, 72 IPS

4K 17:9
3.8K 16:9

1 à 60 IPS 1 à 60, 66, 72, 75, 88, 
90 IPS

4K 17:9 Surround View
3.8K 16:9 Surround View

1 à 48 IPS 1 à 48 IPS

4K 2.39:1 1 à 60 IPS 1 à 60, 66, 72, 75, 88, 
90 IPS

[Remarque]
Une fréquence d’images de prise de vue de 7 ou inférieure ne peut pas être définie 
dans les cas suivants.

 – Lorsque Base ISO est réglé sur ISO 3200
 – Lorsque Base ISO est réglé sur ISO 2500 et le format d’enregistrement est ProRes
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Élément Description

Exposure Index Définit la valeur EI. Vous pouvez modifier le réglage Base ISO en appuyant 
sur le bouton Change Base (touche ITEM 4), puis en appuyant 
simultanément sur les deux boutons Change (touche ITEM 1 et touche ITEM 
3) sur l’écran qui suit. Les réglages disponibles varient comme suit en 
fonction du réglage Base ISO.
MPC-3628

Base ISO 800 :
200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/3200EI

Base ISO 3200 :
800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI/12800EI

MPC-3626
Base ISO 500 :

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

Base ISO 2500 :
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI

Gain Règle la sensibilité de base.
–6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

[Remarque]
Configurable uniquement lorsqu’une RM-B170 ou une autre unité de télécommande 
est connectée et Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Élément Description

Shutter Règle la vitesse d’obturation/l’angle de l’obturateur électronique.
Appuyez sur le bouton Step/Cont. (touche ITEM 1) pour commuter entre les 
méthodes de sélection continue et progressive.
Step : sélectionnez jusqu’à 16 valeurs préréglées enregistrées en tant 
qu’étapes d’obturation. Vous pouvez appuyer sur le bouton Step Edit 
(touche ITEM 4) pour changer la valeur préréglée de n’importe quel réglage 
après la sélection.

Affiche les options de sélection suivantes en fonction du réglage 
Technical > System Configuration > Shutter Mode (page 89) dans le 
menu complet.

Angle : indicateur d’angle d’obturation

Options de sélection par défaut
360/180/172.8/144/90/45/22.5/11.2/5.6

Speed : indicateur de vitesse d’obturation

Options de sélection par défaut
1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000,  
1/2000 1)

[Remarque]
Les valeurs de vitesse par défaut pour différents réglages Project Frame Rate 
(page 56) sont indiquées ci-dessous.
23.98/24 : 1/24, 25 : 1/25, 29.97 : 1/30, 47.95 : 1/48, 50 : 1/50, 59.94 : 1/60

Cont. : sélectionnez un angle/une vitesse au sein de la plage prise en 
charge.

ND Filter Règle la position du filtre ND. Les réglages suivants sont disponibles.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
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Élément Description

LUT Configure les réglages relatifs au LUT à appliquer à la vidéo de sortie. Les 
réglages varient en fonction du réglage Technical > Special Configuration > 
RM/RCP Paint Control (page 93) dans le menu complet.
SDI 1/2

Lorsque RM/RCP Paint Control est réglé sur Off : Log/Look
Sélectionne le LUT à appliquer à l’image de sortie SDI 1/2.

Lorsque RM/RCP Paint Control est réglé sur On : Log/HLG(Natural)/
HLG(Live)/User Gamma

Le réglage de l’image de sortie SDI 1/2 est affiché, car il est déterminé 
par le réglage catégorie Project > Input Color Space dans le menu.

SDI 3/4
Lorsque RM/RCP Paint Control est réglé sur Off : Log/Look

Sélectionne le LUT à appliquer à l’image de sortie SDI 3/4.
Lorsque RM/RCP Paint Control est réglé sur On : Log/HLG(Natural)/

HLG(Live)/User Gamma
Le réglage de l’image de sortie SDI 3/4 est affiché, car il est déterminé 
par le réglage catégorie Project > Input Color Space dans le menu.

Monitor
Lorsque RM/RCP Paint Control est réglé sur Off :

Sélectionne le LUT à appliquer à l’image de sortie Monitor.
Les réglages changent de la manière suivante, en fonction du réglage 
de la catégorie Project > Input Color Space dans le menu.

S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 : Log/s709/R709(800%)/
Look

ACEScct : Log/s709/R709(800%)/Look
Lorsque RM/RCP Paint Control est réglé sur On :

Sélectionne le type d’image de sortie Monitor.
Les réglages changent de la manière suivante, en fonction du réglage 
de la catégorie Project > Input Color Space dans le menu.

S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 : Log/R709(800%)
HLG(Natural) : HLG(Natural)/R709(800%)
HLG(Live) : HLG(Live)/R709(800%)
Rec.2020/User Gamma : User Gamma/R709-Like
Rec.709/User Gamma : User Gamma

Élément Description

Viewfinder
Lorsque RM/RCP Paint Control est réglé sur Off :

Sélectionne le LUT à appliquer à l’image de sortie de l’écran du 
moniteur/du viseur.
Les réglages changent de la manière suivante, en fonction du réglage 
de la catégorie Project > Input Color Space dans le menu.

S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 : Log/s709/R709(800%)/
Look

ACEScct : Log/s709/R709(800%)/Look
Lorsque RM/RCP Paint Control est réglé sur On :

Sélectionne le type d’image de sortie de l’écran du moniteur/du viseur.
Les réglages changent de la manière suivante, en fonction du réglage 
de la catégorie Project > Input Color Space dans le menu.

S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 : Log/R709(800%)
HLG(Natural) : HLG (Naturel)
HLG (Live) : HLG (Live)
Rec.2020/User Gamma : User Gamma/R709-Like
Rec.709/User Gamma : User Gamma

ProRes(Recording)
Lorsque RM/RCP Paint Control est réglé sur Off : Log/Look

Sélectionne le LUT à appliquer à l’image d’enregistrement ProRes.
Lorsque RM/RCP Paint Control est réglé sur On : Log/HLG(Natural)/

HLG(Live)/User Gamma
Seul le réglage de l’image d’enregistrement ProRes est affiché, car il 

est déterminé par le réglage de la catégorie Project > Input Color 
Space dans le menu.

 [Remarque]
Affiché et configurable lorsque Project > Basic Setting > Recording Format 
(page 74) est réglé sur le format ProRes dans le menu complet.

Edit Look
Règle un LUT à appliquer en tant que Look.
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / User 
3D LUT

WB (White Balance) Règle la température de couleur/la teinte de couleur de la balance des 
blancs.

Options de sélection par défaut
3200K+00/4300K+00/5500K+00

Vous pouvez appuyer sur le bouton Step Edit (touche ITEM 4) pour changer 
la valeur préréglée de balance des blancs et la valeur de teinte.
Auto White Bal. : permet d’exécuter la balance des blancs 
automatiquement.

1) Les options sont 1/60 et valeurs suivantes lorsque la fréquence d’images du projet est de 59.94, 1/50 et valeurs 
suivantes lorsqu’elle est de 50.0, 1/30 et valeurs suivantes lorsqu’elle est de 29.97, et 1/25 et valeurs suivantes 
lorsqu’elle est de 25.0.
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Écran des fonctions d’utilisateur
Vous pouvez appuyer sur le bouton USER 
(page 11) pour afficher l’écran des 
fonctions d’utilisateur sur l’affichage auxiliaire 
et pour utiliser les touches ITEM 1 à 5 en tant 
que boutons assignables (User 1 à 5).
Il existe également quatre boutons 
assignables (1 à 4) (pages 9, 10, 11) 
sur l’appareil et trois boutons assignables (VF 
A à VF C) sur le viseur (DVF-EL200) auxquels 
vous pouvez assigner différentes fonctions.
Des fonctions peuvent être assignées à ces 
boutons en utilisant l’écran des fonctions 
d’utilisateur, en plus de Project > Assignable 
Button dans le menu complet.

 Touche ITEM 4 Touche ITEM 5 Touche ITEM 6

Touche ITEM 3Touche ITEM 2Touche ITEM 1

[Remarque]
Lorsqu’un objectif prenant en charge la fonction 
d’affichage du réglage de diaphragme est fixé, la 
position du diaphragme s’affiche au milieu à gauche de 
l’écran des fonctions d’utilisateur.

Changement des fonctions des 
boutons

L’écran de sélection des fonctions d’utilisateur 
s’affiche en appuyant sur le bouton Edit 
(touche ITEM 6) sur l’écran des fonctions 
d’utilisateur. Vous pouvez régler les fonctions 
pour les boutons User 1 à 5 et les boutons 
assignables 1 à 4 ainsi que les boutons 
assignables A à C du viseur sur l’écran de 
sélection des fonctions d’utilisateur.

1 Sur l’écran de sélection des fonctions 
d’utilisateur, déplacez le curseur sur le 
bouton que vous souhaitez modifier, puis 
appuyez sur le bouton Select (touche 
ITEM 3).
Les fonctions qui peuvent être 
sélectionnées s’affichent.

2 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour changer un réglage.

3 Une fois terminé, appuyez sur le bouton Set 
(touche ITEM 3).
L’affichage revient à l’écran des fonctions 
d’utilisateur et affiche la fonction modifiée.
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Le tableau suivant liste les fonctions qui sont assignées lorsque l’appareil quitte l’usine.

Bouton Fonction Réglage de bouton assignable

Assignable 1 Affiche les zones en surbrillance écrêtées en 
rouge dans le viseur.

VF Highlight Clip Ind

Assignable 2 Pas d’assignation Not Assigned

Assignable 3 Pas d’assignation Not Assigned

Assignable 4 Pas d’assignation Not Assigned

Touche ITEM 1 Pas d’assignation Not Assigned

Touche ITEM 2 Pas d’assignation Not Assigned

Touche ITEM 3 Pas d’assignation Not Assigned

Touche ITEM 4 Affiche les zones en surbrillance écrêtées en 
rouge sur la sortie Monitor.

Monitor Highlight Clip Ind

Touche ITEM 5 Définit le mode de commande du ventilateur. Fan Mode

Viewfinder 
assignable A

Active/désactive la fonction Loupe de mise 
au point du viseur.

VF Focus Magnifier

Viewfinder 
assignable B

Active/désactive l’affichage de la fonction de 
fausse couleur sur un viseur.

VF False Color

Viewfinder 
assignable C

Active/désactive l’affichage d’informations 
sur l’image de sortie de l’écran du viseur/du 
moniteur.

VF Overlay

Fonctions pouvant être assignées aux touches ITEM 1 à 5

Réglage de bouton 
assignable

Fonction État après le redémarrage

No Assign Pas d’assignation –

Fan Mode Définit le mode de commande du ventilateur.
Commute entre Auto � Max � Off in Rec/
Auto � Off in Rec/Max chaque fois que la 
touche est enfoncée.

Réglage conservé

Auto Pixel 
Restoration

Exécute la restauration automatique de pixel. –

PL-Mt Interface 
Position

Règle la position de l’interface de l’objectif à 
monture PL.
Commute entre Top � Side � Off chaque 
fois que la touche est enfoncée.

Réglage conservé

Réglage de bouton 
assignable

Fonction État après le redémarrage

SDI 1/2 Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie SDI 1/2.

Réglage conservé

SDI 3/4 Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie SDI 3/4.

Réglage conservé

SDI Overlay Active/désactive l’affichage des informations 
sur l’image de sortie SDI.

Réglage conservé

Press&Hold for SDI12 
Log

Désactive le LUT appliqué à l’image de sortie 
SDI 1/2 pendant que le bouton est enfoncé, et 
règle la qualité d’image Log sans appliquer 
de LUT.

Réglage non conservé

Press&Hold for SDI34 
Log

Désactive le LUT appliqué à l’image de sortie 
SDI 3/4 pendant que le bouton est enfoncé, et 
règle la qualité d’image Log sans appliquer 
de LUT.
Lorsque la sortie SDI 3/4 et la sortie Monitor 
sont liées, Press & Hold for Moni Log est 
également activé.

Réglage non conservé

Monitor Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie Monitor.

Réglage conservé

Monitor Overlay Active/désactive l’affichage des informations 
sur l’image de sortie de Monitor.

Réglage conservé

Press & Hold for Moni 
Log 4)

Désactive le LUT appliqué à l’image de sortie 
Monitor pendant que la touche est enfoncée 
pour une qualité d’image normale sans 
appliquer de LUT.
Lorsque la sortie SDI 3/4 et la sortie Monitor 
sont liées, Press & Hold for SDI34 Log est 
également activé.
Lorsque la sortie HDMI et la sortie Monitor 
sont liées, la sortie HDMI est également 
activée.

Réglage non conservé

Monitor Focus 
Magnifier 2) 3)

Active/désactive la fonction Loupe de mise 
au point de l’image de sortie du Monitor.

Réglage non conservé

Monitor Highlight 
Clip Ind 1)

Active/désactive la fonction qui affiche les 
zones en surbrillance écrêtées en rouge sur 
l’image de sortie Monitor.

Réglage conservé

Monitor False Color 1) Active/désactive l’affichage de la fonction de 
fausse couleur sur un moniteur.

Réglage conservé

Line A: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line A.

Réglage conservé
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Réglage de bouton 
assignable

Fonction État après le redémarrage

Line B: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line B.

Réglage conservé

Line A: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line A.
Chaque fois que la touche est enfoncée, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

Line B: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line B.
Chaque fois que la touche est enfoncée, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

H & V Flip 7) Retourne l’orientation de l’image du mode de 
prise de vue.

Réglage conservé

Anamorphic De-
Squeeze

Modifie le réglage Project > Basic Setting > 
Anamo. De-Squeeze dans le menu complet.
Chaque fois que la touche est enfoncée, le 
réglage passe à l’élément suivant de la liste 
des options de sélection du menu.

Réglage conservé

Auto White Balance 5) Exécute la balance des blancs automatique. –

Color Bars 5) Active/désactive les barres de couleur. Réglage conservé

Picture Cache Rec Active/désactive la fonction d’enregistrement 
de cache d’image.

Réglage conservé

AXS Slot Change Change la fente active lorsque deux cartes 
mémoire AXS sont insérées.
Commute entre A et B chaque fois que la 
touche est enfoncée.

Réglage conservé

Format Media AXS 
Slot A

Formate le support dans la fente AXS A. –

Format Media AXS 
Slot B

Formate le support dans la fente AXS B. –

Réglage de bouton 
assignable

Fonction État après le redémarrage

Iris Open (1/16 stop) 6) Ouvre le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à 
l’ouverture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

Iris Close (1/16 stop) 6) Ferme le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à la 
fermeture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

1) Ne fonctionne pas si la touche est enfoncée lorsque Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

2) S’applique également à la sortie HDMI si la sortie HDMI a le même format de sortie que la sortie Monitor. Vous 
pouvez vérifier le réglage à l’aide de Monitoring > Overlays/Frame Line > HDMI (page 81) dans le menu complet. 
La sortie HDMI est la même que la sortie Monitor si HDMI est réglé sur « Same as Monitor ».

3) Si le format de sortie SDI est 1920×1080i, la fonction Loupe de mise au point est désactivée et appuyer sur le 
bouton n’exécute aucune fonction.

4) Change à la même image que le signal principal sélectionné à l’aide de Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet pendant que le bouton est enfoncé.

5) Ne fonctionne pas si la touche est enfoncée lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée et Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu 
complet.

6) Ne fonctionne pas si la touche est enfoncée lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée.

7) Ne fonctionne pas si la touche est enfoncée lorsque Monitoring > Output Display > Flip Image (page 79) > H & V 
Flip dans le menu complet est grisé.
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Fonctions pouvant être assignées aux boutons assignables 1 à 4

Réglage de bouton 
assignable

Fonction État après le redémarrage

No Assign Pas d’assignation –

SDI 1/2 Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie SDI 1/2.

Réglage conservé

SDI 3/4 Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie SDI 3/4.

Réglage conservé

SDI Overlay Active/désactive l’affichage des informations 
sur l’image de sortie SDI.

Réglage conservé

Press&Hold for SDI12 
Log

Désactive le LUT appliqué à l’image de sortie 
SDI 1/2 pendant que le bouton est enfoncé, et 
règle la qualité d’image Log sans appliquer 
de LUT.

Réglage non conservé

Press&Hold for SDI34 
Log

Désactive le LUT appliqué à l’image de sortie 
SDI 3/4 pendant que le bouton est enfoncé, et 
règle la qualité d’image Log sans appliquer 
de LUT.
Lorsque la sortie SDI 3/4 et la sortie Monitor 
sont liées, Press & Hold for Moni Log est 
également activé.

Réglage non conservé

Monitor Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie Monitor.

Réglage conservé

Monitor Overlay Active/désactive l’affichage des informations 
sur l’image de sortie de Monitor.

Réglage conservé

Press & Hold for Moni 
Log 4)

Désactive le LUT appliqué à l’image de sortie 
Monitor pendant que la touche est enfoncée 
pour une qualité d’image normale sans 
appliquer de LUT.
Lorsque la sortie SDI 3/4 et la sortie Monitor 
sont liées, Press&Hold for SDI34 Log est 
également activé.
Lorsque la sortie HDMI et la sortie Monitor 
sont liées, la sortie HDMI est également 
activée.

Réglage non conservé

Monitor Focus 
Magnifier 2) 3)

Active/désactive la fonction Loupe de mise 
au point de l’image de sortie du Monitor.

Réglage non conservé

Monitor Highlight 
Clip Ind 1)

Active/désactive la fonction qui affiche les 
zones en surbrillance écrêtées en rouge sur 
l’image de sortie Monitor.

Réglage conservé

Réglage de bouton 
assignable

Fonction État après le redémarrage

Monitor High/Low 
Key 1)

Sélectionne le mode de sortie Monitor.
Commute entre High Key (écran de 
vérification des hautes lumières accentuées) 
� Low Key (écran de vérification des ombres 
bloquées) � Off (affichage normal) chaque 
fois que le bouton est enfoncé.

Réglage non conservé

Monitor False Color 1) Active/désactive l’affichage de la fonction de 
fausse couleur sur un moniteur.

Réglage conservé

VF Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie de l’écran du 
viseur/du moniteur.

Réglage conservé

VF Overlay Active/désactive l’affichage d’informations 
sur l’image de sortie de l’écran du viseur/du 
moniteur.

Réglage conservé

Press & Hold for VF 
Log 6)

Désactive le LUT appliqué à l’image de sortie 
de l’écran du viseur/du moniteur pendant 
que le bouton est enfoncé pour une qualité 
d’image normale sans appliquer de LUT.

Réglage non conservé

VF Focus Magnifier Active/désactive la fonction Loupe de mise 
au point du viseur.

Réglage non conservé

VF Highlight Clip Ind 1) Active/désactive la fonction qui affiche les 
zones en surbrillance écrêtées en rouge sur le 
viseur.

Réglage conservé

VF High/Low Key 1) Sélectionne le mode de sortie du viseur.
Commute entre High Key (écran de 
vérification des hautes lumières accentuées) 
� Low Key (écran de vérification des ombres 
bloquées) � Off (affichage normal) chaque 
fois que le bouton est enfoncé.

Réglage non conservé

VF False Color 1) Active/désactive l’affichage de la fonction de 
fausse couleur sur un viseur.

Réglage conservé

VF Zebra Active/désactive la fonction de motif zébré de 
l’image de sortie de l’écran du viseur/du 
moniteur.

Réglage conservé

Line A: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line A.

Réglage conservé

Line B: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line B.

Réglage conservé
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Réglage de bouton 
assignable

Fonction État après le redémarrage

Line A: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line A.
Chaque fois que le bouton est enfoncé, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

Line B: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line B.
Chaque fois que le bouton est enfoncé, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

H & V Flip 8) Retourne l’orientation de l’image du mode de 
prise de vue.

Réglage conservé

Anamorphic De-
Squeeze

Modifie le réglage Project > Basic Setting > 
Anamo. De-Squeeze dans le menu complet.
Chaque fois que le bouton est enfoncé, le 
réglage passe à l’élément suivant de la liste 
des options de sélection du menu.

Réglage conservé

Auto White Balance 5) Exécute la balance des blancs automatique. –

Color Bars 5) Active/désactive les barres de couleur. Réglage conservé

Rec Démarre/arrête l’enregistrement. –

Rec Review Exécute la fonction Rec Review. Réglage non conservé

Picture Cache Rec Active/désactive la fonction d’enregistrement 
de cache d’image.

Réglage conservé

AXS Slot Change Change la fente active lorsque deux cartes 
mémoire AXS sont insérées.
Commute entre A et B chaque fois que le 
bouton est enfoncé.

Réglage conservé

ND +1stop Commute le filtre ND d’un cran dans la 
direction la plus sombre.

–

ND -1stop Commute le filtre ND d’un cran dans la 
direction la plus lumineuse.

–

Réglage de bouton 
assignable

Fonction État après le redémarrage

Iris Open (1/16 stop) 7) Ouvre le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à 
l’ouverture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

Iris Close (1/16 stop) 7) Ferme le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à la 
fermeture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

1) Ne fonctionne pas si le bouton est enfoncé lorsque Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

2) S’applique également à la sortie HDMI si la sortie HDMI a le même format de sortie que la sortie Monitor. Vous 
pouvez vérifier le réglage à l’aide de Monitoring > Overlays/Frame Line > HDMI (page 81) dans le menu complet. 
La sortie HDMI est la même que la sortie Monitor si HDMI est réglé sur « Same as Monitor ».

3) Si le format de sortie SDI est 1920×1080i, la fonction Loupe de mise au point est désactivée et appuyer sur le 
bouton n’exécute aucune fonction.

4) Change à la même image que le signal principal sélectionné à l’aide de Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet pendant que le bouton est enfoncé.

5) Ne fonctionne pas si le bouton est enfoncé lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée et Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu 
complet.

6) Lorsque Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On et Shooting > LUT 
Select > VF LUT (page 72) est réglé sur R709(800%) ou R709-Like dans le menu complet, ceci change à la même 
image que le signal principal lorsque le bouton est enfoncé. Lorsque RM/RCP Paint Control est réglé sur Off et VF 
LUT n’est pas réglé sur Log, l’appareil passe à la même image que le signal principal lorsque le bouton est enfoncé.

7) Ne fonctionne pas si le bouton est enfoncé lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée.

8) Ne fonctionne pas si le bouton est enfoncé lorsque Monitoring > Output Display > Flip Image (page 79) > H & V 
Flip dans le menu complet est grisé.
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Fonctions pouvant être assignées aux boutons assignables A à C du viseur 
(DVF-EL200)

Réglage de bouton 
assignable

Fonction État après le redémarrage

No Assign Pas d’assignation –

VF Frame Line Active/désactive la superposition de lignes de 
cadre sur l’image de sortie de l’écran du 
viseur/du moniteur.

Réglage conservé

VF Overlay Active/désactive l’affichage d’informations 
sur l’image de sortie de l’écran du viseur/du 
moniteur.

Réglage conservé

Press & Hold for VF 
Log 2)

Désactive le LUT appliqué à l’image de sortie 
de l’écran du viseur/du moniteur pendant 
que le bouton est enfoncé pour une qualité 
d’image normale sans appliquer de LUT.

Réglage non conservé

VF Focus Magnifier Active/désactive la fonction Loupe de mise 
au point du viseur.

Réglage non conservé

VF Highlight Clip  
Ind 3)

Active/désactive la fonction qui affiche les 
zones en surbrillance écrêtées en rouge sur le 
viseur.

Réglage conservé

VF High/Low Key 3) Sélectionne le mode de sortie du viseur.
Commute entre High Key (écran de 
vérification des hautes lumières accentuées) 
� Low Key (écran de vérification des ombres 
bloquées) � Off (affichage normal) chaque 
fois que le bouton est enfoncé.

Réglage non conservé

VF False Color 3) Active/désactive l’affichage de la fonction de 
fausse couleur sur un viseur.

Réglage conservé

VF Zebra Active/désactive la fonction de motif zébré de 
l’image de sortie de l’écran du viseur/du 
moniteur.

Réglage conservé

Line A: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line A.

Réglage conservé

Line B: Aspect Ratio 
Disp.

Active/désactive l’affichage Aspect Ratio pour 
Line B.

Réglage conservé

Réglage de bouton 
assignable

Fonction État après le redémarrage

Line A: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line A.
Chaque fois que le bouton est enfoncé, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

Line B: User Frame 
Disp.

Active/désactive l’affichage User Frame Line 1 
et User Frame Line 2 pour Line B.
Chaque fois que le bouton est enfoncé, 
l’affichage commute entre affichage User 
Frame Line 1 et 2 � affichage User Frame Line 
1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.

Réglage conservé

H & V Flip 5) Retourne l’orientation de l’image du mode de 
prise de vue.

Réglage conservé

Anamorphic De-
Squeeze

Modifie le réglage Project > Basic Setting > 
Anamo. De-Squeeze dans le menu complet.
Chaque fois que le bouton est enfoncé, le 
réglage passe à l’élément suivant de la liste 
des options de sélection du menu.

Réglage conservé

Color Bars 1) Active/désactive les barres de couleur. Réglage conservé

Rec Démarre/arrête l’enregistrement. –

Rec Review Exécute la fonction Rec Review. Réglage non conservé

Picture Cache Rec Active/désactive la fonction d’enregistrement 
de cache d’image.

Réglage conservé

AXS Slot Change Change la fente active lorsque deux cartes 
mémoire AXS sont insérées.
Commute entre A et B chaque fois que le 
bouton est enfoncé.

Réglage conservé

ND +1stop Commute le filtre ND d’un cran dans la 
direction la plus sombre.

–

ND -1stop Commute le filtre ND d’un cran dans la 
direction la plus lumineuse.

–
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Réglage de bouton 
assignable

Fonction État après le redémarrage

Iris Open (1/16 stop) 4) Ouvre le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à 
l’ouverture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

Iris Close (1/16 stop) 4) Ferme le diaphragme de l’objectif.
Appuyez et maintenez enfoncé jusqu’à la 
fermeture complète du diaphragme.
Cette fonction est disponible lorsqu’un 
objectif à monture E avec diaphragme 
électrique est fixé.
Le réglage se fait par incréments d’1/16, alors 
que l’indication du diaphragme se fait par 
unités d’incréments d’1/3.

–

1) Ne fonctionne pas si le bouton est enfoncé lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée et Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu 
complet.

2) Change à la même image que le signal principal sélectionné à l’aide de Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet pendant que le bouton est enfoncé.

3) Ne fonctionne pas si le bouton est enfoncé lorsque Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

4) Ne fonctionne pas si le bouton est enfoncé lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée.

5) Ne fonctionne pas si le bouton est enfoncé lorsque Monitoring > Output Display > Flip Image (page 79) > H & V 
Flip dans le menu complet est grisé.
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Opérations du menu
En appuyant sur le bouton MENU pendant la 
prise de vue (pendant l’enregistrement ou la 
veille d’enregistrement) ou la lecture, vous 
pouvez afficher et utiliser l’écran de menu sur 
l’affichage auxiliaire.
 • Catégorie Project : réglages de base et 

réglages du format d’enregistrement
 • Catégorie TC/Media : réglages de valeur de 

code temporel et de format TC
 • Catégorie Monitoring : réglages de format 

de sortie de signal externe SDI/HDMI/
Monitor, OSD et d’état de superposition de 
marqueur

 • Catégorie Audio : réglages de source audio 
et de niveau audio

 • Catégorie Info : informations d’état de 
caméra, support et batterie

Commandes

Bouton MENU (page 10)
Appuyez pour afficher le menu dans 
l’affichage auxiliaire.

Touche ITEM 1 à 6 (page 10)
Sélectionne la catégorie du menu.

Molette SEL/SET (molette MENU) (page 10)
Tournez pour déplacer le curseur dans la 
direction correspondante pour sélectionner 
des éléments de réglage ou des valeurs de 
réglage.
Appuyez sur la molette MENU pour appliquer 
l’élément sélectionné.

Bouton BACK (page 11)
Appuyez pour revenir au menu précédent. Les 
changements non confirmés sont annulés.

Fonctionnement de base

1 Appuyez sur le bouton MENU.
L’écran de menu apparaît.

2 Sélectionnez la catégorie à régler à l’aide 
des touches ITEM 1 à 6.

3 Tournez la molette MENU pour déplacer le 
curseur jusqu’à l’élément de réglage à 
sélectionner.
La valeur de réglage pour chaque élément 
de réglage est affichée.

« Liste d’éléments de menu » (page 56)

4 Appuyez sur la molette MENU.
L’écran de sélection de valeur de réglage 
apparaît à côté de l’élément sélectionné.

5 Tournez la molette MENU pour déplacer le 
curseur jusqu’à la valeur de réglage.

6 Appuyez sur la molette MENU pour 
appliquer le réglage.
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Liste d’éléments de menu

Les éléments disponibles dans chaque catégorie sont indiqués ci-dessous.

Catégorie Project

Les valeurs par défaut sont soulignées et affichées en gras.

Élément Réglage Description

Imager Mode MPC-3628
8.6K 3:2/8.2K 17:9/ 
7.6K 16:9/5.8K 6:5/ 
5.8K 17:9/5.4K 16:9
MPC-3626
6K 3:2/6K 1.85:1/6K 17:9/ 
6K 2.39:1/5.7K 16:9/4K 6:5/ 
4K 4:3/4K 4:3 Surround 
View/4K 17:9/ 
4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/ 
3.8K 16:9 Surround View

Règle la taille d’image effective.

[Remarques]
 • 5.8K 6:5 s’affiche uniquement lorsqu’une 

licence anamorphique est installée.
 • 7.6K 16:9/8.2K 17:9/8.6K 3:2 s’affichent 

uniquement lorsqu’une licence plein format est 
installée.

 • 6K 3:2/6K 1.85:1/6K 17:9/6K 2.39:1/5.7K 16:9 
s’affichent uniquement lorsqu’une licence plein 
format est installée.

 • 4K 6:5/4K 4:3/4K 4:3 Surround View s’affichent 
uniquement lorsqu’une licence anamorphique 
est installée.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Permet de régler la fréquence d’images du 
projet.

Input Color Space Lorsque RM/RCP Paint 
Control (page 93) est 
réglé sur Off :

S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / 
ACEScct

Lorsque RM/RCP Paint 
Control est réglé sur On :

S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / 
ACEScct / HLG(Natural) / 
HLG(Live) / Rec.2020/
User Gamma / Rec.709/
User Gamma

Définit l’espace de couleur.

[Remarque]
HLG(Natural) est équivalent à HLG BT.2100.

Recording Format 1) X-OCN XT/X-OCN ST/X-OCN 
LT/ProRes 4444 4K/ProRes 
4444 QFHD/ProRes 422 HQ 
4K/ProRes 422 HQ QFHD

Règle le format d’enregistrement pour les 
cartes mémoire AXS.

Élément Réglage Description

Anamo. De-Squeeze Off(1.0×)/1.25×/1.3×/1.5×/ 
1.65×/1.8×/2.0×

Règle le traitement de décompression pour 
les signaux d’enregistrement ProRes et les 
signaux de sortie vidéo.
Ce réglage est disponible lorsqu’une licence 
anamorphique est installée et que Imager 
Mode est réglé sur 4K 4:3/4K 4:3 Surround 
View/4K 6:5/4K 17:9/4K 17:9 Surround 
View/5.8K 6:5/5.8K 17:9, ou lorsqu’une 
licence anamorphique et une licence plein 
format sont installées et que Imager Mode 
est réglé sur 6K 3:2/6K 17:9/8.2K 17:9/8.6K 
3:2. Les options varient en fonction de la 
taille d’image.

MPC-3628

Imager Mode Anamo. De-Squeeze

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

8.6K 3:2 Oui Oui Oui Oui Oui Oui Oui

8.2K 17:9 Oui Oui Oui – Oui Oui Oui

7.6K 16:9 Oui – – – – – –

5.8K 6:5 Oui – – – – – Oui

5.8K 17:9 Oui Oui Oui – Oui Oui Oui

5.4K 16:9 Oui – – – – – –

MPC-3626

Imager Mode Anamo. De-Squeeze

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

6K 3:2 Oui Oui Oui Oui Oui Oui Oui

6K 1.85:1 Oui – – – – – –

6K 17:9 Oui Oui Oui – Oui Oui Oui

6K 2.39:1 Oui – – – – – –

5.7K 16:9 Oui – – – – – –

4K 6:5 Oui – – – – – Oui

4K 4:3 Surround Oui – Oui – Oui Oui Oui

4K 4:3 Oui – Oui – Oui Oui Oui

4K 17:9 Surround Oui Oui Oui – Oui Oui Oui

4K 17:9 Oui Oui Oui – Oui Oui Oui

4K 2.39:1 Oui – – – – – –

3.8K 16:9 Surround Oui – – – – – –

3.8K 16:9 Oui – – – – – –
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Élément Réglage Description

Zoom to Fit Off/17:9/16:9 Vous pouvez choisir de découper et 
d’agrandir l’affichage de l’image 
d’enregistrement pour l’écran du viseur ou 
la sortie Monitor.

[Remarques]
 • Configurable dans les conditions suivantes. 

Imager Mode : 8K 3:2/6K 3:2 
Recording Format : X-OCN 
Anamo. De-Squeeze : Off(1.0×)

 • 16:9 ne peut pas être sélectionné lorsque 
Project Frame Rate est réglé sur 47.95.

 • Si le réglage passe de 17:9 ou 16:9 à Off, le 
format de sortie SDI revient au réglage par 
défaut.

Project Details (Touche 
ITEM 6)

Affiche le contenu du menu Project 
(page 74) dans le menu complet.

1) Les formats d’enregistrement disponibles varient en fonction de la combinaison des réglages de taille d’image 
effective et de fréquence d’images du projet. Pour en savoir plus sur les réglages, consultez « Réglages du format 
d’enregistrement » (page 61).

Catégorie TC/Media

Les valeurs par défaut sont soulignées et affichées en gras.

Élément Réglage Description

TC Mode Preset F-Run (Ext-Lk)/
Preset R-Run/Int Regen

Définit le mode du code temporel.
Preset F-Run (Ext-Lk) : le code 
temporel avance de manière 
continue à partir de la valeur 
spécifiée, que l’enregistrement soit 
en cours ou non.
Preset R-Run : le code temporel 
avance à partir de la valeur spécifiée 
uniquement durant l’enregistrement.
Int Regen : le code temporel continue 
à partir de celui du plan précédent.

TC Display Timecode/Duration Active/désactive l’indication des 
données temporelles.

TC Setting
(défini lors du 
basculement vers 
un autre écran)

Setting 
(H, M, S, F)

Règle le code temporel sur la valeur 
souhaitée.

Reset Réinitialise le code temporel sur 
00:00:00:00.

TC Format DF/NDF Règle le format de code temporel.
DF : drop frame
NDF : non-drop frame

TC Source Internal/External Affichage uniquement.

Camera ID A à Z Règle l’ID de caméscope utilisé lors 
de la génération de noms de plan.
Nom de plan : Camera ID + Reel 
Number + Shot Number + Date + 
Chaîne aléatoire

Reel Number 001 à 999 Définit la partie numérique Reel 
Number utilisé lors de la génération 
de noms de plan.
Nom de plan : Camera ID + Reel 
Number + Shot Number + Date + 
Chaîne aléatoire

Camera Position C/L/R Définit la partie du premier caractère 
du Shot Number utilisé lors de la 
génération de noms de plan.
Nom de plan : Camera ID + Reel 
Number + Shot Number + Date + 
Chaîne aléatoire
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Élément Réglage Description

Format Media
(exécuté lors du 
basculement vers 
un autre écran)

AXS Slot A Formate la carte mémoire AXS 
insérée dans la fente A.

AXS Slot B Formate la carte mémoire AXS 
insérée dans la fente B.

SD Card Formate la carte SD.

Media Details 
(Touche ITEM 6)

Affiche le contenu du menu TC/
Media (page 78) dans le menu 
complet.

Catégorie Monitoring

Les valeurs par défaut sont soulignées et affichées en gras.

[Remarques]
 • L’appareil prend en charge la configuration indépendante de Status Info et Frame Line pour chaque système. 

Les informations d’affichage pour les images de sortie A et B sont configurées en utilisant le menu Monitoring 
(page 79).

 • Info et Frame Line peuvent ne pas s’afficher en fonction du réglage Output Format. Dans ce cas, « – » s’affiche et le 
réglage ne peut pas être modifié.

Élément Réglage Description

VF Overlay Info A/Info B/Rec Ind./Off Sélectionne les informations à 
afficher superposées sur l’image du 
viseur.

Frame Line Line A/Line B/Off Sélectionne les lignes de cadre à 
afficher superposées sur l’image du 
viseur.

SDI 1/2 Output 
Format

Les réglages disponibles 
varient en fonction des 
réglages du mode 
d’imageur, de la fréquence 
d’images du projet et du 
format d’enregistrement.

Sélectionne le format de sortie SDI 
1/2.1)

Overlay Info A/Info B/Rec Ind./Off L’affichage des informations n’est pas 
superposé sur la sortie SDI 1/2.

Frame Line Line A/Line B/Off Sélectionne les lignes de cadre à 
afficher superposées sur la sortie SDI 
1/2.

[Remarque]
Les lignes de cadre sont uniquement 
superposées si le format de sortie est 4K/
QFHD.

Élément Réglage Description

SDI 3/4

[Remarque]
En fonction du 
réglage Output 
Format de SDI 1/2, 
les réglages Output 
Format, Info, Frame 
Line de SDI 3/4 
peuvent être vides et 
ne peuvent pas être 
modifiés.

Output 
Format

Les réglages disponibles 
varient en fonction du 
réglage SDI 1/2.

Sélectionne le format de sortie SDI 
3/4.1)

Overlay Info A/Info B/Rec Ind./Off Sélectionne les informations à 
afficher superposées sur la sortie SDI 
3/4.

Frame Line Line A/Line B/Off Sélectionne les lignes de cadre à 
afficher superposées sur la sortie SDI 
3/4.

Monitor Output 
Format

Les réglages disponibles 
varient en fonction du 
réglage SDI 1/2.

Sélectionne le format de sortie 
Monitor.2)

Overlay Info A/Info B/Rec Ind./Off Sélectionne les informations à 
afficher superposées sur la sortie 
Monitor.

Frame Line Line A/Line B/Off Sélectionne les lignes de cadre à 
afficher superposées sur la sortie 
Monitor.

HDMI Output 
Format

Les réglages disponibles 
varient en fonction du 
réglage SDI 1/2.

Sélectionne le format de sortie 
HDMI.2)

Overlay Info A/Info B/Rec Ind./Off Sélectionne les lignes de cadre à 
afficher superposées sur la sortie 
HDMI.

Frame Line Line A/Line B/Off Sélectionne les informations à 
afficher superposées sur la sortie 
HDMI.

Moni. Details 
(Touche ITEM 6)

Affiche le contenu du menu 
Monitoring (page 79) dans le 
menu complet.

1) Pour en savoir plus sur les formats pouvant être sélectionnés, consultez « Formats de sortie du connecteur SDI 
OUT » (page 128).

2) Pour en savoir plus sur les formats pouvant être sélectionnés, consultez « Formats de sortie du connecteur 
MONITOR OUT/connecteur HDMI OUT » (page 133).
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Catégorie Audio

Les valeurs par défaut sont soulignées et affichées en gras.

Élément Réglage Description

Source Switch LINE / AES/EBU / MIC Affiche la position du commutateur AUDIO IN 
(page 11) qui règle la source d’entrée CH-1 
et CH-2.

[Remarque]
Lorsque Audio > Audio Input > Internal Mic Select 
(page 86) est réglé sur CH-1/CH-2 dans le menu 
complet, la source d’entrée Source Switch est 
appliquée à CH-3 et CH-4.

XLR Audio L Level Auto/Manual/Fixed
–99 à ±0 à +99

Règle automatiquement l’enregistrement 
audio lorsqu’il est définit sur Auto.
Le niveau d’enregistrement audio est réglé 
manuellement lorsqu’il est défini sur Manual.

[Remarque]
Fixed est sélectionné lorsque la source d’entrée 
Source Switch est AES/EBU.

XLR Audio R Level Auto/Manual/Fixed
–99 à ±0 à +99

Règle automatiquement l’enregistrement 
audio lorsqu’il est définit sur Auto.
Le niveau d’enregistrement audio est réglé 
manuellement lorsqu’il est défini sur Manual.

[Remarque]
Fixed est sélectionné lorsque la source d’entrée 
Source Switch est AES/EBU.

XLR Mic Reference –60dB/–50dB/–40dB Sélectionne le niveau d’entrée de référence 
du microphone.

Monitor CH Lorsque Monitor Output CH 
Pair est réglé sur CH-1/CH-2

CH-1/CH-2, CH-1, CH-2
Lorsque Monitor Output CH 
Pair est réglé sur CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Sélectionne le canal audio qui est reproduit 
vers les écouteurs et le haut-parleur.

Monitor Level 0 à 99 Règle le niveau audio du moniteur.

CH1 Level Meter – Affiche l’indicateur de niveau CH1.

CH2 Level Meter – Affiche l’indicateur de niveau CH2.

CH3 Level Meter – Affiche l’indicateur de niveau CH3.

CH4 Level Meter – Affiche l’indicateur de niveau CH4.

Audio Details (Touche 
ITEM 6)

Affiche le contenu du menu Audio 
(page 86) dans le menu complet.

Vérification de l’état à l’aide de la catégorie Info

Vous pouvez vérifier l’état du support et de la batterie et vérifier le contenu des avertissements 
et des erreurs émis à l’aide de la catégorie Info. Le contenu de l’affichage est mis à jour en temps 
réel au fur et à mesure que l’état de l’appareil change.
La catégorie Info comprend les neuf pages d’informations suivantes. Tournez la molette MENU 
pour commuter la page.

N° Page Description

1 Camera Condition Affiche des messages d’avertissement et des messages 
d’erreur. Lorsqu’il n’y a aucun message, « All Systems are 
OK » s’affiche en haut de la zone d’affichage.

2 Firmware Affiche le numéro de série et la version de micrologiciel de 
l’appareil.

3 License Affiche le nom et l’état/la validité de l’installation des 
licences logicielles en option. Si aucune option n’est 
ajoutée, « Not Installed » ou « Expired » est affiché comme 
état d’installation.

4 System Affiche les informations de système suivantes.
 • Date et heure
 • Vitesse de rotation du ventilateur
 • Température de détection du capteur
 • Compteur horaire
 • IP Address

[Remarques]
 • Si la température de détection du capteur atteint 65 °C (149 °F), 

un message d’avertissement de température élevée est émis.
 • « 0.0.0.0 » s’affiche si l’adresse IP ne peut pas être obtenue.

5 Battery Affiche les informations de batterie suivantes.
 • Nom ou type de batterie détectée
 • Capacité restante (%)
 • Estimation de durée restante
 • Capacité restante (Ah)
 • Tension (V)
 • Nombre de charges de la batterie
 • Source d’alimentation
 • Tension de source d’alimentation fournie

6 Media Affiche la capacité restante, la durée d’enregistrement 
restante et la durée de vie des données des cartes mémoire 
AXS et des cartes SD.
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N° Page Description

7 Lens Affiche les informations suivantes pour l’objectif fixé à 
l’appareil.
 • Nom du modèle d’objectif
 • Valeur T du diaphragme

 [Remarque]
La valeur F-stop s’affiche au lieu de la valeur T-stop si la valeur 
T-stop ne peut être obtenue.

 • Longueur focale
 • Distance de mise au point
 • Profondeur de champ
 • Numéro de série

8 Network Affiche les informations de configuration de la connexion 
au réseau.
 • État (LAN/Wireless Access Point/Wireless Station/Off)
 • IP Address
 • SSID
 • MAC Address

[Remarque]
« 0.0.0.0 » s’affiche si l’adresse IP ne peut pas être obtenue.

9 False Color Setting Table Affiche les informations suivantes sur la configuration False 
Color.
 • Couleur définie
 • Réglage de la valeur minimale à la valeur maximale
 • Description

[Remarque]
Si le réglage de la valeur minimale à la valeur maximale est différent 
des valeurs initiales, la couleur du texte devient grisée.



3. Opérations du caméscope : Opérations du menu61

Réglages du format d’enregistrement

Les formats d’enregistrement suivants peuvent être sélectionnés pour différentes combinaisons de réglages de taille d’image effective et de fréquence d’images du projet.

MPC-3628

Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

8.6K 3:2 X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui – – –

X-OCN LT Oui Oui Oui Oui – – –

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ – – – – – – –

8.2K 17:9 X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

7.6K 16:9 X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui – Oui Oui

X-OCN LT Oui Oui Oui Oui – Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 Oui Oui Oui Oui – Oui Oui

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

5.8K 6:5 X-OCN XT Oui Oui Oui Oui Oui – –

X-OCN ST Oui Oui Oui Oui Oui – –

X-OCN LT Oui Oui Oui Oui Oui – –

4K ProRes 4444 Oui Oui Oui Oui – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – – –

QFHD ProRes 422 HQ – – – – – – –
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Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

5.8K 17:9 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

5.4K 16:9 X-OCN XT Oui Oui Oui Oui – Oui Oui

X-OCN ST Oui Oui Oui Oui – Oui Oui

X-OCN LT Oui Oui Oui Oui – Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 Oui Oui Oui Oui – Oui Oui

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

MPC-3626

Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 3:2 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ – – – – – – –

6K 1.85:1 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ – – – – – – –
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Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 17:9 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

6K 2.39:1 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

5.7K 16:9 X-OCN XT Oui Oui Oui Oui – Oui Oui

X-OCN ST Oui Oui Oui Oui – Oui Oui

X-OCN LT Oui Oui Oui Oui – Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 Oui Oui Oui Oui – Oui Oui

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

4K 6:5 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

4K 4:3 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ – – – – – – –
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Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 4:3 Surround X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui – – –

X-OCN LT Oui Oui Oui Oui – – –

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ – – – – – – –

4K 17:9 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

4K 17:9 Surround X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui – – –

X-OCN LT Oui Oui Oui Oui – – –

4K ProRes 4444 Oui Oui Oui Oui – – –

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – – –

QFHD ProRes 422 HQ – – – – – – –

4K 2.39:1 X-OCN XT Oui Oui Oui Oui Oui Oui Oui

X-OCN ST Oui Oui Oui Oui Oui Oui Oui

X-OCN LT Oui Oui Oui Oui Oui Oui Oui

4K ProRes 4444 Oui Oui Oui Oui – Oui Oui

QFHD ProRes 4444 – – – – – – –

4K ProRes 422 HQ Oui Oui Oui Oui – Oui Oui

QFHD ProRes 422 HQ – – – – – – –

3.8K 16:9 X-OCN XT Oui Oui Oui Oui – Oui Oui

X-OCN ST Oui Oui Oui Oui – Oui Oui

X-OCN LT Oui Oui Oui Oui – Oui Oui

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 Oui Oui Oui Oui – Oui Oui

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ Oui Oui Oui Oui – Oui Oui
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Taille d’image effective (Imager Mode) Format d’enregistrement Project Frame Rate

23.98 24.00 25.00 29.97 47.95 50.00 59.94

3.8K 16:9 Surround X-OCN XT Oui Oui Oui Oui – – –

X-OCN ST Oui Oui Oui Oui – – –

X-OCN LT Oui Oui Oui Oui – – –

4K ProRes 4444 – – – – – – –

QFHD ProRes 4444 Oui Oui Oui Oui – – –

4K ProRes 422 HQ – – – – – – –

QFHD ProRes 422 HQ Oui Oui Oui Oui – – –
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Opérations du menu complet
Le menu complet pour configurer les réglages 
requis pour la prise de vue et la lecture est 
affiché sur l’affichage auxiliaire en maintenant 
le bouton MENU enfoncé pendant 2 secondes 
ou plus.
Vous pouvez également appuyer sur le 
bouton MENU en même temps que la molette 
MENU pour afficher rapidement l’écran du 
menu complet.

Structure du menu

Menu Shooting

Menu utilisé pour effectuer les réglages 
relatifs à la prise de vue.

Menu Project

Menu utilisé pour effectuer les réglages de 
base pour un projet.

Menu TC/Media

Menu utilisé pour effectuer les réglages 
relatifs au code temporel et au support 
d’enregistrement.

Menu Monitoring

Menu utilisé pour effectuer les réglages 
relatifs à la sortie vidéo et à la sortie du viseur.

Menu Audio

Menu utilisé pour effectuer les réglages 
relatifs à l’audio.

Menu Paint

Menu utilisé pour effectuer les réglages 
relatifs aux fonctions de peinture.
Le menu Paint ne peut être affiché et 
sélectionné que lorsque Technical > Special 
Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet.

Menu Technical

Menu utilisé pour effectuer les réglages 
relatifs aux questions techniques.

Menu Maintenance

Menu utilisé pour effectuer les réglages de 
l’appareil, tels que les réglages d’horloge et de 
langue.

Commandes

Bouton MENU (page 10)
Maintenez appuyé pendant 2 secondes 
ou plus pour afficher le menu complet sur 
l’affichage auxiliaire.

Molette SEL/SET (molette MENU) (page 10)
Tournez pour déplacer le curseur dans la 
direction correspondante pour sélectionner 
des éléments de réglage ou des valeurs de 
réglage.
Appuyez sur la molette MENU pour appliquer 
l’élément sélectionné.

Bouton BACK (page 11)
Appuyez pour revenir au menu précédent. Les 
changements non confirmés sont annulés.

Réglage des éléments de menu

Tournez la molette MENU pour déplacer 
le curseur sur l’élément de menu à régler, 
puis appuyez sur la molette MENU pour 
sélectionner cet élément.
 • La zone de sélection des éléments de menu 

peut afficher un maximum de neuf lignes. 
Lorsque tous les paramètres sélectionnables 
ne peuvent pas être affichés simultanément, 
vous avez la possibilité de faire défiler 
l’affichage vers le haut ou vers le bas en 
déplaçant le curseur.

 • Pour les éléments disposant d’une vaste 
plage de valeurs disponibles (par exemple : 
–99 à +99), la zone de sélection ne 
s’affiche pas. Le réglage actuel est mis en 
surbrillance pour indiquer que la valeur peut 
être changée.

 • Si vous sélectionnez Run pour un élément 
exécutable, la fonction correspondante est 
exécutée.

 • Lorsque vous sélectionnez un paramètre 
que vous devez confirmer avant exécution, 
un message de confirmation apparaît. 
Suivez les instructions dans le message pour 
exécuter ou annuler l’opération.
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Menu Shooting
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Shooting > FPS
Permet de régler la fréquence d’images de prise de vue.

Élément de menu Réglage Description

Fixed/Variable Select Fixed/Variable Détermine si le réglage FPS est réglé sur une 
prise de vue à vitesse constante ou une prise 
de vue à vitesse variable.

FPS Select Lorsque Fixed/Variable Select 
est réglé sur Fixed, une des 
valeurs suivantes s’affiche.

Fixed 23.98/Fixed 24.00/
Fixed 25.00/Fixed 29.97/
Fixed 47.95/Fixed 50.00/
Fixed 59.94

Sélectionne la fréquence d’images de prise de 
vue.
Les valeurs par défaut varient comme indiqué 
ci-dessous en fonction du réglage Project 
Frame Rate.

Project 
Frame 
Rate

Réglage par 
défaut lorsque 
Fixed/Variable 
Select est 
Variable

Valeur affichée 
lorsque Fixed/
Variable Select 
est Fixed

59.94 60 Fixed 59.94

50 50 Fixed 50.00

47.95 48 Fixed 47.95

29.97 30 Fixed 29.97

25 25 Fixed 25.00

24 24 Fixed 24.00

23.97 24 Fixed 23.98

[Remarque]
Une fréquence d’images de prise de vue de 7 ou 
inférieure ne peut pas être définie dans les cas 
suivants.

 – Lorsque Base ISO est réglé sur ISO 3200
 – Lorsque Base ISO est réglé sur ISO 2500 et le 

format d’enregistrement est ProRes

Shooting > Shutter
Effectue les réglages relatifs à l’obturateur électronique.

[Remarque]
L’obturation est grisée et ne peut pas être utilisée lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée et Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu 
complet.

Élément de menu Réglage Description

Shutter Select Lorsque Shutter Mode 
(page 89) est réglé sur 
Speed
Options de sélection par 
défaut

1/24, 1/25, 1/30, 1/48, 1/50, 
1/60, 1/100, 1/120, 1/250, 
1/500, 1/1000, 1/2000 1)

Lorsque Shutter Mode 
(page 89) est réglé sur 
Angle
Options de sélection par 
défaut

360.0/180.0/172.8/144.0/ 
90.0/45.0/22.5/11.2/5.6

Lorsque Step/Cont. Select est 
réglé sur Continuous, la plage 
de sélection est 360.0 à 4.2 
(Angle) ou 1/241) à 1/80002) 
(Speed).

Sélectionne l’angle ou la vitesse d’obturation 
de l’obturateur électronique.
Les valeurs de vitesse par défaut pour 
différents réglages Project Frame Rate 
(page 74) sont indiquées ci-dessous.

23.98/24 : 1/24
25 : 1/25
29.97 : 1/30
47.95 : 1/48
50 : 1/50
59.94 : 1/60

1) Les options sont 1/60 et valeurs suivantes lorsque 
la fréquence d’images du projet est de 59.94, 1/50 
et valeurs suivantes lorsqu’elle est de 50.0, 1/30 
et valeurs suivantes lorsqu’elle est de 29.97, et 
1/25 et valeurs suivantes lorsqu’elle est de 25.0.

2) Les options sont 1/7000 et valeurs précédentes 
lorsque la fréquence d’images du projet est de 
50.0 ou 25.0 et 1/6000 et valeurs précédentes 
lorsqu’elle est de 24.0 ou 23.98.

Step/Cont. Select Step/Continuous Détermine si les valeurs de l’obturateur 
électronique sont des valeurs progressives ou 
continues.

Add/Change Step Ajoute ou modifie l’option de sélection 
disponible dans Shutter Select en mode Step.
Un maximum de 16 options de sélection 
peuvent être ajoutées.

Delete Step Supprime l’option de sélection disponible 
dans Shutter Select en mode Step.

Shooting > Flicker Reduce
Configure les réglages relatifs à la réduction du scintillement.

Élément de menu Réglage Description

Mode On/Off Active/désactive la fonction de réduction de 
scintillement.

Frequency 50Hz/60Hz Règle la fréquence de l’alimentation de 
l’éclairage causant le scintillement.
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Shooting > ND
Règle la position du filtre ND.

Élément de menu Réglage Description

ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/ 
2.1/2.4

Sélectionne la densité du filtre ND.

Shooting > Exposure Index
Définit la valeur EI.

[Remarque]
Exposure Index est grisé et le réglage ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP 
Paint Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

EI Select Les réglages changent de la 
manière suivante, en fonction 
du réglage Project > Basic 
Setting > Base ISO 
(page 74) dans le menu 
complet.
MPC-3628

Base ISO 800 :
200EI/250EI/320EI/400EI/ 
500EI/640EI/800EI/ 
1000EI/1250EI/1600EI/ 
2000EI/2500EI/3200EI

Base ISO 3200 :
800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/ 
3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI/ 
12800EI

MPC-3626
ISO 500 :

125EI/160EI/200EI/250EI/ 
320EI/400EI/500EI/640EI/
800EI/1000EI/1250EI/ 
1600EI/2000EI

ISO 2500 :
640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI/ 
2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/ 
10000EI

Sélectionne la valeur EI.

[Remarque]
Les réglages sont fixés sur les valeurs suivantes 
lorsque Technical > Special Configuration > RM/RCP 
Paint Control (page 93) est réglé sur On dans le 
menu complet.
Lorsque Base ISO est réglé sur ISO500: 500EI
Lorsque Base ISO est réglé sur ISO2500: 2500EI
Lorsque Base ISO est réglé sur ISO800: 800EI 
Lorsque Base ISO est réglé sur ISO3200: 3200EI  

Shooting > Gain
Effectue les réglages relatifs au gain.

[Remarque]
Le réglage du gain ne peut pas être modifié lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée ou Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur Off dans le menu 
complet.

Élément de menu Réglage Description

Gain Select –6dB/–3dB/0dB/3dB/6dB/ 
9dB/12dB/15dB/18dB

Règle la sensibilité de base.

Shooting > White Balance
Effectue les réglages relatifs à la balance des blancs.

[Remarque]
White Balance est grisée et ne peut pas être utilisée lorsqu’une RM-B170 ou une autre unité de télécommande est 
connectée et Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu 
complet.

Élément de menu Réglage Description

Color Temp. Select 3200K+00/4300K+00/ 
5500K+00
+ autres options ajoutées 
(jusqu’à 16)

Affiche et sélectionne la température de 
couleur/teinte de couleur de la balance des 
blancs.

Add/Change Step Ajoute ou modifie une option de sélection en 
changeant la température de couleur et la 
valeur de teinte de la balance des blancs.

Delete Step Supprime une option de sélection ajoutée.

Auto White Balance Run/Cancel Exécute la balance des blancs automatique 
(exécutez en sélectionnant Run).

Shooting > Look
Effectue les réglages relatifs à Preset Look.

[Remarque]
Le réglage Look est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Category Preset Look/User 3D LUT/
ART/ACEScct with User 3D/
ACESproxy with User 3D/ACES 
with ART

Sélectionne la catégorie LUT.

[Remarque]
ACEScct with User 3D/ACESproxy with User 3D/
ACES with ART peut être sélectionné uniquement 
lorsque Project > Basic Setting > Input Color Space 
(page 74) est réglé sur ACEScct dans le menu 
complet.
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Shooting > Look
Effectue les réglages relatifs à Preset Look.

[Remarque]
Le réglage Look est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Preset Look Select s709/R709(800%) /  
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 /  
ACESproxy / ACEScct /  
ACES 1.0 Output-Rec.709

Sélectionne Preset Look.
Émet des images adaptées en tant que point 
de départ pour la gradation de couleur ou des 
images proches d’une qualité de film 
d’impression.
s709 : couleur cinéma
R709(800%) : couleur fidèle
S-Gamut3/SLog3 : espace de couleur étendu
S-Gamut3.Cine/SLog3 : espace de couleur pour 

cinéma numérique
ACESproxy : courbe logarithmique de l’espace 

de couleur étendu (AP1) définie par 
l’Académie.

ACEScct : courbe logarithmique de l’espace 
de couleur étendu (AP1) selon ACESproxy, 
avec la caractéristique Toe qui réduit le 
contraste dans la courbe presque noire.

ACES 1.0 Output-Rec.709 : Look référence 
Rec.709 défini par l’Académie.

[Remarques]
 • Configurable uniquement lorsque Category est 

réglé sur Preset Look.
 • Il est uniquement possible de sélectionner 

S-Gamut3/SLog3 lorsque Project > Basic Setting 
> Input Color Space (page 74) est réglé sur 
S-Gamut3/SLog3 dans le menu complet.

 • Il est uniquement possible de sélectionner 
ACESproxy/ACEScct/ACES 1.0 Output-Rec.709 
lorsque Project > Basic Setting > Input Color Space 
(page 74) est réglé sur ACEScct dans le menu 
complet.

User 3D LUT Select Nom de fichier (01 à 16) des 
fichiers User 3D LUT stockés 
dans la mémoire interne

Sélectionne le fichier User 3D LUT.

[Remarque]
Configurable uniquement lorsque Category est réglé 
sur User 3D LUT, ACEScct with User 3D ou ACESproxy 
with User 3D.

ART Select Nom de fichier (01 à 16) des 
fichiers ART stockés dans la 
mémoire interne

Sélectionne le fichier ART.

[Remarque]
Configurable uniquement lorsque Category est réglé 
sur ART ou ACES with ART.

Shooting > Look
Effectue les réglages relatifs à Preset Look.

[Remarque]
Le réglage Look est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

ART Information Affiche les informations du fichier ART 
sélectionné via ART Select.

[Remarque]
Affiché lorsque Category est réglé sur ART ou ACES 
with ART.

ASC CDL Process CDL Off/Look-> CDL/CDL -> 
Look/CDL On

Détermine l’application ou non d’ASC CDL à la 
vidéo de sortie. En cas d’application, spécifiez 
la séquence de traitement ASC CDL.
CDL Off : ne pas appliquer ASC CDL à la vidéo 

de sortie.
Look -> CDL : appliquer CDL après avoir 

appliqué Look.
CDL -> Look : appliquer CDL avant d’appliquer 

Look.
CDL On : appliquer ASC CDL à la vidéo de 

sortie.

[Remarques]
 • ASC CDL est activé pour les sorties pour lesquelles 

Look est sélectionné dans Shooting > LUT Select 
(page 70) du menu complet.

 • Les conditions d’activation des options ASC CDL 
Process sont indiquées dans le tableau suivant.
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Shooting > Look
Effectue les réglages relatifs à Preset Look.

[Remarque]
Le réglage Look est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

ASC CDL Process Shooting > Look Project > Basic Setting > 
Input Color Space

Options 
disponibles pour 
ASC CDL Process

Category Preset Look Select

Preset Look s709 S-Gamut3/Slog3
S-Gamut3.Cine/Slog3

CDL Off
Look -> CDL
CDL -> Look

R709(800%)
S-Gamut3/Slog3

S-Gamut3/Slog3
S-Gamut3.Cine/Slog3

CDL Off
Look -> CDL

S-Gamut3.Cine/
Slog3

S-Gamut3/Slog3 CDL Off
Look -> CDL

S-Gamut3.Cine/Slog3 CDL Off
Look -> CDL

ACESproxy
ACEScct
ACES 1.0 
Output-Rec.709

ACEScct CDL Off
CDL On

User 3D 
LUT

– S-Gamut3/Slog3
S-Gamut3.Cine/Slog3

CDL Off
Look -> CDL
CDL -> Look

ART – S-Gamut3/Slog3
S-Gamut3.Cine/Slog3

CDL Off
Look -> CDL
CDL -> Look

ACEScct 
with User 
3D
ACESproxy 
with User 
3D

– ACEScct CDL Off
CDL -> Look

ACES with 
ART

– ACEScct CDL Off
CDL -> Look

ASC CDL Select No File/Not Selected Sélectionne l’ASC CDL enregistré dans 
l’appareil.

ASC CDL Information Affiche les informations du fichier ASC CDL 
sélectionné via ASC CDL Select.
Vous pouvez modifier le réglage Saturation 
sur l’écran affiché.

Shooting > Look File
Charge un fichier User 3D LUT dans l’appareil.

[Remarque]
Look File est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Load User 3D LUT Charge un fichier User 3D LUT stocké sur une 
carte SD dans l’appareil.

Reset User 3D LUT Réinitialise un réglage de données User 3D 
LUT.

Reset All User 3D 
LUTs

Run/Cancel Réinitialise tous les réglages de données User 
3D LUT (exécutez en sélectionnant Run).

Load ART Charge un fichier ART stocké sur une carte SD 
dans l’appareil.

Reset ART Réinitialise un réglage de données ART.

Reset All ARTs Run/Cancel Réinitialise tous les réglages de données ART 
(exécutez en sélectionnant Run).

Load ASC CDL Charge les données ASC CDL depuis une carte 
SD.

Reset ASC CDL Réinitialise un réglage de données ASC CDL.

Reset All ASC CDLs Run/Cancel Réinitialise tous les réglages de données ASC 
CDL (exécutez en sélectionnant Run).

Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

SDI 1/2 Lorsque RM/RCP Paint Control 
est réglé sur Off :

Log/Look

Sélectionne le LUT à appliquer à l’image de 
sortie SDI 1/2.

Lorsque RM/RCP Paint Control 
est réglé sur On :

Log/HLG(Natural)/
HLG(Live)/User Gamma

Seul le réglage de l’image de sortie SDI 1/2 
est affiché, car il est déterminé par le réglage 
Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet.
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Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

SDI 3/4 Lorsque RM/RCP Paint Control 
est réglé sur Off :

Log/Look

Sélectionne le LUT à appliquer à l’image de 
sortie SDI 3/4.

[Remarque]
Lorsque la sortie SDI 1/2 est la suivante, ceci est 
réglé sur la même valeur que SDI 1/2 (fixe).

 – Sortie 4K/QFHD Quad
 – Sortie 4K/QFHD Dual

Lorsque la sortie SDI 1/2 est la suivante, ceci est 
réglé sur la même valeur que Monitor (fixe).

 – Sortie 4K/QFHD 12G/6G
 – Sortie 4K/QFHD Dual

Lorsque RM/RCP Paint Control 
est réglé sur On :

Log/HLG(Natural)/
HLG(Live)/User Gamma

Seul le réglage de l’image de sortie SDI 3/4 
est affiché, car il est déterminé par le réglage 
Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet.

[Remarque]
Lorsque la sortie SDI 1/2 est la suivante, ceci est 
réglé sur la même valeur que Monitor (fixe).

 – Sortie 4K/QFHD 12G/6G
 – Sortie 4K/QFHD Dual

Lorsque la sortie SDI 1/2 est la suivante, ceci est 
réglé sur la même valeur que SDI 1/2 (fixe).

 – Sortie 4K/QFHD Quad
 – Sortie 4K/QFHD Dual

Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

Monitor Lorsque RM/RCP Paint Control 
est réglé sur Off :

Lorsque Output Format > SDI 
1/2 est réglé sur 2K/HD :

Log/s709/R709(800%)/
Look/---

Lorsque Output Format > SDI 
1/2 est réglé sur 4K/QFHD :

Log/s709/R709(800%)/
Look/---

Sélectionne le LUT à appliquer à l’image de 
sortie Monitor.

[Remarque]
Il n’y a pas de sortie et « --- » (désactivé) s’affiche 
lorsque Technical > Special Configuration > SD HDMI 
(page 93) est réglé sur On dans le menu complet.

Lorsque RM/RCP Paint Control 
est réglé sur On, les réglages 
changent comme suit en 
fonction du réglage Project > 
Basic Setting > Input Color 
Space (page 74) dans le 
menu complet.
S-Gamut3.Cine/SLog3 ou 
S-Gamut3/SLog3 :

Log/R709(800%)
HLG(Natural) :

HLG(Natural)/R709(800%)
HLG(Live) :

HLG(Live)/R709(800%)
Rec.2020/User Gamma :

User Gamma/R709-Like
Rec.709/User Gamma :

User Gamma

Sélectionne le type d’image de sortie Monitor.

[Remarques]
 • Une valeur de gain SDR (–12 dB) est appliquée à 

l’image de sortie du viseur/du moniteur.
 • Vous pouvez modifier le gain de sortie à l’aide de 

SDR Gain lorsqu’il est réglé sur R709(800%) ou 
R709-Like.
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Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

HDMI Lorsque RM/RCP Paint Control 
est réglé sur Off (sortie 4K/
QFHD) :

Log/Look

Affichage uniquement, car le réglage de 
l’image de sortie HDMI est le même que SDI 
1/2.

Lorsque RM/RCP Paint Control 
est réglé sur Off (sortie 2K/
HD) :

Log/s709/R709(800%)/
Look

Affichage uniquement, car le réglage de 
l’image de sortie HDMI est le même que 
Monitor.

[Remarque]
Réglez sur Log (fixe) lorsque Technical > Special 
Configuration > SD HDMI (page 93) est réglé sur 
On dans le menu complet.

Lorsque RM/RCP Paint Control 
est réglé sur On (sortie 4K/
QFHD) :

Log/HLG(Natural)/
HLG(Live)/User Gamma

Affichage uniquement, car le réglage de 
l’image de sortie HDMI est le même que SDI 
1/2.

Lorsque RM/RCP Paint Control 
est réglé sur On (sortie 2K/
HD) :

Log/HLG(Natural)/
HLG(Live)/User Gamma/
R709(800%)/R709-Like

Affichage uniquement, car le réglage de 
l’image de sortie HDMI est le même que 
Monitor.

Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

VF LUT Lorsque RM/RCP Paint Control 
est réglé sur Off :

Log/s709/R709(800%)/
Look

Sélectionne le LUT à appliquer à l’image de 
sortie de l’écran du moniteur/du viseur.

Lorsque RM/RCP Paint Control 
est réglé sur On :

Les réglages changent de 
la manière suivante, en 
fonction du réglage 
Project > Basic Setting > 
Input Color Space 
(page 74) dans le menu 
complet.
S-Gamut3.Cine/SLog3 ou 
S-Gamut3/SLog3 :

Log/R709(800%)
HLG(Natural) :

HLG(Natural)/
R709(800%)

HLG(Live) :
HLG(Live)/R709(800%)

Rec.2020/User Gamma :
User Gamma/ 
R709-Like

Rec.709/User Gamma :
User Gamma

Sélectionne le type d’image de sortie de 
l’écran du moniteur/du viseur.

[Remarques]
 • Une valeur de gain SDR (–12 dB) est appliquée à 

l’image de sortie du viseur/du moniteur.
 • Vous pouvez modifier le gain de sortie à l’aide de 

SDR Gain lorsqu’il est réglé sur R709(800%) ou 
R709-Like.

ProRes Lorsque RM/RCP Paint Control 
est réglé sur Off :

Log/Look/---

Sélectionne le LUT à appliquer à l’image 
d’enregistrement ProRes.

[Remarque]
« --- » (affiché) s’affiche lorsque Project > Basic 
Setting > Recording Format (page 74) est réglé 
sur le format X-OCN dans le menu complet.

Lorsque RM/RCP Paint Control 
est réglé sur On :

Log/HLG(Natural)/
HLG(Live)/User Gamma

Seul le réglage d’image d’enregistrement 
ProRes est affiché, car il est déterminé par le 
réglage Project > Basic Setting > Input Color 
Space (page 74) dans le menu complet.
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Shooting > LUT Select
Effectue les réglages relatifs au LUT à appliquer à l’image de sortie.

[Remarque]
La valeur de chaque élément de menu (sauf SDR Gain) varie en fonction du réglage Technical > Special 
Configuration > RM/RCP Paint Control (page 93) dans le menu complet.

Élément de menu Réglage Description

SDR Gain –15dB à 0dB (–12dB)  
(incréments de 1 dB)

Règle le gain de sortie SDR lorsque RM/RCP 
Paint Control est réglé sur On.
Vous pouvez l’utiliser pour modifier le gain de 
la sortie Monitor ou du viseur qui est réglé sur 
R709(800%) ou R709-Like.

[Remarque]
Configurable que lorsque Technical > Special 
Configuration > RM/RCP Paint Control (page 93) 
est réglé sur On dans le menu complet.
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Menu Project
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Project > Basic Setting
Effectue les réglages relatifs à la taille de l’image et à la fréquence d’images du projet.

Élément de menu Réglage Description

Imager Mode MPC-3628
8.6K 3:2/8.2K 17:9/ 
7.6K 16:9/5.8K 6:5/ 
5.8K 17:9/5.4K 16:9

MPC-3626
6K 3:2/6K 1.85:1/6K 
17:9/6K 2.39:1/5.7K 
16:9/4K 6:5/4K 4:3/4K 4:3 
Surround View/4K 17:9/4K 
17:9 Surround View/4K 
2.39:1/3.8K 16:9/3.8K 16:9 
Surround View

Sélectionne la taille d’image effective.

[Remarques]
 • 5.8K 6:5 s’affiche uniquement lorsqu’une licence 

anamorphique est installée.
 • 7.6K 16:9/8.2K 17:9/8.6K 3:2 s’affichent 

uniquement lorsqu’une licence plein format est 
installée.

 • 6K 3:2/6K 1.85:1/6K 17:9/6K 2.39:1/5.7K 16:9 
s’affichent uniquement lorsqu’une licence plein 
format est installée.

 • 4K 6:5/4K 4:3/4K 4:3 Surround View s’affichent 
uniquement lorsqu’une licence anamorphique est 
installée.

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

Sélectionne la fréquence d’images du projet.

Input Color Space Lorsque RM/RCP Paint Control 
(page 93) est réglé sur Off :

S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / 
ACEScct

Lorsque RM/RCP Paint Control 
est réglé sur On :

S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / 
ACEScct / HLG(Natural) / 
HLG(Live) / Rec.2020/User 
Gamma / Rec.709/User 
Gamma

Définit l’espace de couleur.

[Remarque]
HLG(Natural) est équivalent à HLG BT.2100.

Recording Format X-OCN XT/X-OCN ST/X-OCN 
LT/ProRes 4444 4K/ProRes 
4444 QFHD/ProRes 422 HQ 
4K/ProRes 422 HQ QFHD

Sélectionne le format vidéo à enregistrer sur 
une carte mémoire AXS.

Base ISO MPC-3628
ISO 800/ISO 3200

MPC-3626
ISO 500/ISO 2500

Règle la sensibilité de base.

Project > Basic Setting
Effectue les réglages relatifs à la taille de l’image et à la fréquence d’images du projet.

Élément de menu Réglage Description

Anamo. De-Squeeze Off(1.0×)/1.25×/1.3×/1.5×/ 
1.65×/1.8×/2.0×

Règle le traitement de décompression pour 
les signaux d’enregistrement ProRes et les 
signaux de sortie vidéo.
Ce réglage est disponible lorsqu’une licence 
anamorphique est installée et que Imager 
Mode est réglé sur 4K 4:3/4K 4:3 Surround 
View/4K 6:5/4K 17:9/4K 17:9 Surround 
View/5.8K 6:5/5.8K 17:9, ou lorsqu’une licence 
anamorphique et une licence plein format 
sont installées et que Imager Mode est réglé 
sur 6K 3:2/6K 17:9/8.2K 17:9/8.6K 3:2. Les 
options varient en fonction de la taille 
d’image.

MPC-3628

Imager Mode Anamo. De-Squeeze

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

8.6K 3:2 Oui Oui Oui Oui Oui Oui Oui

8.2K 17:9 Oui Oui Oui – Oui Oui Oui

7.6K 16:9 Oui – – – – – –

5.8K 6:5 Oui – – – – – Oui

5.8K 17:9 Oui Oui Oui – Oui Oui Oui

5.4K 16:9 Oui – – – – – –

MPC-3626

Imager Mode Anamo. De-Squeeze

Off(1.0×) 1.25× 1.3× 1.5× 1.65× 1.8× 2.0×

6K 3:2 Oui Oui Oui Oui Oui Oui Oui

6K 1.85:1 Oui – – – – – –

6K 17:9 Oui Oui Oui – Oui Oui Oui

6K 2.39:1 Oui – – – – – –

5.7K 16:9 Oui – – – – – –

4K 6:5 Oui – – – – – Oui

4K 4:3 Surround Oui – Oui – Oui Oui Oui

4K 4:3 Oui – Oui – Oui Oui Oui

4K 17:9 Surround Oui Oui Oui – Oui Oui Oui

4K 17:9 Oui Oui Oui – Oui Oui Oui

4K 2.39:1 Oui – – – – – –

3.8K 16:9 Surround Oui – – – – – –

3.8K 16:9 Oui – – – – – –
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Project > Basic Setting
Effectue les réglages relatifs à la taille de l’image et à la fréquence d’images du projet.

Élément de menu Réglage Description

Zoom to Fit Off/17:9/16:9 Vous pouvez choisir de découper et 
d’agrandir l’affichage de l’image 
d’enregistrement pour l’écran du viseur ou la 
sortie Monitor.

[Remarques]
 • Configurable dans les conditions suivantes. 

Imager Mode : 8K 3:2/6K 3:2 
Recording Format : X-OCN 
Anamo. De-Squeeze : Off(1.0×)

 • 16:9 ne peut pas être sélectionné lorsque Project 
Frame Rate est réglé sur 47.95.

 • Si le réglage passe de 17:9 ou 16:9 à Off, le format 
de sortie SDI revient au réglage par défaut.

Project > Assignable Button
Assigne des fonctions aux boutons assignables.

Pour en savoir plus sur l’assignation de fonctions, consultez « Écran des fonctions d’utilisateur » (page 48).

Élément de menu Réglage Description

<1> page 48 Assigne une fonction au bouton assignable 1.

<2> page 48 Assigne une fonction au bouton assignable 2.

<3> page 48 Assigne une fonction au bouton assignable 3.

<4> page 48 Assigne une fonction au bouton assignable 4.

<VF A> page 48 Assigne une fonction au bouton assignable A 
sur le viseur (DVF-EL200).

<VF B> page 48 Assigne une fonction au bouton assignable B 
sur le viseur (DVF-EL200).

<VF C> page 48 Assigne une fonction au bouton assignable C 
sur le viseur (DVF-EL200).

<User 1> page 49 Assigne une fonction à la touche ITEM 1.

<User 2> page 49 Assigne une fonction à la touche ITEM 2.

<User 3> page 49 Assigne une fonction à la touche ITEM 3.

<User 4> page 49 Assigne une fonction à la touche ITEM 4.

<User 5> page 49 Assigne une fonction à la touche ITEM 5.

Project > Special Recording
Effectue les réglages relatifs à l’enregistrement de cache d’image.

Élément de menu Réglage Description

Cache Rec Select On/Off Active/désactive la fonction d’enregistrement 
de cache d’image.

Project > Special Recording
Effectue les réglages relatifs à l’enregistrement de cache d’image.

Élément de menu Réglage Description

Max Cache Rec 
Duration

2 s/4 s/6 s/8 s/10 s/15 s/ 
24 s/30 s

Règle la durée de lecture de vidéo à mettre 
en cache dans la mémoire de cache d’image.
La valeur maximale pouvant être réglée pour 
une carte mémoire AXS est indiquée ci-
dessous.

[Remarque]
Lorsque FPS est réglé sur Variable, la durée de 
lecture réelle varie par rapport au réglage Max Cache 
Rec Duration.

Enregistrement X-OCN
MPC-3628

Imager 
Mode

Recording Format Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

8.6K 3:2 X-OCN XT 4 4 4 2 – – –
X-OCN ST 10 10 8 6 – – –
X-OCN LT 15 15 15 15 – – –

8.2K 17:9 X-OCN XT 8 8 8 6 – – –
X-OCN ST 15 15 15 10 4 4 2
X-OCN LT 30 30 30 24 10 10 8

7.6K 16:9 X-OCN XT 8 8 8 6 – – –
X-OCN ST 15 15 15 10 – 4 2
X-OCN LT 30 30 30 24 – 10 8

5.8K 6:5 X-OCN XT 10 10 10 8 2 – –
X-OCN ST 15 15 15 15 8 – –
X-OCN LT 30 30 30 30 15 – –

5.8K 17:9 X-OCN XT 24 24 24 15 8 8 6
X-OCN ST 30 30 30 30 15 15 10
X-OCN LT 30 30 30 30 30 30 24

5.4K 16:9 X-OCN XT 24 24 24 15 – 8 6
X-OCN ST 30 30 30 30 – 15 10
X-OCN LT 30 30 30 30 – 30 24
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Project > Special Recording
Effectue les réglages relatifs à l’enregistrement de cache d’image.

Élément de menu Réglage Description

MPC-3626

Imager Mode Recording Format Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

6K 3:2 X-OCN XT 15 15 15 10 4 4 2
X-OCN ST 24 24 24 15 10 10 6
X-OCN LT 30 30 30 30 15 15 15

6K 1.85:1 X-OCN XT 15 15 15 15 8 6 4
X-OCN ST 30 30 30 24 15 10 10
X-OCN LT 30 30 30 30 30 24 15

6K 17:9 X-OCN XT 15 15 15 15 8 8 4
X-OCN ST 30 30 30 24 15 10 10
X-OCN LT 30 30 30 30 30 24 15

6K 2.39:1 X-OCN XT 30 30 24 15 10 10 8
X-OCN ST 30 30 30 30 15 15 15
X-OCN LT 30 30 30 30 30 30 30

5.7K 16:9 X-OCN XT 15 15 15 15 – 8 4
X-OCN ST 30 30 30 24 – 10 10
X-OCN LT 30 30 30 30 – 24 15

4K 6:5 X-OCN XT 30 30 30 24 10 10 10
X-OCN ST 30 30 30 30 24 15 15
X-OCN LT 30 30 30 30 30 30 30

4K 4:3 X-OCN XT 30 30 30 30 15 15 10
X-OCN ST 30 30 30 30 24 24 15
X-OCN LT 30 30 30 30 30 30 30

4K 4:3 Surround X-OCN XT 30 30 30 30 – – –
X-OCN ST 30 30 30 30 – – –
X-OCN LT 30 30 30 30 – – –

4K 17:9 X-OCN XT 30 30 30 30 24 24 15
X-OCN ST 30 30 30 30 30 30 30
X-OCN LT 30 30 30 30 30 30 30

4K 17:9 Surround X-OCN XT 30 30 30 30 – – –
X-OCN ST 30 30 30 30 – – –
X-OCN LT 30 30 30 30 – – –

4K 2.39:1 X-OCN XT 30 30 30 30 30 30 24
X-OCN ST 30 30 30 30 30 30 30
X-OCN LT 30 30 30 30 30 30 30

3.8K(QFHD) 16:9 X-OCN XT 30 30 30 30 – 24 15
X-OCN ST 30 30 30 30 – 30 30
X-OCN LT 30 30 30 30 – 30 30

3.8K(QFHD) 16:9 
Surround

X-OCN XT 30 30 30 30 – – –
X-OCN ST 30 30 30 30 – – –
X-OCN LT 30 30 30 30 – – –

Project > Special Recording
Effectue les réglages relatifs à l’enregistrement de cache d’image.

Élément de menu Réglage Description

Enregistrement ProRes

Recording Format Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

ProRes 4K 4444 30 30 30 30 – 15 10
ProRes 4K 422 HQ 30 30 30 30 – 24 15
ProRes QFHD 4444 30 30 30 30 – 15 10
ProRes QFHD 422 HQ 30 30 30 30 – 30 24

Project > All File(Cam Setup)
Effectue les réglages relatifs aux opérations sur les fichiers de réglages All.

Élément de menu Réglage Description

Load SD Card Charge un fichier de réglages All depuis une 
carte SD.

Save SD Card Enregistre un fichier de réglages All sur une 
carte SD.

File ID Affiche l’ID du fichier du fichier de réglages All 
pour le montage.

Format SD Card Formate une carte SD.

Project > Scene File
Effectue les réglages liés aux fichiers de scène.

[Remarque]
Scene File ne peut être affiché et sélectionné que lorsque Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Recall Internal 
Memory

Charge un fichier de scène depuis la mémoire 
interne.

Store Internal 
Memory

Sauvegarde un fichier de scène dans la 
mémoire interne.

Load SD Card Charge un fichier de scène depuis une carte 
SD.

Save SD Card Sauvegarde un fichier de scène sur une carte 
SD.

File ID Affiche l’ID du fichier de scène pour le 
montage.
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Project > User Gamma
Effectue les réglages liés aux fichiers gamma d’utilisateur.

[Remarque]
User Gamma ne peut être affiché et sélectionné que lorsque Technical > Look File Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Current Settings Affiche le nom du fichier gamma d’utilisateur 
actuel dans la mémoire interne.

Load SD Card Charge les données du tableau gamma défini 
par l’utilisateur (fichier gamma utilisateur) 
depuis une carte SD vers la mémoire interne.
Sauvegarde les fichiers gamma d’utilisateur 
créés à l’aide de RAW Viewer pour être utilisés 
par l’appareil dans le répertoire suivant de la 
carte SD.
MPC-3628 :

PRIVATE\SONY\PRO\CAMERA\MPC3628
MPC-3626 :

PRIVATE\SONY\PRO\CAMERA\MPC3626

Reset 1/2/3/4/5/All Réinitialise les fichiers gamma d’utilisateur 
dans une mémoire interne aux réglages 
initiaux.
1 à 5 : réinitialisation individuelle
All : réinitialiser tout
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Menu TC/Media
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.
TC/Media > Timecode

Effectue les réglages relatifs au code temporel.

Élément de menu Réglage Description

Mode Preset F-Run (Ext-Lk)/ 
Preset R-Run/Int Regen

Sélectionne le mode de code temporel.
Preset F-Run (Ext-Lk) : le code temporel 

avance de manière continue à partir de la 
valeur spécifiée, de manière synchronisée 
avec le code temporel d’entrée externe.

Preset R-Run : le code temporel avance à 
partir de la valeur spécifiée uniquement 
durant l’enregistrement.

Int Regen : le code temporel continue à partir 
de celui du plan précédent.

Manual Setting 00:00:00:00 à 23:59:59:29 Définit une valeur de code temporel arbitraire.

Reset Run/Cancel Réinitialise le code temporel sur 00:00:00:00 
(exécutez en sélectionnant Run).

TC Format DF/NDF Sélectionne le format du code temporel.
DF : drop frame
NDF : non-drop frame

TC Source Internal/External Affiche la source de synchronisation TCG.

Time Data Display Timecode/Duration Sélectionne les données temporelles à 
afficher.

TC/Media > Genlock
Effectue les réglages relatifs à la fonction genlock.

Élément de menu Réglage Description

Input Source HD SDI/Analog Sélectionne le signal d’entrée genlock.
HD SDI : numérique
Analog : analogique

Reference Lock Type Internal/External(HD)/
External(SD)

Affiche l’état de la fonction Genlock. Affiche le 
type de signal lors de l’application de la 
fonction Genlock.
Internal : pas d’application de la fonction 

Genlock.
External(HD) : application de la fonction 

Genlock par synchronisation HD.
External(SD) : application de la fonction 

Genlock par synchronisation SD.

TC/Media > Clip Name Format
Règle les noms de plans. (Nom de plan : Camera ID + Reel Number + Shot Number + Date + 
Chaîne aléatoire)

Élément de menu Réglage Description

Camera ID A à Z Règle l’ID de caméscope utilisé lors de la 
génération de noms de plan.

Reel Number 001 à 999 Définit la partie numérique Reel Number 
utilisé lors de la génération de noms de plan.

Camera Position C/L/R Définit la partie du premier caractère du Shot 
Number utilisé lors de la génération de noms 
de plan.

TC/Media > Format Media
Formate le support et met à jour le fichier de gestion sur le support.

Élément de menu Réglage Description

AXS Slot A Run/Cancel Initialise la carte mémoire AXS dans la fente A 
(exécutez en sélectionnant Run).

AXS Slot B Run/Cancel Initialise la carte mémoire AXS dans la fente B 
(exécutez en sélectionnant Run).

SD Card Run/Cancel Initialise la carte SD (exécutez en 
sélectionnant Run).
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Menu Monitoring
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Monitoring > Output Format
Effectue les réglages relatifs au format de sortie.

Élément de menu Réglage Description

SDI 1/2 Les réglages disponibles 
varient en fonction des 
réglages du mode d’imageur, 
de la fréquence d’images du 
projet et du format 
d’enregistrement.

Sélectionne le format de sortie SDI 1/2.
Les réglages varient selon le format 
d’enregistrement (page 128).

SDI 3/4 Les réglages disponibles 
varient en fonction du réglage 
SDI 1/2.

Sélectionne le format de sortie SDI 3/4.
Les réglages varient selon le format 
d’enregistrement (page 128).

Monitor Les réglages disponibles 
varient en fonction du réglage 
SDI 1/2.

Sélectionne le format de sortie Monitor.
Les réglages varient selon le format 
d’enregistrement (page 133).

HDMI Les réglages disponibles 
varient en fonction du réglage 
SDI 1/2.

Sélectionne le format de sortie HDMI.
Les réglages varient selon le format 
d’enregistrement (page 133).

3G SDI 1/2/3/4 
Output

Level A/Level B Sélectionne si le format de sortie 3G SDI est 
Level A ou Level B.

Monitoring > Output Display
Effectue les réglages relatifs à l’affichage du moniteur.

Élément de menu Réglage Description

Flip Image Normal/Horizontal Flip/
Vertical Flip/H & V Flip

Règle l’orientation de l’image du mode prise 
de vue. Avec le réglage est sur Normal, la 
couleur n’est pas inversée.

[Remarques]
 • Les images d’enregistrement AXS sont stockées 

de manière non basculée.
 • Lorsque Vertical Flip ou H & V Flip est sélectionné, 

les signaux vidéo et audio sont retardés de 1 
trame pour la fréquence d’images à cause du 
traitement interne.

Monitoring > Output Display
Effectue les réglages relatifs à l’affichage du moniteur.

Élément de menu Réglage Description

Audio/Video Delay Off/1frame Sélectionne d’activer ou non la fonction de 
synchronisation pour synchroniser l’audio et 
la vidéo avec un autre appareil qui retourne 
l’image en retardant le signal vidéo et le 
signal audio.
Off : sans retard
1frame : retard du signal vidéo, du signal 

audio et des métadonnées (y compris le 
code temporel) d’environ 1 trame.

[Remarque]
Fixe sur 1frame lorsque Flip Image est réglé sur 
Vertical Flip ou H & V Flip.

Monitor Magnifier 
Mode

Toggle/Press & Hold Sélectionne la méthode pour activer/
désactiver la fonction Loupe de mise au point 
de l’image de sortie du Monitor.
Toggle : active/désactive l’agrandissement 

chaque fois que vous appuyez sur un 
bouton assignable auquel Monitor Focus 
Magnifier est assigné.

Press & Hold : active l’agrandissement quand 
vous appuyez sur un bouton assignable 
auquel Monitor Focus Magnifier est 
assigné.

Monitor Magnifier 
Ratio

×2.0 / ×4.0 / ×2.0/×4.0 Sélectionne le taux d’agrandissement de la 
mise au point pour l’image de sortie du 
Monitor.

[Remarques]
 • Seul le format ×2.0 peut être sélectionné lorsque 

Project Frame Rate (page 74) est réglé sur 
59.94 ou 50.

 • ×2.0/×4.0 ne peut pas être sélectionné lorsque 
Monitor Magnifier Mode est réglé sur Press & 
Hold.
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Monitoring > VF Display
Effectue les réglages relatifs à l’affichage du viseur.

Élément de menu Réglage Description

VF LUT

[Remarque]
Lié au réglage Shooting 
> LUT Select > VF LUT 
(page 72) dans le 
menu complet.

Lorsque Technical > Special 
Configuration > RM/RCP Paint 
Control (page 93) est réglé 
sur Off dans le menu complet :

Log/s709/R709(800%)/
Look

Sélectionne le LUT à appliquer à l’image de 
sortie de l’écran du moniteur/du viseur.

Lorsque RM/RCP Paint Control 
est réglé sur On :

Les réglages changent de 
la manière suivante, en 
fonction du réglage 
Project > Basic Setting > 
Input Color Space 
(page 74) dans le menu 
complet.
S-Gamut3.Cine/SLog3 ou 
S-Gamut3/SLog3 :

Log/R709(800%)
HLG(Natural) :

HLG(Natural)/
R709(800%)

HLG(Live) :
HLG(Live)/R709(800%)

Rec.2020/User Gamma :
User Gamma/ 
R709-Like

Rec.709/User Gamma :
User Gamma

Sélectionne le type d’image de sortie de 
l’écran du moniteur/du viseur.

[Remarques]
 • Une valeur de gain SDR (–12 dB) est appliquée à 

l’image de sortie du viseur/du moniteur.
 • Vous pouvez modifier le gain de sortie à l’aide de 

SDR Gain lorsqu’il est réglé sur R709(800%) ou 
R709-Like.

Overlay Info. A/Info. B/Rec Ind./Off Sélectionne les informations à afficher 
superposées sur l’image de sortie de l’écran 
du viseur/du moniteur.

Frame Line Frame Line A/Frame Line B/
Off

Sélectionne les lignes de cadre à afficher 
superposées sur l’image de sortie de l’écran 
du viseur/du moniteur.

Monitoring > VF Display
Effectue les réglages relatifs à l’affichage du viseur.

Élément de menu Réglage Description

VF Magnifier Mode Toggle/Press & Hold Sélectionne la méthode pour activer/
désactiver la fonction Loupe de mise au point 
du viseur.
Toggle : active/désactive l’agrandissement 

chaque fois que vous appuyez sur un 
bouton assignable auquel VF Focus 
Magnifier est assigné.

Press & Hold : active l’agrandissement quand 
vous appuyez sur un bouton assignable 
auquel VF Focus Magnifier est assigné.

VF Magnifier Ratio ×2.0 / ×4.0 / ×2.0/×4.0 Sélectionne le taux d’agrandissement de la 
mise au point pour le viseur.

[Remarque]
×2.0/×4.0 ne peut pas être sélectionné lorsque VF 
Magnifier Mode est réglé sur Press & Hold.

Color –99 à ±0 à +99 Règle la profondeur de couleur de l’image du 
viseur.

SDR Gain –15dB à 0dB (–12dB)  
(incréments de 1 dB)

Règle le gain de sortie SDR lorsque RM/RCP 
Paint Control est réglé sur On.
Vous pouvez l’utiliser pour modifier le gain de 
la sortie Monitor ou du viseur qui est réglé sur 
R709(800%) ou R709-Like.

[Remarques]
 • Lié au réglage Shooting > LUT Select > SDR Gain 

(page 73) dans le menu complet.
 • Configurable que lorsque Technical > Special 

Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet.

Monitoring > VF Function
Effectue les réglages relatifs aux fonctions du viseur.

Élément de menu Réglage Description

Double Speed Scan On/Off Active/désactive la fonction de balayage à 
double vitesse du viseur.

Peaking Frequency Normal/High Détermine si la fréquence de contour est 
normale ou élevée pendant le contour.

[Remarque]
Le niveau de contour est réglé à l’aide du menu du 
viseur.

Assign<VF A> page 48 Assigne une fonction au bouton assignable A 
sur le viseur (DVF-EL200).
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Monitoring > VF Function
Effectue les réglages relatifs aux fonctions du viseur.

Élément de menu Réglage Description

Assign<VF B> page 48 Assigne une fonction au bouton assignable B 
sur le viseur (DVF-EL200).

Assign<VF C> page 48 Assigne une fonction au bouton assignable C 
sur le viseur (DVF-EL200).

Zebra On/Off Active/désactive la fonction de mire zébrée.

Zebra Select 1/2/Both Sélectionne le type de motif zébré (Zebra 1, 
Zebra 2, Both).

Zebra1 Level 0% à 107% (41%) Règle le niveau d’affichage de la mire zébrée 
1.

Zebra1 Aperture 
Level

1% à 20% (10%) Règle le niveau d’ouverture de la mire zébrée 
1.

Zebra2 Level 0% à 109% (61%) Règle le niveau d’affichage de la mire zébrée 
2.

Monitoring > Overlays/Frame Line
Effectue les réglages relatifs aux informations et aux lignes de cadre superposées sur chaque 
signal de sortie.
Le réglage On/Off est sélectionné au moyen d’une case à cocher (sauf Frame Line on Playback).
On : case cochée
Off : case décochée

Élément de menu Réglage Description

VF Overlay (On/Off,  
Info. A/Info. B/Rec Ind.)

Sélectionne les informations à afficher 
superposées sur l’image de sortie de l’écran 
du viseur/du moniteur.

Frame Line (On/Off,  
Line A/Line B)

Sélectionne les lignes de cadre à afficher 
superposées sur l’image de sortie de l’écran 
du viseur/du moniteur.

SDI 1/2 Overlay (On/Off,  
Info. A/Info. B/Rec Ind.)

Sélectionne les informations à afficher 
superposées sur le signal de sortie SDI 1/2.

Frame Line (On/Off,  
Line A/Line B)

Sélectionne les lignes de cadre à afficher 
superposées sur le signal de sortie SDI 1/2.

SDI 3/4 Overlay (On/Off,  
Info. A/Info. B/Rec Ind.)

Sélectionne les informations à afficher 
superposées sur le signal de sortie SDI 3/4.

Frame Line (On/Off,  
Line A/Line B)

Sélectionne les lignes de cadre à afficher 
superposées sur le signal de sortie SDI 3/4.

Same as Monitor Définit si les informations affichées 
superposées sur le signal de sortie SDI 3/4 
sont identiques à celles pour la sortie Monitor.

Monitoring > Overlays/Frame Line
Effectue les réglages relatifs aux informations et aux lignes de cadre superposées sur chaque 
signal de sortie.
Le réglage On/Off est sélectionné au moyen d’une case à cocher (sauf Frame Line on Playback).
On : case cochée
Off : case décochée

Élément de menu Réglage Description

Monitor Overlay (On/Off,  
Info. A/Info. B/Rec Ind.)

Sélectionne les informations à afficher 
superposées sur la sortie de signal Monitor.

Frame Line (On/Off,  
Line A/Line B)

Sélectionne les lignes de cadre à afficher 
superposées sur le signal de sortie Monitor.

HDMI Overlay (On/Off,  
Info. A/Info. B/Rec Ind.)

Sélectionne les informations à afficher 
superposées sur le signal de sortie HDMI.

Frame Line (On/Off,  
Line A/Line B)

Sélectionne les lignes de cadre à afficher 
superposées sur le signal de sortie HDMI.

Same as SDI 1/2/3/4 / Same 
as SDI 1/2 / Same as Monitor

Définit si les informations affichées 
superposées sur le signal de sortie HDMI sont 
identiques à celles pour la sortie 
correspondante.

Overlay A/B Setup Project
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations de projet dans les informations 
de sortie réglées pour Overlay A et Overlay B.

Camera ID Status
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations ID de caméra dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

TC/Genlock Status
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non de l’état de 
verrouillage externe du code temporel et 
les informations d’état genlock dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

Timecode
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations de code temporel dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

Audio Level Meter
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations de vumètre audio dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

Look Status
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non du type de 
Look sélectionné dans les informations de 
sortie réglées pour Overlay A et Overlay B.
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Monitoring > Overlays/Frame Line
Effectue les réglages relatifs aux informations et aux lignes de cadre superposées sur chaque 
signal de sortie.
Le réglage On/Off est sélectionné au moyen d’une case à cocher (sauf Frame Line on Playback).
On : case cochée
Off : case décochée

Élément de menu Réglage Description

Output LUT
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations de LUT de sortie dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

Rec Format/LUT
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non du format 
d’enregistrement et des informations de LUT 
de sortie d’enregistrement dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

VF Status
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations d’état du viseur dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

Roll/Tilt Value
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage numérique ou non des 
informations de niveau à bulle dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

[Remarque]
Roll/Tilt Value est grisé et ne peut pas être utilisé 
lorsqu’un CBK-3610XS est connecté à l’appareil.

Level Gauge
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage graphique ou non des 
informations de niveau à bulle dans les 
informations de sortie réglées pour Overlay A 
et Overlay B.

[Remarque]
Level Gauge est grisé et ne peut pas être utilisé 
lorsqu’un CBK-3610XS est connecté à l’appareil.

Lens Status
Info. A (On/Off)
Info. B (On/Off)
Option (Meter/Feet)

Sélectionne l’affichage ou non des 
informations d’objectif dans les informations 
de sortie réglées pour Overlay A et Overlay B.
Sélectionne les unités d’affichage de position 
de la mise au point.

Remote Control Status
Info. A (On/Off)
Info. B (On/Off)

Sélectionne l’affichage ou non des 
informations d’état de la télécommande dans 
les informations de sortie réglées pour 
Overlay A et Overlay B.

Monitoring > Overlays/Frame Line
Effectue les réglages relatifs aux informations et aux lignes de cadre superposées sur chaque 
signal de sortie.
Le réglage On/Off est sélectionné au moyen d’une case à cocher (sauf Frame Line on Playback).
On : case cochée
Off : case décochée

Élément de menu Réglage Description

Frame Line A/B 
Setup

Color
Option (White/Yellow/
Cyan/Green/Magenta/
Red/Blue)

Règle la couleur d’affichage des lignes de 
cadre.

Center Marker
Line A (On/Off)
Line B (On/Off)
Option (Cross/Open 
Cross/Dot)

Sélectionne l’affichage ou non du marqueur 
central dans les informations de sortie réglées 
pour Frame Line A et Frame Line B.
Sélectionne la forme d’affichage (Cross/Open 
Cross/Dot) du marqueur central.

Picture Area
Line A (On/Off)
Line B (On/Off)

Sélectionne l’affichage ou non de la zone 
d’image dans les informations de sortie 
réglées pour Frame Line A et Frame Line B.

Aspect Ratio
Line A (On/Off)
Line B (On/Off)
Option (17:9/16:9/15:9/ 
14:9/13:9/9:16/4:3/1:1/ 
1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1)

Sélectionne l’affichage ou non du marqueur 
de rapport d’aspect dans les informations de 
sortie réglées pour Frame Line A et Frame 
Line B.
Sélectionne le mode (17:9/16:9/15:9/14:9/ 
13:9/9:16/4:3/1:1/1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1) lors de l’affichage du marqueur 
de rapport d’aspect.

Aspect Ratio Type
Option (Line/Mask/
Line&Mask)

Sélectionne la forme d’affichage du marqueur 
de rapport d’aspect.
Line : affiche les lignes avec la couleur définie 

dans Color.
Mask : affiche un niveau de signal vidéo plus 

faible pour des zones situées en-dehors 
de la zone du repère.

Line&Mask : affiche les lignes dont la couleur 
est définie par Color et un niveau de 
signal vidéo inférieur pour les zones 
situées en-dehors de la zone du repère.
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Monitoring > Overlays/Frame Line
Effectue les réglages relatifs aux informations et aux lignes de cadre superposées sur chaque 
signal de sortie.
Le réglage On/Off est sélectionné au moyen d’une case à cocher (sauf Frame Line on Playback).
On : case cochée
Off : case décochée

Élément de menu Réglage Description

Surround View Type
Option (Line/Mask/
Line&Mask)

Sélectionne la forme d’affichage du marqueur 
Surround View.
Line : affiche la zone d’enregistrement à l’aide 

de lignes.
Mask : affiche la zone d’enregistrement en 

masquant (réduisant) le niveau de signal 
vidéo en dehors de la zone 
d’enregistrement.

Line&Mask : affiche la zone d’enregistrement 
en utilisant des lignes et en masquant 
(réduisant) le niveau de signal vidéo en 
dehors de la zone d’enregistrement.

Mask Level
Option (0 à 15 (12))

Sélectionne la luminosité de l’image en dehors 
du marqueur lorsque Aspect Ratio Type ou 
Surround View Type est réglé sur Mask.

Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Sélectionne l’affichage ou non de la zone de 
sécurité dans les informations de sortie 
réglées pour Frame Line A et Frame Line B.
Sélectionne la plage (80%/90%/92.5%/95%) 
de la zone de sécurité.

Aspect Safety Zone
Line A (On/Off)
Line B (On/Off)
Option 
(80%/90%/92.5%/95%)

Sélectionne l’affichage ou non de la zone de 
sécurité d’aspect dans les informations de sortie 
réglées pour Frame Line A et Frame Line B.
Sélectionne la taille (pourcentage de 
l’ensemble de l’écran) du marqueur de zone 
de sécurité d’aspect.

User Frame Line 1
Line A (On/Off)
Line B (On/Off)
Option
(Preset/Variable)

Sélectionne l’affichage ou non de User Frame 
Line 1 dans les informations de sortie réglées 
pour Frame Line A et Frame Line B.
Sélectionne l’affichage ou non de User Frame 
Line 1 ou du rapport d’aspect fixe.

User Frame Line 2
Line A (On/Off)
Line B (On/Off)
Option
(Preset/Variable)

Sélectionne l’affichage ou non de User Frame 
Line 2 dans les informations de sortie réglées 
pour Frame Line A et Frame Line B.
Sélectionne l’affichage ou non de User Frame 
Line 2 ou du rapport d’aspect fixe.

Frame Line on Playback
Option (On/Off)

Active/désactive la fonction permettant de 
superposer des lignes de cadre pendant la 
lecture.

Monitoring > Frame Line Setup
Effectue les réglages relatifs aux lignes et aux marqueurs affichés sur l’image de sortie.

Élément de menu Réglage Description

Color White/Yellow/Cyan/Green/
Magenta/Red/Blue

Sélectionne la couleur d’affichage pour les 
lignes de cadre.

Center Marker Cross/Open Cross/Dot Sélectionne la forme d’affichage du marqueur 
central.

Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 
9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1

Sélectionne le mode lors de l’affichage du 
marqueur de rapport d’aspect.

Aspect Ratio Type Line/Mask/Line&Mask Sélectionne la forme d’affichage du marqueur 
de rapport d’aspect.
Line : affiche les lignes avec la couleur définie 

dans Color.
Mask : affiche un niveau de signal vidéo plus 

faible pour des zones situées en-dehors 
de la zone du repère.

Line&Mask : affiche les lignes dont la couleur 
est définie par Color et un niveau de 
signal vidéo inférieur pour les zones 
situées en-dehors de la zone du repère.

Surround View Type Line/Mask/Line&Mask Sélectionne la forme d’affichage du marqueur 
Surround View.
Line : affiche la zone d’enregistrement à l’aide 

de lignes.
Mask : affiche la zone d’enregistrement en 

masquant (réduisant) le niveau de signal 
vidéo en dehors de la zone 
d’enregistrement.

Line&Mask : affiche la zone d’enregistrement 
en utilisant des lignes et en masquant 
(réduisant) le niveau de signal vidéo en 
dehors de la zone d’enregistrement.

Mask Level 0 à 15 (12) Sélectionne la luminosité de l’image en 
dehors du marqueur lorsque Aspect Ratio 
Type ou Surround View Type est réglé sur 
Mask.

Safety Zone 80%/90%/92.5%/95% Sélectionne la plage de la zone de sécurité.

Aspect Safety Zone 80%/90%/92.5%/95% Sélectionne la taille (pourcentage de 
l’ensemble de l’écran) du marqueur de zone 
de sécurité d’aspect.

Frame Line on 
Playback

On/Off Active/désactive la fonction permettant de 
superposer des lignes de cadre pendant la 
lecture.
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Monitoring > User Frame Line 1
Effectue les réglages liés à User Frame Line 1.

Élément de menu Réglage Description

Select Preset/Variable Sélectionne l’affichage ou non de User Frame 
Line 1 ou du rapport d’aspect fixe.
Preset : affiche le rapport d’aspect défini par 

Preset Aspect Ratio, Scaling et Preset 
Aspect Ratio Type.

Variable : affiche un cadre rectangulaire 
arbitraire défini par Width, Height, H 
Position, V Position et Variable Aspect 
Type.

Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 
9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1/ 
1.90:1 (W34)*
* Ligne de cadre avec la même 

taille d’image horizontale que 
lorsque 1.43:1 est réglé. En 
mode 6K 3:2, la taille d’image 
horizontale est d’environ 
34 mm.

Sélectionne le mode lors de l’affichage d’un 
rapport d’aspect fixe.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Preset.

Scaling 1% à 100%/--- Règle le facteur de l’échelle pour un rapport 
d’aspect fixe.

[Remarques]
 • Configurable uniquement lorsque Select est réglé 

sur Preset.
 • « --- » s’affiche lorsque Preset Aspect Ratio est 

réglé sur 1.90:1 (W34) et que la configuration n’est 
pas possible.

Preset Aspect Ratio 
Type

Line/Mask/Line&Mask Sélectionne la forme d’affichage d’un rapport 
d’aspect fixe.
Line : affiche à l’aide de lignes.
Mask : affiche un niveau de signal vidéo plus 

faible pour des zones situées en-dehors 
de la zone du repère.

Line&Mask : affiche les lignes et un niveau de 
signal vidéo plus faible pour des zones 
situées en dehors de la zone du repère.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Preset.

Monitoring > User Frame Line 1
Effectue les réglages liés à User Frame Line 1.

Élément de menu Réglage Description

Aspect Ratio(Pixels) Rapport d’aspect (nombre de 
pixels, rapport anamorphique)

Affiche le rapport d’aspect de User Frame Line 
1, le nombre de pixels et le rapport 
anamorphique pour la taille d’image effective.

[Remarque]
Le nombre de pixels est la valeur de la taille d’image 
effective avant la conversion de décompression 
anamorphique.

Width 3 à 480 (240) Règle la largeur de User Frame Line 1 
(distance du centre aux bords gauche et 
droit).

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

Height 3 à 270 (135) Règle la hauteur de User Frame Line 1 
(distance du centre aux bords supérieur et 
inférieur).

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

H Position Max. –477 à 477 (±0) Règle la position horizontale du centre de 
User Frame Line 1.
La plage de réglage diminue au fur et à 
mesure que le réglage Width augmente à 
plus de 3.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

V Position Max. –267 à 267 (±0) Règle la position verticale du centre de User 
Frame Line 1.
La plage de réglage diminue au fur et à 
mesure que le réglage Height augmente à 
plus de 3.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

Variable Aspect Type Line Affiche le type d’affichage de la ligne 1 du 
cadre utilisateur.

[Remarque]
Affiché uniquement lorsque Select est réglé sur 
Variable.
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Monitoring > User Frame Line 2
Effectue les réglages liés à User Frame Line 2.

Élément de menu Réglage Description

Select Preset/Variable Sélectionne l’affichage ou non de User Frame 
Line 2 ou du rapport d’aspect fixe.
Preset : affiche le rapport d’aspect défini par 

Preset Aspect Ratio, Scaling et Preset 
Aspect Ratio Type.

Variable : affiche un cadre rectangulaire 
arbitraire défini par Width, Height, H 
Position, V Position et Variable Aspect 
Type.

Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 
9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1/ 
1.90:1 (W34)*
* Ligne de cadre avec la même 

taille d’image horizontale que 
lorsque 1.43:1 est réglé. En 
mode 6K 3:2, la taille d’image 
horizontale est d’environ 
34 mm.

Sélectionne le mode lors de l’affichage d’un 
rapport d’aspect fixe.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Preset.

Scaling 1% à 100%/--- Règle le facteur de l’échelle pour un rapport 
d’aspect fixe.

[Remarques]
 •  Configurable uniquement lorsque Select est réglé 

sur Preset.
 •  « --- » s’affiche lorsque Preset Aspect Ratio est 

réglé sur 1.90:1 (W34) et que la configuration n’est 
pas possible.

Preset Aspect Ratio 
Type

Line Affiche la forme d’affichage pour un rapport 
d’aspect fixe.

[Remarque]
Affiché uniquement lorsque Select est réglé sur 
Preset.

Aspect Ratio(Pixels) Rapport d’aspect (nombre de 
pixels, rapport anamorphique)

Affiche le rapport d’aspect de User Frame Line 
2, le nombre de pixels et le rapport 
anamorphique pour la taille d’image effective.

[Remarque]
Le nombre de pixels est la valeur de la taille d’image 
effective avant la conversion de décompression 
anamorphique.

Monitoring > User Frame Line 2
Effectue les réglages liés à User Frame Line 2.

Élément de menu Réglage Description

Width 3 à 480 (240) Règle la largeur de User Frame Line 2 
(distance du centre aux bords gauche et 
droit).

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

Height 3 à 270 (135) Règle la hauteur de User Frame Line 2 
(distance du centre aux bords supérieur et 
inférieur).

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

H Position Max. –477 à 477 (±0) Règle la position horizontale du centre de 
User Frame Line 2.
La plage de réglage diminue au fur et à 
mesure que le réglage Width augmente à 
plus de 3.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

V Position Max. –267 à 267 (±0) Règle la position verticale du centre de User 
Frame Line 2.
La plage de réglage diminue au fur et à 
mesure que le réglage Height augmente à 
plus de 3.

[Remarque]
Configurable uniquement lorsque Select est réglé 
sur Variable.

Variable Aspect Type Line Affiche le type d’affichage de la ligne 2 du 
cadre utilisateur.

[Remarque]
Affiché uniquement lorsque Select est réglé sur 
Variable.
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Menu Audio
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Audio > Audio Input
Effectue les réglages relatifs aux niveaux d’enregistrement audio.

[Remarque]
Le niveau d’enregistrement audio est verrouillé avec un signal AES/EBU fixe.

Élément de menu Réglage Description

Internal Mic Select Off / CH-1/CH-2 / CH-3/CH-4 Sélectionne le canal d’entrée du microphone 
interne.

XLR Audio L Select Auto/Manual Règle automatiquement l’enregistrement 
audio lorsqu’il est définit sur Auto.

XLR Audio R Select Auto/Manual Règle automatiquement l’enregistrement 
audio lorsqu’il est définit sur Auto.

XLR Audio L Level –99 à ±0 à +99 Règle le niveau d’enregistrement audio 
lorsque CH-1 Audio Select est réglé sur 
Manual.

XLR Audio R Level –99 à ±0 à +99 Règle le niveau d’enregistrement audio 
lorsque CH-2 Audio Select est réglé sur 
Manual.

XLR Mic Reference –60dB/–50dB/–40dB Sélectionne le niveau d’entrée de référence 
du microphone.

Audio > Audio Monitor
Effectue les réglages relatifs à la surveillance audio.

Élément de menu Réglage Description

Monitor CH Lorsque Monitor Output CH 
Pair est réglé sur CH-1/CH-2

CH-1/CH-2, CH-1, CH-2
Lorsque Monitor Output CH 
Pair est réglé sur CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Sélectionne le canal audio qui est reproduit 
vers les écouteurs et le haut-parleur.
CH-1/CH-2 (CH-3/CH-4) : canal 1+2 (canal 3+4)
CH-1 (CH-3) : canal 1 (canal 3) uniquement
CH-2 (CH-4) : canal 2 (canal 4) uniquement

Monitor Level 0 à 99 Règle le niveau audio du moniteur.

[Remarque]
Si la configuration est telle que le son capturé par le 
microphone interne est audible par le haut-parleur 
intégré, un sifflement peut se produire si le volume 
du moniteur est augmenté.

Audio > Audio Configuration
Effectue les réglages relatifs à l’entrée/la sortie audio.

Élément de menu Réglage Description

Alarm Level 0 à 99 Règle le niveau audio de l’alarme.

Audio > Audio Configuration
Effectue les réglages relatifs à l’entrée/la sortie audio.

Élément de menu Réglage Description

Input Limiter Mode Off/–6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique du limiteur 
(niveau de saturation) pour des forts signaux 
d’entrée lorsque le niveau d’entrée audio est 
réglé manuellement. Sélectionnez Off si vous 
n’utilisez pas le limiteur.

AGC Level –6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique AGC (niveau de 
saturation).

AGC Mono/Stereo Mono/Stereo Règle automatiquement le niveau d’entrée 
des signaux audio analogiques enregistrés 
sur les canaux 1 et 2, et choisit d’effectuer les 
ajustements séparément pour chaque canal 
(Mono) ou en mode stéréo (Stereo).

MIC Input Mono/
Stereo

Mono/Stereo Sélectionne le mode du microphone avant : 
monaural (Mono) ou stéréo (Stereo).

Phantom Power 
+48V

On/Off Active/désactive la fonction permettant de 
fournir une alimentation externe de +48 V 
(alimentation fantôme) au microphone.

Monitor Output CH 
Pair

CH-1/CH-2, CH-3/CH-4 Règle les canaux de sortie audio sur les 
canaux 1 et 2 ou sur les canaux 3 et 4.

Headphone Mono/ST Mono/Stereo Règle la sortie casque sur monaural (Mono) 
ou stéréo (Stereo).
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Menu Paint
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.

[Remarque]
Technical > Special Configuration > RM/RCP Paint Control (page 93) doit être réglé sur On dans le menu complet 
pour activer le réglage des éléments du menu Paint.

Les valeurs par défaut sont soulignées et affichées en gras.

Paint > Black
Effectue les réglages relatifs au niveau de noir.

Élément de menu Réglage Description

Master Black –99 à ±0 à +99 Règle le niveau de noir maître.

R Black –99 à ±0 à +99 Règle le niveau de noir R.

B Black –99 à ±0 à +99 Règle le niveau de noir B.

Paint > Flare
Effectue les réglages relatifs à la correction de lumière parasite.

Élément de menu Réglage Description

Réglage On/Off Active/désactive la fonction de correction de 
lumière parasite.

Master Flare –99 à ±0 à +99 Règle le réglage utilisateur de lumière 
parasite maître de la correction de lumière 
parasite requise par l’appareil.

R Flare –99 à ±0 à +99 Règle le réglage utilisateur de lumière 
parasite R de la correction de lumière parasite 
requise par l’appareil.

G Flare –99 à ±0 à +99 Règle le réglage utilisateur de lumière 
parasite G de la correction de lumière parasite 
requise par l’appareil.

B Flare –99 à ±0 à +99 Règle le réglage utilisateur de lumière 
parasite B de la correction de lumière parasite 
requise par l’appareil.

Paint > Gamma
Effectue les réglages relatifs à la correction gamma.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction de correction 
gamma.

Gamma Category S-Log3/HLG(Natural)/
HLG(Live)/User

Seul le réglage de la catégorie gamma est 
affiché, car il est déterminé par le réglage 
Project > Basic Setting > Input Color Space 
(page 74) dans le menu complet.

Paint > Gamma
Effectue les réglages relatifs à la correction gamma.

Élément de menu Réglage Description

Gamma Select Lorsque Gamma Category est 
réglé sur S-Log3 :

S-Log3
Lorsque Gamma Category est 
réglé sur HLG(Natural) :

HLG(Natural)
Lorsque Gamma Category est 
réglé sur HLG(Live) :

HLG(Live)
Lorsque Gamma Category est 
réglé sur User :

User 1/User 2/User 3/ 
User 4/User 5

Sélectionne le tableau gamma utilisé pour la 
correction gamma.

Paint > Black Gamma
Effectue les réglages relatifs à la correction gamma du noir.

[Remarque]
Black Gamma est grisé et ne peut pas être utilisé lorsque Project > Basic Setting > Input Color Space (page 74) est 
réglé sur S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 dans le menu complet.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction de correction 
gamma du noir.

Range Low/L.Mid/H.Mid Sélectionne la plage effective de la correction 
gamma noir.
Low : 0% à 3.6%
L.Mid : 0% à 7.2%
H.Mid : 0% à 14.4%

Master Black Gamma –99 à ±0 à +99 Règle le niveau de gamma du noir maître.

Paint > Knee
Effectue les réglages relatifs à la correction de Knee.

[Remarque]
Knee est grisé et ne peut pas être utilisé lorsque Project > Basic Setting > Input Color Space (page 74) est réglé 
sur S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 dans le menu complet.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
Knee.

Point –99 à ±0 à +99 Règle le point de Knee.

Slope –99 à ±0 à +99 Règle le coefficient angulaire de Knee.



3. Opérations du caméscope : Menu Paint88

Paint > White Clip
Effectue les réglages relatifs à l’ajustement d’écrêtage du blanc.

[Remarque]
White Clip est grisé et ne peut pas être utilisé lorsque Project > Basic Setting > Input Color Space (page 74) est 
réglé sur S-Gamut3.Cine/SLog3 ou S-Gamut3/SLog3 dans le menu complet.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction d’ajustement 
d’écrêtage du blanc.

Level 60.0% à 108.0% à 109.0% Règle le niveau d’écrêtage du blanc.

Paint > Detail
Effectue les réglages relatifs aux ajustements de détail.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction d’ajustement de 
détail.

Level –99 à ±0 à +99 Règle le niveau de détail.

H/V Ratio –99 à ±0 à +99 Règle le rapport de mélange entre le niveau 
de détail H et niveau de détail V.

Crispening –99 à ±0 à +99 Règle le niveau de netteté.

Level Depend On/Off Active/désactive la fonction d’ajustement de 
dépendance du niveau.

Level Depend Level –99 à ±0 à +99 Règle le niveau de dépendance du niveau.

Frequency –99 à ±0 à +99 Règle la fréquence centrale du signal de détail 
H (des valeurs plus grandes donnent des 
détails plus précis).

Knee Aperture On/Off Active/désactive la fonction de correction 
d’ouverture de Knee.

Knee Aperture Level –99 à ±0 à +99 Règle le niveau d’ouverture de Knee.

Limit –99 à ±0 à +99 Règle les limites de détail pour les côtés blanc 
et noir.

White Limit –99 à ±0 à +99 Définit la limite inférieure du côté blanc.

Black Limit –99 à ±0 à +99 Définit la limite inférieure du côté noir.

Paint > Matrix
Effectue les réglages relatifs à la correction de matrice.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
matrice.

User Matrix On/Off Active/désactive la fonction de correction de 
matrice utilisateur.

User Matrix R-G –99 à ±0 à +99 Règle les coefficients de matrice 
individuellement pour un ajustement précis 
de la couleur dans toute l’image.

User Matrix R-B –99 à ±0 à +99

User Matrix G-R –99 à ±0 à +99

User Matrix G-B –99 à ±0 à +99

User Matrix B-R –99 à ±0 à +99

User Matrix B-G –99 à ±0 à +99

Paint > Multi Matrix
Effectue les réglages relatifs à la correction de matrice multiple.

[Remarque]
Multi Matrix est grisé et ne peut pas être utilisé lorsque Matrix est réglé sur Off.

Élément de menu Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
matrice multiple pour régler la saturation 
dans un espace de teintes à 16 axes.

Area Indication On/Off Active/désactive l’affichage d’un motif de 
zébrures dans la zone de couleur de l’écran 
cible pour la correction de matrice multiple.

Reset Run/Cancel Règle toutes les valeurs [Hue] et [Saturation] 
de chaque axe sur les valeurs par défaut 
(exécutez en sélectionnant Run).

Axis B/B+/MG–/MG/MG+/R/R+/
YL–/YL/YL+/G–/G/G+/CY/
CY+/B–

Règle la couleur cible pour la correction de 
matrice multiple (mode 16 axes)

Hue –99 à ±0 à +99 Règle la teinte de la couleur cible pour la 
correction de matrice multiple pour chacun 
des 16 axes.

Saturation –99 à ±0 à +99 Règle la saturation de la couleur cible pour la 
correction de matrice multiple pour chacun 
des 16 axes.
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Menu Technical
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Technical > System Configuration
Effectue les réglages relatifs au contrôle de l’appareil.

Élément de menu Réglage Description

Fan Control Auto / Max /  
Off in Rec/Auto /  
Off in Rec/Max

Sélectionne le mode de commande du 
ventilateur.
Auto : commande automatiquement le 

ventilateur en fonction de la température 
interne.

Max : le ventilateur tourne à la vitesse 
maximale.

Off in Rec/Auto : le ventilateur est silencieux 
pendant l’enregistrement et fonctionne 
automatiquement en fonction de la 
température interne lorsque 
l’enregistrement n’est pas en cours.

Off in Rec/Max : le ventilateur est silencieux 
pendant l’enregistrement et tourne à la 
vitesse maximale lorsque l’enregistrement 
n’est pas en cours.

Shutter Mode Speed/Angle Sélectionne le mode de fonctionnement de 
l’obturateur électronique.

SDI Rec Remote 
Trigger

Off / HD SDI Remote I/F / 
Parallel Rec

Sélectionne la méthode de contrôle du mode 
de télécommande SDI.
Off : désactive le télécommande.
HD SDI Remote I/F : utilise la méthode de 

télécommande HD SDI.
Parallel Rec : utilise une méthode de contrôle 

par balise valide.

Level Gauge Adjust Run/Cancel Exécute l’ajustement du zéro de la jauge de 
niveau à bulle (exécutez en sélectionnant 
Run).

Level Gauge Reset Run/Cancel Réinitialise la valeur de l’ajustement du zéro 
de la jauge de niveau à bulle (exécutez en 
sélectionnant Run).

Technical > Lens Configuration
Effectue les réglages relatifs aux objectifs.

Élément de menu Réglage Description

PL-Mt Interface 
Position

Top/Side/Off Règle la position de l’interface de l’objectif à 
monture PL.

[Remarque]
Réglez avant de fixer un objectif, en fonction de 
l’objectif à fixer. Si vous modifiez ce réglage alors 
que l’objectif est fixé à l’appareil, redémarrez 
l’appareil.

PL-Mt Voltage 8 V � 24 V/24 V Règle la méthode d’alimentation de l’objectif à 
monture PL.

Focus Distance 
Format

Meter/Feet Sélectionne les unités d’affichage de position de la 
mise au point.

Lens 12pin On/Off Active/désactive l’interface de l’objectif à 12 
broches.

[Remarque]
Si vous modifiez ce réglage alors que l’objectif est 
fixé à l’appareil, redémarrez l’appareil.

E-Mount Shading 
Comp.

Auto/Off Détermine si une baisse de l’éclairage 
périphérique sera compensée ou non 
lorsqu’un objectif compatible est fixé.

E-Mt Chro. Aber. 
Comp.

Auto/Off Détermine si une aberration chromatique de 
l’éclairage périphérique sera compensée ou 
non lorsqu’un objectif compatible est fixé.

Technical > Auto Pixel Restore
Exécute Auto Pixel Restoration (ajustement automatique du capteur d’image).

Élément de menu Réglage Description

Auto Pixel 
Restoration

Run/Cancel Exécute la fonction de réduction du bruit de 
pixel automatique (exécutez en sélectionnant 
Run).

Reset Run/Cancel Supprime les mouchetures blanches ajoutées 
par l’exécution de la fonction APR (exécutez 
en sélectionnant Run).

Technical > Authentication
Configure les réglages de base relatifs à l’authentification réseau.

Élément de menu Réglage Description

User Name (Affiche le nom d’utilisateur 
actuel.)

Règle le nom d’utilisateur à utiliser pour 
l’authentification d’accès.
Réglé sur « admin » par défaut.
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Technical > Authentication
Configure les réglages de base relatifs à l’authentification réseau.

Élément de menu Réglage Description

Password (*******) Définit le mot de passe à utiliser pour 
l’authentification d’accès (8 caractères 
alphanumériques ou plus contenant au moins 
un caractère alphabétique et un caractère 
numérique).
Lors de la saisie d’un mot de passe, les 
caractères marqués d’un astérisque sont 
remplacés par les caractères saisis lorsque la 
touche ITEM 1 de l’affichage auxiliaire est 
enfoncée.

Technical > Network
Effectue les réglages relatifs au réseau.

Élément de menu Réglage Description

Setting LAN/Wireless/Off Définit la méthode de connexion du réseau.

[Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

LAN DHCP (On/Off) Définit le DHCP.
Lorsque cette fonction est réglée sur On, une 
adresse IP est automatiquement attribuée à 
l’appareil. Pour saisir manuellement l’adresse 
IP de l’appareil, réglez sur Off.

IP Address (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 192.168.2.50)

Permet de saisir l’adresse IP de l’appareil.
Activé lorsque DHCP est réglé sur Off.

Subnet Mask (DHCP/On : 
obtenir automatiquement, 
DHCP/Off : 255.255.255.0)

Permet de saisir le masque de sous-réseau de 
l’appareil.
Activé lorsque DHCP est réglé sur Off.

Technical > Network
Effectue les réglages relatifs au réseau.

Élément de menu Réglage Description

Wireless Network Mode (Access Point/
Station)

Règle le mode réseau pour les connexions 
sans fil.

Scan Networks (Run/Cancel) Recherche des points d’accès pour les 
destinations de connexion (exécutez en 
sélectionnant Run).

[Remarque]
Configurable uniquement lorsque Network Mode est 
réglé sur Station.

SSID Quand Network Mode est réglé sur Access 
Point

Affiche le SSID pour la connexion sans fil à 
l’appareil.

Quand Network Mode est réglé sur Station
Affiche/configure le SSID du point d’accès 
de la destination de connexion.

[Remarque]
Caractères valides pour l’affichage et la saisie :
Alphabétique (A à Z, a à z)
Numérique (0 à 9 -.@—_())
Symboles (!"#$%&’*+,/:;<=>?[\]^`{|}~)

Password Quand Network Mode est réglé sur Access 
Point

Affiche le mot de passe pour la connexion 
sans fil à l’appareil.

Quand Network Mode est réglé sur Station
Configure le mot de passe du point 
d’accès de la destination de connexion.
Lors de la saisie d’un mot de passe, les 
caractères marqués d’un astérisque sont 
remplacés par les caractères saisis lorsque 
la touche ITEM 1 de l’affichage auxiliaire 
est enfoncée.

[Remarque]
Caractères valides pour l’affichage et la saisie :
Alphabétique (A à Z, a à z)
Numérique (0 à 9 -.@—_())
Symboles (!"#$%&’*+,/:;<=>?[\]^`{|}~)

WPS (Run/Cancel) Démarre la configuration de la connexion à 
l’aide de WPS (exécutez en sélectionnant 
Run).
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Technical > Network
Effectue les réglages relatifs au réseau.

Élément de menu Réglage Description

Channel (Auto(5GHz)/Auto/
CH1/CH2/CH3/CH4/CH5/CH6/
CH7/CH8/CH9/CH10/CH11)

Règle le canal du point d’accès.

[Remarques]
 • Configurable uniquement lorsque Network Mode 

est réglé sur Access Point.
 • Auto(5GHz) peut ne pas être affiché en fonction 

du module LAN sans fil utilisé. Vérifiez si 
l’utilisation du module LAN sans fil est prise en 
charge dans votre pays/région. Pour plus de 
détails, consultez le mode d’emploi du module 
LAN sans fil.

DHCP (On/Off) Définit le DHCP.
Lorsque cette fonction est réglée sur On, une 
adresse IP est automatiquement attribuée à 
l’appareil. Pour saisir manuellement l’adresse 
IP de l’appareil, réglez sur Off.

[Remarque]
Configurable uniquement lorsque Network Mode est 
réglé sur Station.

IP Address (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 192.168.1.50)

Permet de saisir l’adresse IP de l’appareil.
Activé lorsque DHCP est réglé sur Off.

[Remarque]
Configurable uniquement lorsque Network Mode est 
réglé sur Station.

Subnet Mask (DHCP/On : 
obtenir automatiquement, 
DHCP/Off : 255.255.255.0)

Permet de saisir le masque de sous-réseau de 
l’appareil.
Activé lorsque DHCP est réglé sur Off.

[Remarque]
Configurable uniquement lorsque Network Mode est 
réglé sur Station.

MAC Address Affiche l’adresse MAC de l’adaptateur LAN 
sans fil raccordé à l’appareil.

Regenerate Password (Run/
Cancel)

Génère le nouveau mot de passe (exécutez en 
sélectionnant Run).

[Remarque]
Exécutable uniquement lorsque Network Mode est 
réglé sur Access Point.

Technical > Alerts & Tally
Permet d’effectuer les réglages relatifs au bouton REC et aux alertes de capacité du support.

Élément de menu Réglage Description

Rec Light On/Off Active/désactive le voyant REC.

Technical > Alerts & Tally
Permet d’effectuer les réglages relatifs au bouton REC et aux alertes de capacité du support.

Élément de menu Réglage Description

Rec Start/Stop Beep 0 à 99 Ajuste le volume du bip sonore émis lors du 
démarrage et de l’arrêt de l’enregistrement.

Media Near Full 
Alarm

1min/3min/5min Règle le seuil d’alarme pour notifier que la 
capacité restante du support est faible.

Technical > Batt./Voltage Alarm
Permet d’effectuer les réglages relatifs aux alarmes de tension de l’alimentation CC externe et des 
batteries.

Élément de menu Réglage Description

Near End:Info Battery 5% à 100% (incréments de 5%) Règle seuil à laquelle l’indicateur de la 
capacité restante de batterie commence à 
clignoter lors de l’utilisation d’une batterie 
Sony Info.

End:Info Battery 0% à 5% Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie Sony Info.

Near End:Sony 
Battery

11.5V à 17V (incréments de 
0.1V)

Règle la valeur seuil à laquelle l’indicateur de 
la capacité restante de batterie commence à 
clignoter lors de l’utilisation d’une batterie 
Sony autre qu’une batterie Info.

End:Sony Battery 11.0V à 12.5V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie Sony autre qu’une 
batterie Info.

Near End:Other 
Battery

11.5V à 17V (11.8V) (incréments 
de 0.1V)

Règle la valeur seuil à laquelle l’indicateur de 
la capacité restante de batterie commence à 
clignoter lors de l’utilisation d’une batterie 
d’un autre fabricant que Sony.

End:Other Battery 11.0V à 14V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage de 
l’avertissement « Battery End » lors de 
l’utilisation d’une batterie d’un autre fabricant 
que Sony.

Detected Battery Sony Info Battery/Sony 
Battery/Other Battery/DC IN 
(12V)/DC IN (24V)

Affiche le résultat de la détection 
automatique du type de pack de batteries.

DC Low Voltage1 11.5V à 17V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement de tension basse lors de 
l’utilisation d’une source d’alimentation 
externe raccordée au connecteur DC IN.
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Technical > Batt./Voltage Alarm
Permet d’effectuer les réglages relatifs aux alarmes de tension de l’alimentation CC externe et des 
batteries.

Élément de menu Réglage Description

DC Low Voltage2 11.0V à 14V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement de sous-tension lors de 
l’utilisation d’une source d’alimentation 
externe raccordée au connecteur DC IN.

DC(24V) Low 
Voltage1

22.5V à 34.0V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement de tension basse lors de 
l’utilisation d’une source d’alimentation 
externe 24 V raccordée au connecteur DC IN.

DC(24V) Low 
Voltage2

22.0V à 28.0V (incréments de 
0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement de sous-tension lors de 
l’utilisation d’une source d’alimentation 
externe 24 V raccordée au connecteur DC IN.

Technical > Panel Control
Effectue les réglages relatifs aux affichages.

Élément de menu Réglage Description

Brightness level High/Mid/Low/Minimum Règle la luminosité de l’affichage secondaire 
et du mini-écran.

Lock Operator Side without Rec Button /  
without Assign3 Button / 
without Rec/Assign3 /  
with Rec/Assign3 Button

Règle si l’opération du bouton REC ou du 
bouton Assign3 est verrouillée ou non lorsque 
les boutons sont verrouillés en utilisant le 
commutateur LOCK du côté opérateur.

Lock Assistant Side without Rec Button / 
with Rec Button

Détermine si l’opération du bouton REC est 
verrouillée ou non lorsque les boutons sont 
verrouillés en utilisant le commutateur LOCK 
du côté assistant.

Technical > False Color
Effectue les réglages relatifs aux fausses couleurs.

[Remarque]
Le réglage False Color est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Level Preset/Manual Détermine si le réglage d’activation/de 
désactivation prédéfini et le seuil de chaque 
fausse couleur doivent être utilisés dans la 
sortie du viseur/du moniteur ou si les 
couleurs doivent être réglées manuellement.
Lorsque Manual est sélectionné, les éléments 
suivants peuvent être configurés.

Red On/Off Active/désactive l’affichage du rouge.

Technical > False Color
Effectue les réglages relatifs aux fausses couleurs.

[Remarque]
Le réglage False Color est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Red Upper Limit 0.0% à 109.0% (96.1%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
rouge.

Red Lower Limit 0.0% à 109.0% (93.4%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
rouge.

Yellow On/Off Active/désactive l’affichage du jaune.

Yellow Upper Limit 0.0% à 109.0% (93.4%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
jaune.

Yellow Lower Limit 0.0% à 109.0% (91.3%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
jaune.

Orange On/Off Active/désactive l’affichage de l’orange.

Orange Upper Limit 0.0% à 109.0% (90.6%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
orange.

Orange Lower Limit 0.0% à 109.0% (87.7%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
orange.

Pink On/Off Active/désactive l’affichage du rose.

Pink Upper Limit 0.0% à 109.0% (58.0%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
rose.

Pink Lower Limit 0.0% à 109.0% (54.3%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
rose.

Light Pink On/Off Active/désactive l’affichage du rose clair.

Light Pink Upper 
Limit

0.0% à 109.0% (50.8%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
rose clair.

Light Pink Lower 
Limit

0.0% à 109.0% (47.8%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
rose clair.

Cyan On/Off Active/désactive l’affichage du cyan.

Cyan Upper Limit 0.0% à 109.0% (46.5%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
cyan.

Cyan Lower Limit 0.0% à 109.0% (43.8%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
cyan.

Green On/Off Active/désactive l’affichage du vert.

Green Upper Limit 0.0% à 109.0% (42.2%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
vert.

Green Lower Limit 0.0% à 109.0% (38.9%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
vert.

Light Blue On/Off Active/désactive l’affichage du bleu clair.
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Technical > False Color
Effectue les réglages relatifs aux fausses couleurs.

[Remarque]
Le réglage False Color est grisé et ne peut pas être modifié lorsque Technical > Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le menu complet.

Élément de menu Réglage Description

Light Blue Upper 
Limit

0.0% à 109.0% (34.4%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
bleu clair.

Light Blue Lower 
Limit

0.0% à 109.0% (24.6%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
bleu clair.

Blue On/Off Active/désactive l’affichage du bleu.

Blue Upper Limit 0.0% à 109.0% (5.6%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
bleu.

Blue Lower Limit 0.0% à 109.0% (3.5%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
bleu.

Purple On/Off Active/désactive l’affichage du violet.

Purple Upper Limit 0.0% à 109.0% (3.5%) 
(incréments de 0.1%)

Règle la limite supérieure pour l’affichage en 
violet.

Purple Lower Limit –7.3% à 109.0% (–7.3%) 
(incréments de 0.1%)

Règle la limite inférieure pour l’affichage en 
violet.

Reset Run/Cancel Réinitialise le réglage d’activation/de 
désactivation et le seuil de chaque couleur 
(exécutez en sélectionnant Run).

Technical > Test Signals
Effectue les réglages relatifs aux barres de couleur.

Élément de menu Réglage Description

Color Bars On/Off Active/désactive les barres de couleur.

[Remarques]
 • Lorsqu’une RM-B170 ou une autre unité de 

télécommande est connectée, le réglage de 
l’unité de télécommande est affiché et grisé.

 • Les barres de couleur ne sont pas enregistrées, 
même si elles sont activées. L’image capturée est 
enregistrée.

Color Bar Type ARIB/SMPTE Sélectionne le type de barres de couleur.

1kHz Tone on Color 
Bars

On/Off Active/désactive la fonction permettant 
d’émettre un signal de test 1 kHz en mode de 
barres de couleur.

Test Saw On/Off Active/désactive le signal de test.

Test Saw Type Saw/Step Saw Sélectionne le type de signal de test.
Saw : sortie d’une onde en dent de scie 

comme signal de test.
Step Saw : sortie d’une onde en escalier 

comme signal de test.

Technical > Special Configuration
Effectue les réglages relatifs au contrôle de l’appareil.

Élément de menu Réglage Description

RM/RCP Paint 
Control

On/Off Active/désactive les fonctions de peinture 
d’une RM-B170 ou d’une autre unité de 
télécommande.

[Remarque]
Tous les réglages de l’appareil sont initialisés 
lorsque le réglage RM/RCP Paint Control est modifié. 
Toutefois, RM/RCP Paint Control et d’autres réglages, 
tels que les réglages réseau, ne sont pas initialisés.

NR(4K 17:9/16:9) On/Off Active/désactive la réduction du bruit des 
images d’enregistrement 4K 17:9/16:9.

[Remarque]
Définissez le réglage sur Off (fixe) lorsque les 
fonctions suivantes sont activées.
 • Select FPS
 • Anamo. De-Squeeze : réglages autres que 

Off(1.0×)
 • Flip Image : réglages autres que Normal

SD HDMI On/Off Active/désactive la fonction permettant de 
régler le signal de sortie HDMI sur le format 
SD.

[Remarque]
Peut être réglé sur On lorsque toutes les conditions 
suivantes sont remplies.
Imager Mode : 16:9 (y compris lorsque Zoom to Fit 
est réglé sur 16:9)
Recording Format : X-OCN ST
Project Frame Rate : 50 ou 59.94

360° Shutter Setting Pre Shutter On/Pre Shutter 
Off

Active/désactive la fonction de pré-obturation 
lorsque vous utilisez un angle d’obturation de 
360° (obturateur désactivé).
Pre Shutter On : active la pré-obturation.
Pre Shutter Off : désactive la pré-obturation.

[Remarque]
Avec le réglage sur Pre Shutter Off, une image 
rémanente peut subsister pendant une trame 
lorsqu’une quantité excessive de lumière a un 
impact, par exemple lors de la prise de vue avec un 
flash.
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Menu Maintenance
Les fonctions et les réglages disponibles de chaque élément de menu sont indiqués ci-après.
Les valeurs par défaut sont soulignées et affichées en gras.

Maintenance > Language
Sélectionne la langue d’affichage des menus et des messages.

Élément de menu Réglage Description

Select English/ Sélectionne la langue d’affichage du menu 
complet et des messages.

Maintenance > Clock Set
Effectue les réglages relatifs à l’horloge intégrée.

Élément de menu Réglage Description

Time Zone UTC + 14:00 à UTC Greenwich 
à UTC – 12:00 (incréments de 
30 minutes)

Sélectionne la différence horaire par rapport 
au temps universel coordonné (temps moyen 
de Greenwich) par incréments de 30 minutes.

Date Mode YYMMDD/MMDDYY/
DDMMYY

Sélectionne le format d’affichage pour les 
dates.
YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

Date Règle la date actuelle (appliquez en appuyant 
sur Set).

Time Règle l’heure actuelle (appliquez en appuyant 
sur Set).

Maintenance > Hours Meter
Affiche le temps d’utilisation accumulé.

Élément de menu Réglage Description

Hours (System) Affiche le temps d’utilisation accumulé de 
l’appareil (ne peut pas être réinitialisé).

Hours (Resettable) Affiche le temps d’utilisation accumulé de 
l’appareil (peut être réinitialisé).

Reset Run/Cancel Réinitialise l’affichage Hours (Resettable) à 0 
(exécutez en Run).

Maintenance > Reset to Default
Réinitialise l’appareil à l’état d’usine par défaut.

Élément de menu Réglage Description

Reset Run/Cancel Initialise tous les réglages de l’appareil 
(exécutez en sélectionnant Run).

Maintenance > Network Reset
Réinitialise les réglages relatifs au réseau à l’état d’usine par défaut.

Élément de menu Réglage Description

Reset Run/Cancel Initialise tous les réglages relatifs au réseau 
(exécutez en sélectionnant Run).

Maintenance > License Options
Installe les options du logiciel.

Élément de menu Réglage Description

Install: <licence_
cible>

Run/Cancel Installe les options du logiciel (exécutez en 
sélectionnant Run).

Anamorphic XX days Remaining (Y keys)/
Permanent License Installed/
Not Installed/Expired

S’affiche si l’option Anamorphic est activée.
XX days Remaining (Y keys) : expiration de la 

licence temporaire
Permanent License Installed : une licence 

permanente est installée
Not Installed : non installé
Expired : la licence temporaire a expiré

Full-Frame XX days Remaining (Y keys)/
Permanent License Installed/
Not Installed/Expired

S’affiche si l’option plein format est activée.
XX days Remaining (Y keys) : expiration de la 

licence temporaire
Permanent License Installed : une licence 

permanente est installée
Not Installed : non installé
Expired : la licence temporaire a expiré

Unique Device ID Affiche l’ID utilisé pour émettre la clé de 
licence de l’option du logiciel.

Maintenance > Firmware
Affiche la version de l’appareil et met à jour le micrologiciel de l’appareil.

Élément de menu Réglage Description

Version Affiche la version de micrologiciel de 
l’appareil (Vx.xx).

Firmware Update Run/Cancel Met à jour l’appareil (exécutez en 
sélectionnant Run).
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Opérations sur les plans sur l’affichage auxiliaire
Les opérations sur les plans sont effectuées à l’aide de l’écran de liste de plans et de l’écran de 
lecture. Vous pouvez lire un plan en sélectionnant le plan à lire à partir de l’écran de liste de plans 
affiché sur l’affichage auxiliaire.

Écran de liste de plans

Appuyez sur le bouton CLIPS (page 11) sur le côté assistant pour afficher l’écran de liste de 
plans pour le support lisible sur l’affichage auxiliaire.

5

4

1 2 3

13
12
11
10
9
8
7
6

1. Bouton de sélection de support
Appuyez sur la touche ITEM 1 pour commuter 
la fente du support de lecture.

2. Bouton de curseur vers le haut
Appuyez sur la touche ITEM 2 pour 
sélectionner le plan à lire à partir de la liste de 
plans.

3. Bouton de début de lecture
Appuyez sur la touche ITEM 3 pour afficher 
l’écran de lecture (page 16) et commencer 
la lecture.

4. Liste de plans
Affiche une liste de plans sur le support de 
lecture actif. Affiche également l’état des 
plans à l’aide d’icônes.

Icône Signification

 (Ne peut pas 
être lu)

Impossible de lire le 
plan

5. Bouton de curseur vers le bas
Appuyez sur la touche ITEM 5 pour 
sélectionner le plan à lire à partir de la liste de 
plans.

6. Position du plan sur le support de lecture
Affiche le numéro du plan indiqué par le 
curseur et le nombre total de plans.

7. Date et heure de création
Affiche la date et heure de création du plan 
indiqué par le curseur.

8. Format (codec)
Affiche le format d’enregistrement (codec) du 
plan indiqué par le curseur.

9. Indicateur de taille d’image
Affiche la taille de l’image effective lors 
de l’enregistrement du plan indiqué par le 
curseur.

10. Indicateur de fréquence d’images du 
projet/mode d’enregistrement spécial

Affiche la fréquence d’images du projet et 
le mode d’enregistrement spécial du plan 
indiqué par le curseur.

11. Durée (Dur)
Affiche la durée du plan indiqué par le curseur.

12. Code temporel (TCR)
Affiche le code temporel de la première image 
du plan indiqué par le curseur.

13. Support de lecture actif
Affiche le support de lecture actif de la liste 
affichée. Affiche l’état du support à l’aide 
d’icônes.

Icône Signification

 (protection) Support protégé contre 
l’écriture
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Écran de lecture

L’écran de lecture est affiché lorsque vous sélectionnez un plan à lire sur l’écran de liste de plans 
et appuyez sur la molette MENU ou le bouton Play (Touche ITEM 3).

Zone d’affichage de fonction

1 2 3

4 5 6

1. Bouton F Rev
Permet la lecture rapide en arrière.

2. Bouton Play/Pause
Permet de lire un plan ou de mettre en pause 
la lecture.

3. Bouton F Fwd
Permet la lecture rapide en avant.

4. Bouton Prev
Permet de passer au début du plan précédent.

5. Boutons Stop/Clips
Permet d’arrêter la lecture et de revenir à 
l’écran de liste de plans.

6. Bouton Next

Permet de passer au début du plan suivant.

Zone d’affichage d’état

1 2 3 4

513

67911

12

810

1. Affichage des données temporelles
Affiche le code temporel de la position de 
lecture.

2. Indicateur de l’état de lecture
Affiche l’état de lecture.
Affiche « CALL » lorsqu’une commande CALL 
est reçue.

3. Indicateur de fréquence d’images
Affiche la fréquence d’images du projet.

4. Indicateur de tension d’alimentation/
capacité restante de la batterie

Affiche la tension d’alimentation ou la 
capacité restante de la batterie.

5. Vu-mètres audio
Affiche le niveau audio de lecture.

6. Indicateur de mode d’enregistrement 
spécial

Affiche les informations sur le mode 
d’enregistrement spécial du plan lu.

7. Indicateur du format du plan lu (codec)
Affiche le format (codec) du plan lu.

8. Indicateur de mode d’imageur
Affiche la taille de l’image.

9. Indicateur de nom de plan
Affiche le nom du plan.

10. Numéro de plan
Affiche le numéro du plan actuellement lu/
nombre total de plans lisibles.

11. Indicateur de support
Affiche le support en cours de lecture.
Une icône  (protection) s’affiche sur la droite 
si la carte mémoire est protégée en écriture.

12. Icône de thermomètre
S’affiche lorsqu’un message d’avertissement 
de température élevée est émis.
La description s’affiche dans la catégorie Info 
du menu.

13. Icône d’avertissement
S’affiche lorsqu’un message différent d’un 
avertissement de température élevée est 
émis.
La description s’affiche dans la catégorie Info 
du menu.
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Lecture
Vous pouvez lire les plans enregistrés alors 
que l’appareil est en mode veille.

[Remarques]
 • Lors de la lecture d’un plan enregistré en ProRes, le 

LUT configuré à l’aide de LUT Select (page 70) dans 
le menu Shooting n’est pas appliqué.

 • Les commandes de lecture apparaissent sur les 
touches ITEM 1 à 6 (page 10). Appuyez sur 
une touche ITEM pour sélectionner l’élément 
correspondant.

1 Insérez la carte mémoire AXS à lire.

2 Appuyez sur le bouton CLIPS (page 11) 
du côté assistant.
La liste des plans du support de lecture 
actif s’affiche sur l’affichage auxiliaire.

3 Utilisez le bouton  (touche ITEM 2), 
bouton  (touche ITEM 5), ou la molette 
MENU pour sélectionner un plan à lire.

4 Appuyez sur la molette MENU ou sur le 
bouton Play (touche ITEM 3).
L’image de lecture apparaît sur l’écran du 
viseur/du moniteur.

Opérations de lecture

L’opération de lecture se commande grâce aux 
boutons de l’affichage auxiliaire (page 96).
Bouton Play/Pause : Mettre en pause la 

lecture. Pour poursuivre la lecture, appuyez 
à nouveau sur ce bouton.

Bouton F Fwd/Bouton F Rev : lecture accélérée 
avant/arrière. Pour revenir en mode de 
lecture normale, appuyez sur le bouton 
Play/Pause.

Bouton Stop/Clips : Permet d’arrêter la lecture 
et de revenir à l’écran de liste de plans.

Contrôle audio

En mode de lecture normale, vous pouvez 
contrôler l’audio enregistré grâce au haut-
parleur intégré (page 9) ou aux écouteurs 
branchés.
Lorsque les écouteurs sont branchés au 
connecteur de casque (page 9), le haut-
parleur intégré est coupé.
Vous pouvez sélectionner le canal à surveiller 
et régler le volume à l’aide de la catégorie 
Audio > Monitor CH et Monitor Level 
(page 59) dans le menu.

Navigation

Pour lire depuis le début d’un plan, appuyez 
sur le bouton Prev sur l’affichage auxiliaire 
(page 96).
Vous pouvez sauter des plans et accéder à un 
autre plan en appuyant à plusieurs reprises 
sur le bouton Prev ou Next.

Passage d’une carte mémoire AXS à 
l’autre

Lorsque deux cartes mémoire AXS sont 
chargées, appuyez sur le bouton SLOT SELECT 
(page 9) pour passer d’une carte mémoire 
à l’autre. Lorsque l’écran de liste de plans est 

affiché sur l’affichage auxiliaire, vous pouvez 
également appuyer sur la touche ITEM 1 de 
l’affichage auxiliaire pour basculer.

[Remarque]
Vous ne pouvez pas basculer entre les cartes mémoire 
AXS pendant la lecture. La lecture continue de cartes 
dans les fentes A et B est impossible.
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Opérations sur l’écran d’accueil du mini-écran
Vous pouvez contrôler l’état de l’appareil 
et définir ses réglages de base sur l’écran 
d’accueil du mini-écran.

1
2
3
4
5

1. FPS
Permet de régler la fréquence d’images de 
prise de vue.

2. Shutter
Affiche et règle la vitesse d’obturation/l’angle 
d’obturation de l’obturateur électronique.

3. ND Filter
Affiche et règle la densité du filtre ND.

4. Exposure Index/Gain
Affiche et règle l’indice d’exposition (EI), ou 
affiche et règle la valeur de gain (unités dB) 
réglée par une RM-B170 ou une autre unité de 
télécommande.

[Remarque]
La valeur de gain n’est affichée que lorsque Technical 
> Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

5. WB (White Balance)
Affiche et règle la balance des blancs.

Affichage et fonctionnement quand RM/
RCP Paint Control est activé

 • La valeur de gain s’affiche au lieu de 
Exposure Index lorsque Technical > Special 
Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet. Dans ce mode, la valeur EI ne peut 
pas être modifiée, mais la valeur de gain 
peut être modifiée.

 • Les éléments suivants ne peuvent pas être 
utilisés lorsqu’une RM-B170 ou une autre 
unité de télécommande est connectée et 
Technical > Special Configuration > RM/
RCP Paint Control (page 93) est réglé 
sur On dans le menu complet. Réglez ces 
options à l’aide de l’unité de télécommande 
(page 119).

 • Shutter
 • WB (White Balance)

Commandes

Bouton HOME (page 9)
Appuyez pour retourner à l’écran d’accueil. Les 
changements non confirmés sont annulés.

Touche ITEM 1 (  (haut)) (page 9)
Appuyez pour sélectionner des éléments sur 
l’écran d’accueil.

Touche ITEM 2 (  (appliquer)) (page 9)
Appuyez pour appliquer l’élément sélectionné.

Touche ITEM 3 (  (bas)) (page 9)
Appuyez pour sélectionner des éléments sur 
l’écran d’accueil.

Fonctionnement de base

1 Appuyez sur la touche ITEM 1, 2 ou 3.
Le curseur s’affiche.

2 Sélectionnez l’élément à régler à l’aide du 
bouton  (touche ITEM 1) ou du bouton 

 (touche ITEM 3).

3 Appuyez sur le bouton  (appliquer) 
(touche ITEM 2).
L’écran de sélection de valeur de réglage 
apparaît pour l’élément sélectionné.

 [Remarque]
Le symbole  (point centré) indique le réglage 
actuel.

4 Déplacez le curseur vers l’élément ou la 
valeur de réglage à l’aide du bouton  
(touche ITEM 1) ou du bouton  (touche 
ITEM 3).

5 Appuyez sur le bouton  (appliquer) 
(touche ITEM 2) pour appliquer le réglage.

6 Appuyez sur le bouton HOME pour 
masquer le curseur.
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Éléments de l’écran d’accueil sur le mini-écran

Les noms des éléments et les valeurs de réglage correspondantes sont indiqués ci-dessous.
Les valeurs par défaut sont soulignées et affichées en gras.

Élément Description

FPS Permet de régler la fréquence d’images de prise de vue.
Variable/Fixed : permet de basculer entre la prise de vue à vitesse variable 
et à vitesse constante sur l’écran d’accueil (page 44) de l’affichage 
auxiliaire.
Lorsque « Fixed » est sélectionné, le réglage est déterminé par le réglage 
de la catégorie Project > Project Frame Rate (page 56) dans le menu.

Project Frame Rate Affichage

23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94

Lorsque « Variable » est sélectionné, les réglages changent de la manière 
suivante, en fonction des réglages de la catégorie Project > Imager Mode 
(page 74) et Recording Format (page 74) dans le menu.

Enregistrement X-OCN
MPC-3628

Imager Mode Fréquence d’images de prise de vue

8.6K 3:2 1 à 30 IPS

8.2K 17:9
7.6K 16:9

1 à 60 IPS

5.8K 6:5 1 à 48 IPS

5.8K 17:9
5.4K 16:9

1 à 60, 66, 72, 75, 88, 90 IPS

Élément Description

MPC-3626

Imager Mode Réglage

6K 3:2 1 à 60 IPS

6K 1.85:1
6K 17:9
5.7K 16:9

1 à 60, 66, 72 IPS

6K 2.39:1 1 à 60, 66, 72, 75, 88, 90 IPS

4K 6:5 1 à 60, 66, 72 IPS

4K 4:3 1 à 60, 66, 72, 75 IPS

4K 4:3 Surround View 1 à 30 IPS

4K 17:9
3.8K 16:9

1 à 60, 66, 72, 75, 88, 90, 96, 100, 110 IPS

4K 17:9 Surround View
3.8K 16:9 Surround View

1 à 48 IPS

4K 2.39:1 1 à 60, 66, 72, 75, 88, 90, 96, 100, 110, 120 IPS

Enregistrement ProRes
MPC-3628

Imager Mode Fréquence d’images de prise de vue

ProRes 4K / QFHD

4444 422 HQ

8.2K 17:9
7.6K 16:9

1 à 60 IPS 1 à 60 IPS

5.8K 6:5 1 à 48 IPS 1 à 48 IPS

5.8K 17:9
5.4K 16:9

1 à 60 IPS 1 à 60, 66, 72, 75 IPS
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Élément Description

MPC-3626

Imager Mode Fréquence d’images de prise de vue

ProRes 4K / QFHD

4444 422 HQ

6K 17:9
5.7K 16:9

1 à 60 IPS 1 à 60, 66, 72 IPS

6K 2.39:1 1 à 60 IPS 1 à 60, 66, 72, 75 IPS

4K 6:5 1 à 60 IPS 1 à 60, 66, 72 IPS

4K 17:9
3.8K 16:9

1 à 60 IPS 1 à 60, 66, 72, 75, 88, 
90 IPS

4K 17:9 Surround View
3.8K 16:9 Surround View

1 à 48 IPS 1 à 48 IPS

4K 2.39:1 1 à 60 IPS 1 à 60, 66, 72, 75, 88, 
90 IPS

[Remarque]
Une fréquence d’images de prise de vue de 7 ou inférieure ne peut pas être définie 
dans les cas suivants.

 – Lorsque Base ISO est réglé sur ISO 3200
 – Lorsque Base ISO est réglé sur ISO 2500 et le format d’enregistrement est ProRes

Exposure Index Définit la valeur EI. Les réglages changent de la manière suivante, en 
fonction du réglage Project > Basic Setting > Base ISO (page 74) dans le 
menu complet.
MPC-3628

Base ISO 800 :
200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/1600EI/ 
2000EI/2500EI/3200EI

Base ISO 3200 :
800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/5000EI/ 
6400EI/8000EI/10000EI/12800EI

MPC-3626
ISO 500 :

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500 :
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI

Gain Règle la sensibilité de base.
–6dB/–3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

[Remarque]
Configurable uniquement lorsqu’une RM-B170 ou une autre unité de télécommande 
est connectée et Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Élément Description

Shutter Règle la vitesse d’obturation/l’angle de l’obturateur électronique.
Sélectionnez à partir des valeurs préréglées enregistrées en tant qu’étapes 
d’obturation.

[Remarque]
Non disponible lorsque l’opération de l’obturateur électronique est réglée sur 
Continuous.

Affiche les options de sélection suivantes en fonction du réglage Technical 
> System Configuration > Shutter Mode (page 89) dans le menu complet.
Angle (Δ) : indicateur d’angle d’obturation

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.6 1)

Speed (SS) : indicateur de vitesse d’obturation
1/24, 1/25, 1/30, 1/48, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 
1/2000 1)

ND Filter Règle la densité du filtre ND. Les réglages suivants sont disponibles.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance) Règle la température de couleur de la balance des blancs.
Sélectionnez à partir des valeurs préréglées enregistrées en tant qu’étapes 
de balance des blancs.

3200K+00/4300K+00/5500K+00 1)

1) Les options de sélection peuvent être modifiées à l’aide de Step Edit sur l’écran d’accueil de l’affichage auxiliaire.
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Opérations sur les plans sur le mini-écran
Vous pouvez lire un plan en sélectionnant le 
plan à lire à partir de l’écran des plans affiché 
sur le mini-écran.

Écran des plans

Appuyez sur le bouton CLIPS (page 9) sur 
le côté opérateur pour afficher l’écran des 
plans pour le support lisible sur le mini-écran.

7

6

5

1
2

3

4

1.  Indicateur de l’état de lecture
Affiche l’état de lecture du plan.

2. Support de lecture actif
Affiche le support de lecture actif du plan 
sélectionné.

3. Indicateur de nom de plan
Affiche le nom de plan du plan sélectionné.

4. Position du plan sur le support de lecture
Affiche le numéro de plan/nombre total du 
plan sélectionné.

5. Bouton F Fwd/Next
Passe au plan suivant lorsque le bouton  
(touche ITEM 3) est enfoncé pendant que la 
lecture est en pause.
Lit le plan en lecture accélérée avant lorsque 
le bouton  (touche ITEM 3) est enfoncé 
pendant la lecture.

6. Bouton Play/Pause
Lit/met la lecture du plan en pause lorsque le 
bouton  (touche ITEM 2) est enfoncé.

7. Bouton F Rev/Prev
Passe au plan précédent lorsque le bouton  
(touche ITEM 1) est enfoncé pendant que la 
lecture est en pause.
Lit le plan en lecture accélérée arrière lorsque 
le bouton  (touche ITEM 1) est enfoncé 
pendant la lecture.

Lecture

Vous pouvez lire les plans enregistrés alors 
que l’appareil est en mode veille.

1 Insérez la carte mémoire AXS à lire.

2 Appuyez sur le bouton CLIPS (page 9) 
du côté opérateur.
Le plan en cours de lecture active apparaît 
sur le mini-écran.

3 Utilisez le bouton Prev (touche ITEM 1) ou 
le bouton Next (touche ITEM 3) pour 
sélectionner un plan à lire.

4 Appuyez sur le bouton Play/Pause 
(touche ITEM 2).
L’image de lecture apparaît sur l’écran du 
viseur/du moniteur.

Opérations de lecture

L’opération de lecture se commande grâce aux 
boutons du mini-écran (page 101).
Bouton Play/Pause : mettre en pause la 
lecture. Pour poursuivre la lecture, appuyez à 
nouveau sur ce bouton.
Bouton F Fwd/Bouton F Rev : lecture accélérée 
avant/arrière. Pour revenir en mode de lecture 
normale, appuyez sur le bouton Play/Pause.

Contrôle audio

En mode de lecture normale, vous pouvez 
contrôler l’audio enregistré grâce au haut-
parleur intégré (page 9) ou aux écouteurs 
branchés.
Lorsque les écouteurs sont branchés au 
connecteur de casque (page 9), le haut-
parleur intégré est coupé.
Vous pouvez sélectionner le canal à surveiller 
et régler le volume à l’aide de la catégorie 
Audio > Monitor CH et Monitor Level 
(page 59) dans le menu.

Passage d’une carte mémoire AXS à 
l’autre

Lorsque deux cartes mémoire AXS sont 
chargées, appuyez sur le bouton SLOT SELECT 
(page 9) pour passer d’une carte mémoire 
à l’autre. Lorsque l’écran de liste de plans est 
affiché sur l’affichage auxiliaire, vous pouvez 
également appuyer sur la touche ITEM 1 de 
l’affichage auxiliaire pour basculer.

[Remarque]
Vous ne pouvez pas basculer entre les cartes mémoire 
AXS pendant la lecture. La lecture continue de cartes 
dans les fentes A et B est impossible.
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Configuration et opérations réseau
Connecter l’appareil à un réseau vous permet 
de contrôler différents réglages de l’appareil 
à partir d’un ordinateur, d’un smartphone, 
d’une tablette ou d’un autre périphérique 
et d’afficher des informations concernant 
l’appareil.

[Remarque]
Lors de la connexion à Internet, connectez-vous via un 
routeur, un dispositif doté d’une fonction de routeur ou 
un pare-feu pour éviter toute attaque externe.

Présentation de la fonction réseau

Lorsque l’appareil et un périphérique sont 
connectés via LAN filaire ou un LAN sans fil, il 
est possible d’accéder à l’appareil depuis un 
navigateur sur le périphérique, en affichant 
la télécommande Web et en activant les 
opérations suivantes.
 • Contrôler l’enregistrement sur l’appareil 

(page 106)
 • Contrôler la lecture sur l’appareil 

(page 106)
 • Configurer les réglages de prise de vue sur 

l’appareil (page 106)
 • Contrôler l’objectif fixé à l’appareil 

(page 106)
 • Configurer et utiliser des boutons 

assignables sur l’appareil (page 106)
Utiliser la télécommande Web vous permet 
de lancer/arrêter l’enregistrement ou de 
configurer les réglages à distance et est 
également utile dans des circonstances dans 
lesquelles l’appareil est positionné à distance 
ou monté sur une grue, par exemple.

Périphériques compatibles

Vous pouvez utiliser un ordinateur, un 
smartphone ou une tablette pour configurer 
et utiliser l’appareil. Les périphériques, le 
système d’exploitation et les navigateurs 
vérifiés sont affichés dans le tableau suivant.

Périphérique Système 
d’exploitation

Navigateur

Ordinateur Microsoft Windows 
10/11

Chrome

macOS 11.x Safari

Smartphone Android 10.x/11.x Chrome

iOS 14.x/15 Safari

Tablette Android 10.x/11.x Chrome

iPadOS 14.x Safari

[Remarque]
Les contrôles peuvent ne pas s’afficher normalement, en 
fonction de la version du navigateur que vous utilisez. 
Le fonctionnement a été vérifié dans les versions de 
navigateur suivantes.
Safari : 14/15
Chrome : 93

Connexion de l’appareil et d’un 
périphérique via un LAN filaire

Vous pouvez connecter l’appareil à un 
périphérique via une connexion LAN filaire ou 
un routeur en utilisant le connecteur réseau 
de l’appareil.

1 Raccordez le connecteur réseau 
(page 12) de l’appareil à l’ordinateur à 
l’aide d’un câble LAN. Ou raccordez le 
connecteur réseau de l’appareil au routeur 
à l’aide d’un câble LAN.

2 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
LAN.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

3 Configurez l’appareil.
Pour obtenir l’adresse IP de l’appareil 
automatiquement :
Réglez Technical > Network > LAN > DHCP 
(page 90) dans le menu complet sur 
On, puis sélectionnez Set pour appliquer 
le réglage.
Pour saisir l’adresse IP de l’appareil 
manuellement :
Réglez Technical > Network > LAN > DHCP 
dans le menu complet sur Off, saisissez 
l’adresse IP spécifiée à l’aide de LAN > IP 
Address, puis sélectionnez Set pour 
appliquer le réglage.

 [Remarque]
Sélectionnez Set sur l’écran de configuration 
Technical > Network > LAN dans le menu complet. 
Si vous ne sélectionnez pas Set, les réglages 
configurés ne sont pas appliqués.

Lorsque la connexion LAN filaire est 
activée, l’icône LAN de l’indicateur d’état 
de connexion au réseau (page 15) 
s’affiche sur l’écran du viseur/du 
moniteur.

Connexion de l’appareil et d’un 
périphérique via un LAN sans fil

L’appareil peut se connecter à des 
périphériques à l’aide d’une connexion LAN 
sans fil si l’adaptateur LAN sans fil CBK-WA02 
(optionnel) est fixé à l’appareil.

Fixation du CBK-WA02

[Remarque]
Mettez toujours l’appareil hors tension avant de 
raccorder le CBK-WA02.

1 Fixez l’adaptateur d’extension USB au 
point indiqué dans l’image ci-dessous et 
tournez la vis de retenue dans le sens des 
aiguilles d’une montre pour la verrouiller 
en place.

Vis de retenue
Adaptateur 
d’extension USB

Vous pouvez ajuster la position de 
l’adaptateur d’extension USB en le glissant 
tel qu’indiqué dans l’image ci-dessous.
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2 Fixez le cache de protection (fourni) au 
connecteur USB de l’adaptateur 
d’extension USB.

3 Ouvrez le couvercle du bloc de connecteur 
du périphérique externe et insérez le 
connecteur USB de l’adaptateur 
d’extension USB dans le connecteur du 
périphérique externe.

4 Insérez le CBK-WA02 dans le connecteur 
USB de l’adaptateur d’extension USB.

Connexion en mode de point d’accès

L’appareil peut se connecter aux dispositifs qui 
sont configurés comme points d’accès via LAN 
sans fil.

Smartphone/
Tablette

Ordinateur

Connexion à l’aide de dispositifs équipés du 
WPS
Les dispositifs qui prennent en charge le WPS 
peuvent être connectés à l’aide du WPS.

1 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
Wireless.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

2 Réglez Technical > Network > Wireless > 
Network Mode (page 90) dans le menu 
complet sur Access Point.

3 Sélectionnez Technical > Network > 
Wireless > WPS (page 90) dans le menu 
complet.

4 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

5 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

6 Appuyez sur le bouton poussoir WPS dans 
les réglages réseau ou les réglages Wi-Fi 
du dispositif.

[Remarque]
Les étapes varient en fonction du dispositif utilisé.

Connexion à l’aide d’un SSID et d’un mot de 
passe sur le dispositif
Connectez-vous en saisissant le SSID et le mot 
de passe sur le dispositif.

1 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
Wireless.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

2 Réglez Technical > Network > Wireless > 
Network Mode (page 90) dans le menu 
complet sur Access Point.

3 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

4 Sélectionnez le SSID de l’appareil à partir 
de la liste de SSID du réseau Wi-Fi, puis 
saisissez un mot de passe pour vous 
connecter.
Pour le SSID et le mot de passe de 
l’appareil, reportez-vous à Technical > 
Network > Wireless > SSID et Password 
(page 90) dans le menu complet.

[Remarque]
Les étapes varient en fonction du dispositif utilisé.

Connexion en mode station

L’appareil peut se connecter à des points 
d’accès de LAN sans fil existants en tant que 
client.
Le dispositif se connecte par l’intermédiaire du 
point d’accès.

Smartphone/
Tablette

Ordinateur

Point 
d’accès

Connexion à un point d’accès à l’aide de la 
fonction WPS
Si un point d’accès prend en charge la fonction 
WPS, vous pouvez vous connecter à l’aide 
d’un réglage de base.

1 Activez le point d’accès.
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2 Allumez l’appareil.

3 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
Wireless.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

4 Réglez Technical > Network > Wireless > 
Network Mode (page 90) dans le menu 
complet sur Station.

5 Sélectionnez Technical > Network > 
Wireless > WPS (page 90) dans le menu 
complet.

6 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

7 Appuyez sur le bouton WPS du point 
d’accès.
Pour de plus amples informations 
concernant le fonctionnement du bouton 
WPS, reportez-vous au mode d’emploi du 
point d’accès.

[Remarque]
Si la connexion échoue, exécutez de nouveau la 
procédure de l’étape 1.

Connexion en saisissant un SSID et un mot de 
passe
Connectez-vous en saisissant le SSID et le mot 
de passe sur l’appareil.

1 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
Wireless.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

2 Réglez Technical > Network > Wireless > 
Network Mode (page 90) dans le menu 
complet sur Station.

3 Réglez les éléments suivants dans 
Technical > Network > Wireless 
(page 90) dans le menu complet.
 • SSID
 • Password
 • DHCP
 • IP Address
 • Subnet Mask

4 Sélectionnez Set pour confirmer.

[Remarque]
Usez toujours Set pour confirmer les réglages. Si les 
réglages ne sont pas confirmés à l’aide de Set, les 
réglages configurés ne seront pas appliqués.

Connexion à l’aide de la détection 
automatique de point d’accès
L’appareil peut se connecter en détectant 
automatiquement les points d’accès de 
connexion sans avoir à saisir manuellement le 
SSID.

1 Réglez Technical > Network > Setting 
(page 90) dans le menu complet sur 
Wireless.

 [Remarque]
Grisé et ne peut pas être modifié si un mot de 
passe n’est pas configuré à l’aide de Technical > 
Authentication > Password (page 90) dans le 
menu complet.

2 Réglez Technical > Network > Wireless > 
Network Mode (page 90) dans le menu 
complet sur Station.

3 Sélectionnez Technical > Network > 
Wireless > Scan Networks (page 90) 
dans le menu complet.

4 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.
L’appareil lance la détection automatique 
des points d’accès de connexion. Lorsque 
la détection automatique est terminée, les 
réseaux disponibles à la connexion sont 
affichés dans une liste.

5 Sélectionnez le réseau auquel se 
connecter en tournant la molette MENU, 
puis appuyez sur la molette MENU.

6 Sélectionnez Set pour confirmer.
Un écran de saisie du mot de passe 
apparaît.

7 Saisissez le mot de passe, puis 
sélectionnez Done.
L’écran des préférences Wireless apparaît.

8 Réglez les éléments suivants dans 
Technical > Network > Wireless dans le 
menu complet, puis sélectionnez Set pour 
confirmer.
 • DHCP
 • IP Address
 • Subnet Mask

[Remarque]
Usez toujours Set pour confirmer les réglages. Si les 
réglages ne sont pas confirmés à l’aide de Set, les 
réglages configurés ne seront pas appliqués.

Affichage de la télécommande 
Web

La télécommande Web s’affiche lorsqu’un 
accès à l’appareil a lieu depuis le 
navigateur d’un périphérique. L’écran de la 
télécommande Web est automatiquement 
redimensionné pour s’adapter à la taille de 
l’écran du périphérique connecté.

1 Connectez l’appareil et le périphérique 
comme indiqué dans « Connexion de 
l’appareil et d’un périphérique via un LAN 
filaire » ou « Connexion de l’appareil et 
d’un périphérique via un LAN sans fil ».

2 Lancez un navigateur sur le périphérique 
et saisissez « http://adresse IP de 
l’appareil/rm.html » dans la barre d’URL.
Vous pouvez vérifier l’adresse IP de 
l’appareil avec la catégorie Info > System > 
IP Address (page 59) dans le menu.
Par exemple, si l’adresse IP est 192.168.1.1, 
saisissez « http://192.168.1.1/rm.html » 
dans la barre d’URL.

3 Saisissez le nom d’utilisateur et le mot de 
passe (Technical > Authentication 
(page 89) dans le menu complet) sur 
l’écran du navigateur.
Une fois la connexion réussie, l’écran de 
télécommande Web apparaît sur le 
périphérique.

[Remarque]
La page risque de ne pas s’afficher correctement sur un 
smartphone ou un autre appareil si le mode d’affichage 
est défini sur les pages mobiles. Changez le mode 
d’affichage sur les pages du bureau.

http://IP%20address%20of%20unit/rm.html
http://IP%20address%20of%20unit/rm.html
http://192.168.1.1/rm.html
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Écran de télécommande Web

Global Menu

Sélectionnez  (Global Menu) en haut 
à gauche de la télécommande Web pour 
afficher le Global Menu. Sélectionnez 
l’élément que vous souhaitez configurer.

Écran Camera Control

L’écran Camera Control comprend l’écran 
Camera, l’écran Lens et l’écran Info. 
Sélectionnez l’onglet Camera pour afficher 
l’écran Camera, l’onglet Lens pour afficher 
l’écran Lens, et l’onglet Info pour afficher 
l’écran Info.
Différents éléments d’affichage et boutons 
d’opération sont affichés sur l’écran Camera 
Control (éléments communs à l’écran Camera, 
l’écran Lens, l’écran Info et l’écran de lecture).
 • État de connexion du réseau (Connected/

Disconnected)
 • Camera ID*
 • Bouton Rec
 • Boutons assignables (1 à 4, A à C)

* La couleur du texte Camera ID est la même couleur 
que celle réglée à l’aide de Frame Line A/B Setup > 
Color.

Écran Camera

Vous pouvez configurer les mêmes éléments 
que ceux affichés sur l’écran d’accueil de 
l’affichage auxiliaire sur l’écran Camera.

[Remarque]
De même que pour l’écran d’affichage auxiliaire, la 
zone d’affichage EI devient la zone d’affichage Gain et 
des restrictions s’appliquent aux éléments (page 38) 
qui peuvent être utilisés lorsque Technical > Special 
Configuration > RM/RCP Paint Control (page 93) est 
réglé sur On dans le menu complet.

 • Réglages de prise de vue (page 36) 
FPS, EI, Shutter, ND, LUT, WB

 • Affichage de l’état de la caméra (page 37) 
État de fonctionnement, données 
temporelles, vu-mètre audio, nom du plan, 
format d’enregistrement, état du support/
espace libre, tension de la batterie/capacité 
restante de la batterie

Écran Lens

Les contrôles de l’objectif pour le zoom, la 
mise au point et le diaphragme sont affichés 
sur l’écran Lens.

Écran Info

L’écran Info affiche le même contenu que la 
catégorie Info (page 59) de l’écran de menu 
de l’affichage auxiliaire, vous permettant de 
vérifier l’état de la caméra, du support et de la 
batterie.

Écran Full Menu

Sélectionnez Full Menu dans le Global Menu 
pour afficher l’écran de menu complet afin de 
configurer les éléments (page 66).

[Remarque]
Il se peut que certains éléments ne soient pas 
configurables à partir de la télécommande Web.

Écran OSS (Open Source Software) 
Information

Sélectionnez OSS Information dans le Global 
Menu pour afficher les informations sur le 
logiciel libre.

Écran de lecture

Vous pouvez lire des plans sur l’écran de 
lecture. Les informations concernant le plan 
lu sont également affichées dans la zone 
d’affichage d’état de l’écran.
 • Affichage de fonction (page 96) 

F Rev, Play/Pause, F Fwd, Prev, Stop/Clips, 
Next

 • Affichage de l’état de lecture (page 96) 
Données temporelles, numéro de plan, 
fréquence d’images/taille d’image du plan 
lu, mode d’enregistrement spécial, vu-mètre 
audio, format du plan lu (codec), icône 
(protection-plan), nom de plan, support de 
lecture et état de lecture.

Bouton HOME

Appuyez sur le bouton HOME pour retourner à 
l’écran Camera.
Lorsque la caméra est en mode de lecture, 
appuyer sur le bouton HOME permet de 
revenir à l’état de prise de vue de la caméra 
même lorsque l’écran de lecture s’affiche sur 
l’écran de la télécommande Web.

Bouton CLIPS

Appuyez sur le bouton CLIPS pour retourner à 
l’écran de lecture. (L’appareil passe à l’écran de 
liste de plans (page 95).)
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Enregistrement

Appuyez sur le bouton Rec sur l’écran Camera 
Control pour commencer l’enregistrement 
et pour que le voyant REC s’affiche en 
rouge. Cliquez à nouveau pour arrêter 
l’enregistrement.
Le bouton Rec est activé lorsque le témoin 
REC ACTIVE ci-dessous et à la droite du bouton 
Rec est vert.

Pour verrouiller le bouton Rec

Faites glisser le curseur de verrouillage sous 
le bouton Rec vers la droite pour désactiver 
l’opération du bouton Rec.

Lecture

Appuyez sur le bouton CLIPS sur l’écran 
Camera pour retourner à l’écran de lecture 
en état de lecture. (L’affichage auxiliaire de 
l’appareil affiche l’écran de liste de plans 
(page 95).)
Sélectionnez le plan que vous souhaitez 
lire sur l’écran de lecture et utilisez les 
commandes de lecture pour lire le plan.

Pour basculer entre les supports de 
lecture

Appuyez sur le bouton de sélection du 
support pour commuter la fente du support 
de lecture.

Configuration des réglages de 
prise de vue

Vous pouvez configurer et utiliser les mêmes 
éléments qui ceux affichés sur l’écran d’accueil 
de l’affichage auxiliaire de l’appareil sur l’écran 
Camera.

[Remarque]
L’opération Step Edit pour Shutter n’est pas prise en 
charge.

L’opération est la même que sur l’écran 
d’accueil de l’affichage auxiliaire.

« Opérations sur l’écran d’accueil de l’affichage auxiliaire » 
(page 38)

Contrôle de l’objectif

Vous pouvez vérifier l’état des réglages de 
l’objectif à monture E (zoom, mise au point, 
diaphragme) sur l’écran Lens, et également 
contrôler le zoom, la mise au point et le 
diaphragme en utilisant les curseurs, si 
l’objectif fixé peut être contrôlé.
Le contrôle de communication de l’objectif 
Cooke à monture PL est pris en charge sur 
l’écran Lens.
Le contrôle de communication de l’objectif à 
12 broches est également pris en charge sur 
l’écran Lens.

[Remarque]
Les curseurs sont grisés et ne peuvent pas être 
utilisés lorsqu’une RM-B170 ou une autre unité de 
télécommande est connectée et Technical > Special 
Configuration > RM/RCP Paint Control (page 93) 
est réglé sur On dans le menu complet. Les curseurs 
de mise au point et de zoom sont grisés lorsque 
la télécommande de la mise au point et du zoom, 
respectivement, est activée.

Configuration/Utilisation des 
boutons assignables

Les boutons assignables 1 à 4 et les boutons 
assignables A à C du viseur sont affichés sur 
l’écran Camera Control.
Appuyez sur les boutons assignables 1 à 4 et 
les boutons assignables A à C du DVF-EL200 
pour faire basculer les fonctions assignées 
entre on/off (activé/désactivé) ou pour activer 
les fonctions assignées de la même manière 
que les boutons assignables à sur l’appareil.
Sélectionnez le nom de la fonction d’un 
bouton assignable pour afficher les options 
de sélection dans un menu déroulant. 
Sélectionnez une option pour changer la 
fonction assignée au bouton assignable.

« Fonctions pouvant être assignées aux boutons 
assignables 1 à 4 » (page 51)

« Fonctions pouvant être assignées aux boutons 
assignables A à C du viseur (DVF-EL200) » (page 53)

[Remarque]
Les fonctions assignées aux commutateurs assignables 
qui sont activés uniquement lorsqu’un bouton est 
enfoncé ou sont activés par une pression longue 
ne peuvent pas être utilisées grâce aux boutons 
assignables de la télécommande Web. Ceci comprend 
les fonctions suivantes.

 – Press&Hold for SDI12 Log
 – Press&Hold for SDI34 Log
 – Press & Hold for Moni Log
 – Press & Hold for VF Log
 – Iris Open (1/16 stop)
 – Iris Close (1/16 stop)
 – Monitor Focus Magnifier (lorsque Monitor Magnifier 

Mode est réglé sur Press & Hold)
 – VF Focus Magnifier (lorsque VF Magnifier Mode est 

réglé sur Press & Hold)

Chargement de plusieurs fichiers

Vous pouvez charger un fichier User 3D LUT, 
un fichier ART ou un fichier ASC CDL dans 
l’appareil en utilisant l’écran de sélection du 
LUT de l’écran Camera.

Affichage de l’écran de sélection du LUT

Cliquez/appuyez sur la zone de sélection 
du LUT sur l’écran d’accueil de l’affichage 
auxiliaire de l’écran Camera.

Zone de sélection du LUT

L’écran de sélection du LUT s’affiche.

Chargement d’un fichier User 3D LUT

Vous pouvez également charger un fichier 
User 3D LUT dans l’appareil via un dispositif 
connecté au réseau.

1 Cliquez/appuyez sur le bouton Edit Look 
sur l’écran de sélection du LUT.
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L’écran de sélection du Look s’affiche.

2 Cliquez/appuyez sur le bouton Load File.
L’écran de sélection de type de fichier 
apparaît.

3 Déplacez le curseur sur Load User 3D LUT 
File et cliquez/appuyez sur le bouton 
Select.
Un écran de sélection de destination de 
charge apparaît.

4 Déplacez le curseur sur Web et cliquez/
appuyez sur le bouton Select.

Les numéros de destination de 
chargement (01 à 16) s’affichent.

Un nom de fichier s’affiche pour les 
numéros chargés.

5 Utilisez le bouton , le bouton , ou 
touchez-le directement pour déplacer le 
curseur sur un numéro de destination de 
charge, puis cliquez/appuyez sur le 
bouton Select.

6 Ouvrez un dossier sur le dispositif 
connecté au réseau et sélectionnez le 
fichier à charger.
Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

Chargement d’un fichier ART

Vous pouvez charger un fichier ART dans 
l’appareil via un dispositif connecté au réseau.

1 Cliquez/appuyez sur le bouton Edit Look 
sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Cliquez/appuyez sur le bouton Load File.
L’écran de sélection de type de fichier 
apparaît.

3 Déplacez le curseur sur Load ART File et 
cliquez/appuyez sur le bouton Select.
Un écran de sélection de destination de 
charge apparaît.

4 Déplacez le curseur sur Web et cliquez/
appuyez sur le bouton Select.

Les numéros de destination de 
chargement (01 à 16) s’affichent.
Un nom de fichier s’affiche pour les 
numéros chargés.

5 Utilisez le bouton , le bouton , ou 
touchez-le directement pour déplacer le 
curseur sur un numéro de destination de 
charge, puis cliquez/appuyez sur le 
bouton Select.

6 Ouvrez un dossier sur le dispositif 
connecté au réseau et sélectionnez le 
fichier à charger.
Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

Chargement d’un fichier ASC CDL

Vous pouvez charger un fichier ASC CDL dans 
l’appareil via un dispositif connecté au réseau.

1 Cliquez/appuyez sur le bouton Edit Look 
sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.
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2 Cliquez/appuyez sur le bouton Load File.
L’écran de sélection de type de fichier 
apparaît.

3 Déplacez le curseur sur Load ASC CDL File 
et cliquez/appuyez sur le bouton Select.
Un écran de sélection de destination de 
charge apparaît.

4 Déplacez le curseur sur Web et cliquez/
appuyez sur le bouton Select.

5 Ouvrez un dossier sur le dispositif 
connecté au réseau et sélectionnez le 
fichier à charger.

Lorsque le fichier est correctement 
chargé, le message « Sucessfully loaded » 
s’affiche.

Modification de la saturation dans 
un fichier ASC CDL

Vous pouvez modifier le réglage de saturation 
dans un fichier ASC CDL à l’aide de l’écran de 
sélection du LUT de l’écran Camera.

1 Cliquez/appuyez sur le bouton Edit Look 
sur l’écran de sélection du LUT.
L’écran de sélection du Look s’affiche.

2 Déplacez le curseur sur ASC CDL Select, et 
cliquez/appuyez sur le bouton CDL/ART 
Info.
L’écran d’information du fichier ASC CDL 
apparaît.

3 Cliquez/appuyez sur le bouton Edit.
L’écran de modification Saturation 
apparaît.

4 Cliquez/appuyez sur le bouton + ou le 
bouton – pour changer le réglage.

5 Cliquez/appuyez sur le bouton OK pour 
appliquer le réglage.

Verrouillage de l’écran de 
télécommande Web

Vous pouvez désactiver le fonctionnement 
de l’écran de télécommande Web en faisant 
glisser le curseur de verrouillage vers la droite 
en haut à droite de l’écran de télécommande 
Web.
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Fonctionnement de base
Vous pouvez procéder à l’enregistrement de 
base à l’aide des procédures suivantes.

1 Assurez-vous que les périphériques 
nécessaires sont fixés à l’appareil et qu’ils 
sont alimentés en tension.

2 Réglez l’interrupteur d’alimentation 
(page 9) sur la position ON.
L’écran d’enregistrement s’affiche sur le 
l’écran du viseur.

3 Chargez une/des carte(s) mémoire.
Si vous chargez deux cartes mémoire AXS, 
l’enregistrement se poursuit par 
commutation automatique à la deuxième 
carte lorsque la première est pleine.

4 Appuyez sur le bouton REC (pages 9, 
11).
Le voyant REC s’allume et l’enregistrement 
commence.

 [Remarque]
Si l’appareil ne peut pas démarrer immédiatement 
l’enregistrement alors que vous avez appuyé sur le 
bouton REC, le voyant REC clignote. Le voyant REC 
s’allume quand l’enregistrement commence.

5 Pour arrêter l’enregistrement, appuyez à 
nouveau sur le bouton REC.
L’enregistrement s’arrête et l’appareil 
passe en mode STBY (veille 
d’enregistrement).
Lorsque vous arrêtez d’enregistrer, les 
données vidéo, audio et subsidiaires du 
début à la fin de l’enregistrement sont 
enregistrées sous la forme d’un plan 
unique.

Noms de plans

Les noms de plans sont enregistrés en 
utilisant le format « Cam ID + Reel# ». Le 
nom du plan est créé en fonction des règles 
suivantes.
 • S’il existe déjà un plan mémorisé utilisant 

le format de nom « Cam ID + Reel# » sur 
la carte mémoire AXS insérée, le nouveau 
fichier hérite des informations du dernier 
fichier.  
Exemple : si « B002C003_XXXXXXXX » existe 
sur la carte mémoire AXS, le prochain plan 
créé sera appelé « B002C004_XXXXXXXX ».

 • Si la carte mémoire AXS insérée ne 
comporte pas de fichiers, « 1 » est ajouté à 
Reel Number du dernier plan enregistré.  
Exemple : si vous enregistrez sur une 
carte vide 2 après avoir enregistré jusqu’à 
« D001CXXX_XXXXXXXX » sur la carte 1, le 
prochain plan créé sera appelé « D002C001_
XXXXXXXX ». Le nom du plan apparaît 
souligné jusqu’à ce que l’enregistrement 
commence.

 • Si vous réglez Camera ID et Reel Number 
à l’aide de la catégorie TC/Media dans le 
menu, ces informations sont appliquées.  
Exemple : si vous changez Camera ID à  
« F » et Reel Number à « 001 » dans le menu 
pour la carte mémoire AXS qui a enregistré 
jusqu’au « E003CXXX_XXXXXXXX », le 
plan suivant sera appelé « F001CXXX_
XXXXXXXX ». Quand vous modifiez 
uniquement Camera ID, Reel Number passe 
à « 001 ».
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Fonctions utiles

Affichage User Frame Line

Vous pouvez sélectionner d’afficher ou non 
des lignes de cadre utilisateur configurées de 
façon arbitraire ou un rapport d’aspect fixe.
User Frame Line 1 et User Frame Line 2 
peuvent être définis pour les lignes de cadre 
utilisateur.
Pour définir les lignes configurées par 
l’utilisateur, sélectionnez Variable à l’aide de 
Monitoring > User Frame Line 1 (page 84) ou 
User Frame Line 2 (page 85) > Select dans 
le menu complet, et spécifiez les éléments de 
menu Width, Height, H Position et V Position.
Pour définir un rapport d’aspect fixe, 
sélectionnez Preset à l’aide de Monitoring > 
User Frame Line 1 (page 84) ou User Frame 
Line 2 (page 85) > Select dans le menu 
complet, et spécifiez les éléments de menu 
Preset Aspect Ratio, Scaling et Preset Aspect 
Ratio Type.
Vous pouvez vérifier le rapport d’aspect, le 
nombre de pixels et le rapport anamorphique 
des lignes de cadre utilisateur configurées 
pour les lignes configurées par l’utilisateur 
ou le rapport d’aspect fixe à l’aide de Aspect 
Ratio(Pixels) (page 84).

[Remarques]
 • Le réglage User Frame Line 2 > Preset Aspect Ratio 

Type est défini sur Line (fixe).
 • Le rapport anamorphique n’est pas affiché pour les 

réglages de taille d’image effective (Imager Mode) 
pour lesquels le rapport anamorphique ne peut pas 
être configuré.

Opérations du bouton assignable

Vous pouvez afficher/masquer User Frame 
Line 1 et User Frame Line 2 configurés pour 
Line A en assignant Line A: User Frame Disp. à 
un des boutons assignables 1 à 4, des boutons 
assignables A à C du viseur, et des touches 
ITEM 1 à 5 (page 48).
Chaque fois que le bouton assignable est 
enfoncé, l’affichage commute entre affichage 
User Frame Line 1 et 2 � affichage User Frame 
Line 1 � affichage User Frame Line 2 � User 
Frame Line 1 et 2 masqués.
De même, vous pouvez afficher/masquer User 
Frame Line 1 et User Frame Line 2 configurés 
pour Line B en assignant Line B: User Frame 
Disp. à un des boutons assignables ou une 
touche.
Vous pouvez également afficher/masquer 
Aspect Ratio configuré pour Line A ou Line 
B en assignant Line A: Aspect Ratio Disp. ou 
Line B: Aspect Ratio Disp. à un des boutons 
assignables 1 à 4, des boutons assignables A à 
C du viseur, et des touches ITEM 1 à 5. Chaque 
fois que le bouton assignable est enfoncé, 
l’affichage commute entre l’affichage Aspect 
Ratio et Aspect Ratio masqué.

Enregistrement dans la mémoire 
cache des images

L’appareil conserve toujours un cache des 
données vidéo et audio dans la mémoire 
pendant la prise de vue, ce qui vous permet 
d’enregistrer plusieurs secondes de prise de 
vue avant le début de l’enregistrement.
Lorsque vous lancez l’enregistrement quand 
Project > Special Recording > Cache Rec Select 
(page 75) est réglé sur On dans le menu 
complet, une vidéo de la durée définie dans 
Project > Special Recording > Max Cache 
Rec Duration (page 75) est enregistrée de 
manière rétroactive.
Vous pouvez également activer/désactiver 
l’enregistrement de cache d’image à l’aide 
d’un bouton assignable auquel la fonction 
Picture Cache Rec a été affectée.

[Remarques]
 • Des restrictions peuvent s’appliquer au réglage Max 

Cache Rec Duration en fonction de la fréquence 
d’images du projet, du format d’enregistrement et 
du support d’enregistrement. Pour en savoir plus, 
consultez page 75.

 • Le fait de changer les réglages du système, tels que 
le format d’enregistrement, efface toutes les images 
stockées dans la mémoire. Les images filmées juste 
avant le changement des réglages ne peuvent donc 
pas être enregistrées, si l’enregistrement débute 
immédiatement après le changement des réglages. 
Le mode de cache d’image est automatiquement 
libéré.

 • Les réglages de cache d’image ne peuvent pas être 
modifiés pendant l’enregistrement.

Revue instantanée (Rec Review)

Vous pouvez revoir le dernier plan enregistré à 
l’écran en assignant la fonction Rec Review à 
un des boutons assignables 1 à 4 (page 48).
Lorsque vous arrêtez l’enregistrement et 
appuyez sur le bouton auquel Rec Review est 
assignée, le plan est lu à vitesse normale à 
partir de la première image.
Le plan est lu jusqu’à la fin, puis Rec Review 
prend fin et l’appareil revient en mode STBY 
(veille d’enregistrement).
Si le bouton HOME est enfoncé du côté 
opérateur ou du côté assistant pendant la 
lecture, la lecture s’arrête et l’appareil passe en 
mode de prise de vue.

Zoom to Fit

Lors de la prise de vue et de l’enregistrement 
d’une scène qui est plus large que la taille 
d’image réelle souhaitée, vous pouvez 
agrandir l’image enregistrée à la taille d’image 
souhaitée sur l’écran du viseur ou l’écran du 
moniteur.
Configurez à l’aide du réglage Project > Basic 
Setting > Zoom to Fit (page 75) dans le 
menu complet.

[Remarque]
Pendant la lecture, la fonction Zoom to Fit est 
désactivée.
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Fonction Loupe de mise au point 
haute définition

Vous pouvez agrandir l’affichage de l’écran du 
viseur ou de la sortie Monitor.
En appuyant sur le bouton FOCUS MAG du 
viseur (DVF-EL200, DVF-L700) fixé à l’appareil, 
ou en appuyant sur un bouton assignable 
attribué avec la fonction VF Focus Magnifier, 
vous pouvez agrandir la partie centrale de 
l’écran du viseur, ce qui facilite le réglage de 
la mise au point. En appuyant sur un bouton 
assignable attribué avec la fonction Monitor 
Focus Magnifier, vous pouvez agrandir la 
partie centrale de l’image de sortie Monitor, ce 
qui facilite le réglage de la mise au point.
L’affichage agrandi n’affecte pas l’image 
enregistrée ou les autres signaux de sortie, 
autres que la sortie Monitor.
L’agrandissement normal de la mise au point 
réduit la résolution, car il agrandit simplement 
une partie de l’image affichée. Mais la double 
mise au point (×2) effectuée par l’appareil 
permet de procéder à l’agrandissement de la 
mise au point tout en conservant la résolution 
d’affichage, en découpant la portion à 
agrandir sur l’image 4K, au lieu de l’image 
enregistrée ou d’autres signaux de sortie, 
autres que la sortie Monitor.
La sélection du quadruple agrandissement 
(×4) de la mise au point est également pris en 
charge en utilisant la fonction de découpage 
de l’image 4K.
Les fonctions d’agrandissement de la mise au 
point suivantes peuvent être affectées à un 
bouton assignable (page 48).
Fonction d’agrandissement de la mise au 

point du viseur : VF Focus Magnifier
Fonction d’agrandissement de la mise au 

point de la sortie Monitor : Monitor Focus 
Magnifier

La séquence d’agrandissement du bouton 
FOCUS MAG et des boutons assignables 
attribués avec une fonction d’agrandissement 
de la mise au point est réglée à l’aide des 
éléments suivants.
Écran du viseur : Monitoring > VF Display > VF 

Magnifier Ratio (page 80) dans le menu 
complet

Sortie Monitor : Monitoring > Output Display > 
Monitor Magnifier Ratio (page 79) dans 
le menu complet

Lorsque VF Magnifier Ratio est réglé sur 
×2.0/×4.0, chaque fois que vous appuyez 
sur un bouton assignable auquel VF 
Focus Magnifier est assigné, la séquence 
d’agrandissement est la suivante : ×2.0 � 
×4.0 � ×1.0 � ×2.0.
De même, lorsque Monitor Magnifier 
Ratio est réglé sur ×2.0/×4.0, la séquence 
d’agrandissement change chaque fois que 
vous appuyez sur un bouton assignable 
assigné avec Monitor Focus Magnifier.

[Remarques]
 • En mode High Frame Rate (fréquence d’images 

de prise de vue de 61 ips ou plus), la résolution de 
l’image d’affichage mise au point ×2/×4 diminue car 
l’affichage découpé d’une image 4K n’est pas pris en 
charge.

 • Lorsque Project Frame Rate est réglé sur 59.94 ou 50 
et que le réglage de sortie Monitor est 1920×1080P, 
Monitor Magnifier Ratio ne peut être réglé sur ×4.0 
ou ×2.0/×4.0. Lorsque le réglage de sortie Monitor est 
1920×1080i, Monitor Focus Magnifier ne fonctionne 
pas.

 • Monitor Focus Magnifier s’applique également à la 
sortie HDMI si la sortie HDMI a le même format de 
sortie que la sortie Monitor. Vous pouvez vérifier le 
réglage à l’aide de Monitoring > Overlays/Frame Line 
> HDMI (page 81) dans le menu complet. La sortie 
HDMI est la même que la sortie Monitor si HDMI est 
réglé sur « Same as Monitor ».

Opération des boutons assignables 
affectés aux fonctions de loupe de mise 
au point

Vous pouvez définir si un bouton assignable 
auquel est assignée une fonction de loupe de 
mise au point activera/désactivera la fonction 
chaque fois que le bouton est enfoncé ou 
activera la fonction uniquement lorsque le 
bouton est enfoncé.
Écran du viseur : Monitoring > VF Display > VF 
Magnifier Mode (page 80) dans le menu 
complet
Sortie Monitor : Monitoring > Output Display > 
Monitor Magnifier Mode (page 79) dans le 
menu complet

Indicateur de plan en surbrillance

Vous pouvez afficher les zones en surbrillance 
écrêtées en rouge sur l’image de sortie 
Monitor et sur l’image de sortie du viseur.
Appuyez sur les boutons assignables (pages 
49, 51) auxquels Monitor Highlight Clip 
Ind et VF Highlight Clip Ind sont assignés pour 
allumer/éteindre les indicateurs de plan en 
surbrillance.

[Remarque]
Les indicateurs de plan en surbrillance ne fonctionnent 
pas que lorsque Technical > Special Configuration > RM/
RCP Paint Control (page 93) est réglé sur On dans le 
menu complet.

High Key / Low Key

Vous pouvez vérifier la présence de hautes 
lumières accentuées et d’ombres bloquées 
sur l’image de sortie Monitor et sur l’image de 

sortie du viseur.
Activez High Key pour différencier les zones 
à luminance élevée, pour qu’elles soient plus 
faciles à voir, afin de vérifier la présence de 
hautes lumières accentuées.
Activez Low Key pour différencier les zones 
à faible luminance, pour qu’elles soient plus 
faciles à voir, afin de vérifier la présence 
d’ombres bloquées.
Appuyez sur les boutons assignables 1 à 4 
(page 51) auxquels Monitor High/Low 
Key et VF High/Low Key sont assignés pour 
commuter les réglages High Key et Low Key.

[Remarque]
High/Low Key ne fonctionne pas que lorsque Technical 
> Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Affichage de fausse couleur

Vous pouvez afficher une fausse couleur 
dans le viseur en appuyant sur le bouton B/
False Color (DVF-EL200) ou le bouton SPARE 
(DVF-L700) sur le viseur fixé à l’appareil.
Vous pouvez également afficher une fausse 
couleur sur la sortie du moniteur.

Couleur 
d’affichage

Niveau de signal

S-Log3 (par 
défaut)

S-Log2 (valeur de 
référence du 
PMW-F55)

Rouge 93,4% à 96,1% 105,5% à 109,5%

Jaune 91,3% à 93,4% 102,5% à 105,5%

Orange 87,7% à 90,6% 97,4% à 101,5%

Rose 54,3% à 58,0% 50,2% à 55,2%

Rose clair 47,8% à 50,8% 
(18% gris + 1 
palier)

41,5% à 45,4% 
(18% gris + 1 
palier)

Cyan 43,8% à 46,5% 36,3% à 39,6%

Vert 38,9% à 42,2% 
(18% gris)

30,4% à 34,4% 
(18% gris)
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Couleur 
d’affichage

Niveau de signal

S-Log3 (par 
défaut)

S-Log2 (valeur de 
référence du 
PMW-F55)

Bleu clair 24,6% à 34,4% 15,5% à 25,2%

Bleu 3,5% à 5,6% 3,0% à 4,0%

Violet –7,3% à 3,5% –7,3% à 3,0%

 • Vous pouvez choisir d’utiliser le réglage 
d’activation/de désactivation prédéfini et 
le seuil de chaque fausse couleur dans le 
viseur et la sortie du moniteur, ou de régler 
les couleurs manuellement en utilisant 
Technical > False Color (page 92).

 • Vous pouvez activer/désactiver l’affichage 
de la fonction de fausse couleur sur 
un viseur en appuyant sur un bouton 
assignable auquel VF False Color est 
assigné.

 • Vous pouvez activer/désactiver l’affichage 
de la fonction de fausse couleur sur un 
moniteur en appuyant sur un bouton 
assignable auquel Monitor False Color est 
assigné.

[Remarque]
La fonction de fausse couleur ne fonctionne pas lorsque 
Technical > Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu complet.

Fonction de balayage à double 
vitesse du viseur

Si la fréquence d’images du projet est de 
23.98P, 24P, 25P ou de 29.97P, l’image peut 
devenir floue et difficile à voir en raison de la 
fréquence d’image faible pendant la capture 
d’image lorsque vous balancez l’appareil vers 
la droite et la gauche.
Dans ce cas, vous pouvez réduire le flou et voir 
plus facilement l’image en activant la fonction 
de balayage à double vitesse du viseur.

Pour activer la fonction, réglez Monitoring > 
VF Function > Double Speed Scan (page 80) 
dans le menu complet sur On.

[Remarques]
 • Lorsque cette fonction est activée, l’angle d’obturation 

de la fonction de l’obturateur électronique est limité à 
180 degrés ou moins.

 • Cette fonction est réglée sur Off pendant la prise de 
vue à vitesse variable.

 • Cette fonction est activée pour les combinaisons 
suivantes de taille d’image et de fréquence d’images 
du projet.

 MPC-3628 :
 5.8K 6:5 (23.98p, 24p)
 5.8K 17:9 (23.98p, 24p, 25p, 29.97p)
 5.4K 16:9 (23.98p, 24p, 25p, 29.97p)
 MPC-3626 :
 4K 4:3 (23.98p, 24p)
 4K 17:9 (23.98p, 24p, 25p, 29.97p)
 4K 17:9 Surround View (23.98p, 24p)
 4K 2.39:1 (23.98p, 24p, 25p, 29.97p)
 3.8K 16:9 (23.98p, 24p, 25p, 29.97p)
 3.8K 16:9 Surround View (23.98p, 24p)

User 3D LUT

Vous pouvez charger un fichier CUBE (*.cube) 
pour un 3D LUT à 17 points, 33 points ou 
65 points créé avec RAW Viewer ou DaVinci 
Resolve (de Blackmagic Design Pty. Ltd.) 
(page 41).
Vous pouvez également charger un fichier 
User 3D LUT dans l’appareil via un réseau 
(page 106).
Réglez Input Color Space pour que l’espace 
de couleurs d’entrée corresponde à celui du 
moment où le fichier CUBE a été créé.
Si le fichier a été créé avec S-Gamut3.Cine/
SLog3, réglez la catégorie Project > Basic 
Setting > Input Color Space (page 74) dans 
le menu sur S-Gamut3.Cine/SLog3.
Enregistrez le fichier User 3D LUT dans le 
répertoire suivant sur la carte SD.
PRIVATE\SONY\PRO\LUT\

[Remarque]
Les données d’un cube de 65 points sont réduites à un 
cube de 33 points, puis chargées.

ART

Vous pouvez importer des fichiers ART 
(Advanced Rendering Transform) (*.art) créés 
à l’aide de RAW Viewer dans le caméscope 
(page 41).
Vous pouvez également charger un fichier ART 
dans l’appareil via un réseau (page 107).
Un fichier ART est un fichier Look propriétaire 
de Sony créé dans un format binaire. 
L’utilisation d’un fichier ART permet d’obtenir 
une sortie moniteur de meilleure qualité que 
l’importation d’un 3D LUT utilisateur dans 
l’appareil.
Enregistrez le fichier ART créé pour l’appareil 
dans le répertoire suivant sur la carte SD.
MPC-3628 : 

PRIVATE\SONY\PRO\CAMERA\MPC3628
MPC-3626 : 

PRIVATE\SONY\PRO\CAMERA\MPC3626

[Remarque]
Les fichiers ART du MPC-3610 ne sont pas compatibles.

ASC CDL

Vous pouvez importer dans l’appareil des 
fichiers ASC CDL (The American Society of 
Cinematographers Color Decision List) (*.cdl) 
créés par des outils externes (page 42).
Vous pouvez également charger un fichier ASC 
CDL dans l’appareil via un réseau (page 107).
Cela vous permet de filmer avec les 
paramètres ASC CDL appliqués au Look.
Enregistrez le fichier ASC CDL dans le 
répertoire suivant sur la carte SD.

PRIVATE\SONY\PRO\CDL\
Vous pouvez également modifier les 
paramètres ASC CDL via un navigateur Web et 
les contrôler à l’aide de Livegrade de Pomfort.
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Données de configuration utilisateur
Vous pouvez sauvegarder/charger les 
réglages du menu complet dans la mémoire 
interne et sur des cartes SD. Cela vous permet 
de rappeler rapidement un ensemble de 
réglages de menu approprié à la situation 
actuelle.
Pour sauvegarder les données de 
configuration sur une carte SD, insérez une 
carte SD inscriptible (page 34) dans le 
logement pour carte SD (page 13) avant de 
lancer la procédure.
Pour en savoir plus sur les réglages 
sauvegardés dans chaque fichier, consultez 
« Éléments enregistrés dans les fichiers » 
(page 142).

Fichiers All

Les fichiers de configuration All sont utilisés 
pour sauvegarder/charger les données de 
configuration de tous les menus.
Vous pouvez sauvegarder jusqu’à 64 fichiers 
sur une carte SD.

[Remarque]
Les données spécifiques à un dispositif (nuançage, 
niveaux de sortie et autres données nécessitant un 
ajustement pour le dispositif spécifique) ne sont pas 
sauvegardées.

Fichiers Scene

Les fichiers de scène sont utilisés pour 
sauvegarder/charger les ajustements des 
éléments de peinture pour la prise de vue 
d’une scène particulière. Vous pouvez 
sauvegarder jusqu’à cinq fichiers dans la 
mémoire interne et jusqu’à 64 fichiers sur une 
carte SD.
Les réglages peuvent être sauvegardés 
ou chargés lorsque Technical > Special 
Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet.
Les fichiers de scène vous permettent de 
sauvegarder les types de données suivants.
 • Valeurs réglées dans le menu Paint
 • Réglages Shutter, ND filter, Gain, Base ISO, 

Input Color Space et NR
 • Données de balance des blancs

Fichiers User Gamma

Vous pouvez sauvegarder jusqu’à cinq fichiers 
gamma d’utilisateur définis par l’utilisateur 
dans la mémoire interne.
Ils peuvent être sauvegardés lorsque Technical 
> Special Configuration > RM/RCP Paint 
Control (page 93) est réglé sur On dans le 
menu complet.
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Fichiers All

Sauvegarde de données de 
configuration en tant que fichier 
All

1 Sélectionnez Project > All File(Cam Setup) 
> Save SD Card (page 76) dans le menu 
complet.
Un écran pour la sélection de la 
destination de sauvegarde du fichier All 
apparaît.

2 Sélectionnez une destination de 
sauvegarde en tournant la molette MENU, 
puis appuyez sur la molette MENU.
Vous pouvez sauvegarder des fichiers sur 
plusieurs rangées avec File ID défini sur 
« No File ».
Si vous sélectionnez une rangée spécifiant 
un nom File ID, le fichier sélectionné sera 
écrasé.
File ID est généré automatiquement, mais 
vous pouvez le modifier.

3 Sélectionnez Run sur l’écran de 
confirmation en tournant la molette 
MENU, puis appuyez sur la molette MENU.

Si un message d’erreur apparaît

L’un des messages d’erreur suivants peut 
apparaître pendant ou après l’opération. Dans 
ce cas, le fichier n’est pas sauvegardé.

Message 
d’erreur

Problème Solution

File Access 
NG

Aucune carte SD 
enregistrable 
n’est insérée.

Insérez une 
carte SD 
enregistrable.

Changement du nom File ID

1 Sélectionnez Project > All File(Cam Setup) 
> File ID (page 76) dans le menu 
complet.
Un écran pour modifier le nom File ID 
apparaît.

2 Sélectionnez les caractères et saisissez le 
nom File ID.

3 Sélectionnez Done en tournant la molette 
MENU, puis appuyez sur la molette MENU.
Le nom File ID est mis à jour.

Chargement de données de 
configuration

1 Sélectionnez Project > All File(Cam Setup) 
> Load SD Card (page 76) dans le menu 
complet.
Un écran avec la liste des fichiers All 
apparaît.

2 Sélectionnez le fichier en tournant la 
molette MENU, puis appuyez sur la 
molette MENU.
Un écran de confirmation apparaît.

3 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

[Remarques]
 • Lorsque vous chargez un fichier depuis une carte SD, 

les données sauvegardées dans la mémoire interne 
sont écrasées.

 • Ne rappelez pas un fichier sur un dispositif plus 
ancien que le dispositif sur lequel le fichier a 
été sauvegardé. Cela pourrait provoquer un 
dysfonctionnement.

 • L’appareil redémarrera automatiquement après avoir 
chargé les données de configuration.

 • Le MPC-3628 ne peut pas charger de fichier All du 
MPC-3626. De même, le MPC-3626 ne peut pas 
charger de fichier All du MPC-3628.

Si un fichier ne peut pas être chargé

L’un des messages d’erreur suivants peut 
apparaître pendant ou après l’opération. Dans 
ce cas, le fichier n’est pas chargé.

Message 
d’erreur

Problème Solution

File Access 
NG

 • Le chargement 
du fichier s’est 
terminé de 
façon 
anormale

 • Les données 
du fichier 
correspondant 
sur la carte SD 
sont 
corrompues

 • Essayez à 
nouveau de 
charger

 • Insérez à 
nouveau la 
carte SD

 • Sauvegardez 
un fichier 
valide sur la 
carte SD

[Remarque]
Un fichier enregistré par un appareil avec un logiciel 
optionnel installé ne peut pas être chargé sans que le 
logiciel optionnel correspondant ne soit installé.

Restauration de tous les réglages 
actuels sur les valeurs par défaut

1 Sélectionnez Maintenance > Reset to 
Default (page 94) dans le menu 
complet.
Un écran de confirmation apparaît.

2 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

[Remarque]
L’appareil redémarrera automatiquement après 
l’exécution.
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Fichiers Scene

Sauvegarde d’un fichier de scène 
dans la mémoire interne

1 Sélectionnez Project > Scene File > Store 
Internal Memory (page 76) dans le 
menu complet.
Un écran avec la liste des fichiers de scène 
apparaît.
Si File ID est réglé sur la destination 
« Standard », les réglages préconfigurés 
standard sont sauvegardés.

2 Sélectionnez une destination de 
sauvegarde en tournant la molette MENU, 
puis appuyez sur la molette MENU.
Le fichier de scène est sauvegardé, et 
écrase tout fichier existant, dans le fichier 
de destination sélectionné.

3 Sélectionnez Run sur l’écran de 
confirmation en tournant la molette 
MENU, puis appuyez sur la molette MENU.

Sauvegarde d’un fichier de scène 
sur une carte SD

1 Sélectionnez Project > Scene File > Save 
SD Card (page 76) dans le menu 
complet.
Un écran pour la sélection de la 
destination de sauvegarde du fichier de 
scène apparaît.

2 Sélectionnez une destination de 
sauvegarde en tournant la molette MENU, 
puis appuyez sur la molette MENU.
Vous pouvez sauvegarder des fichiers sur 

plusieurs rangées avec File ID défini sur 
« No File ».
Si vous sélectionnez une rangée spécifiant 
un nom File ID, le fichier sélectionné sera 
écrasé.
File ID est généré automatiquement, mais 
vous pouvez le modifier.

3 Sélectionnez Run sur l’écran de 
confirmation en tournant la molette 
MENU, puis appuyez sur la molette MENU.

Changement du nom File ID

1 Sélectionnez Project > Scene File > File ID 
(page 76) dans le menu complet.
Un écran pour modifier le nom File ID 
apparaît.

2 Sélectionnez les caractères et saisissez le 
nom File ID.

3 Sélectionnez Done en tournant la molette 
MENU, puis appuyez sur la molette MENU.
Le nom File ID est mis à jour.

Chargement d’un fichier de scène 
depuis la mémoire interne

1 Sélectionnez Project > Scene File > Recall 
Internal Memory (page 76) dans le 
menu complet.
Un écran avec la liste des fichiers de scène 
apparaît.

2 Sélectionnez le fichier en tournant la 
molette MENU, puis appuyez sur la 
molette MENU.
Un écran de confirmation apparaît.

3 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

[Remarque]
Le MPC-3628 ne peut pas charger de fichier scène du 
MPC-3626. De même, le MPC-3626 ne peut pas charger 
de fichier scène du MPC-3628.

Chargement d’un fichier de scène 
depuis une carte SD

1 Sélectionnez Project > Scene File > Load 
SD Card (page 76) dans le menu 
complet.
Un écran avec la liste des fichiers de scène 
apparaît.

2 Sélectionnez le fichier en tournant la 
molette MENU, puis appuyez sur la 
molette MENU.
Un écran de confirmation apparaît.

3 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.

[Remarque]
Le MPC-3628 ne peut pas charger de fichier scène du 
MPC-3626. De même, le MPC-3626 ne peut pas charger 
de fichier scène du MPC-3628.
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Fichiers User Gamma

Utilisation des fichiers User 
Gamma créés avec RAW Viewer 
V4.0 ou version ultérieure

Vous pouvez utiliser des fichiers User Gamma 
créés avec RAW Viewer V4.0 ou version 
ultérieure.
Enregistrez les fichiers crées dans le répertoire 
suivant sur la carte SD.
MPC-3628 : 

PRIVATE\SONY\PRO\CAMERA\MPC3628
MPC-3626 : 

PRIVATE\SONY\PRO\CAMERA\MPC3626
Pour plus de détails sur RAW Viewer V4.0 ou 
version ultérieure, contactez votre revendeur 
Sony ou un représentant du service après-
vente Sony.

Pour effectuer des opérations de chargement, 
de vérification, de réinitialisation ou d’autres 
opérations sur les fichiers gamma utilisateur, 
réglez Technical > Special Configuration > RM/
RCP Paint Control (page 93) sur On dans le 
menu complet pour activer les fonctions de 
peinture.

Chargement d’un fichier User 
Gamma depuis une carte SD

1 Sélectionnez Project > User Gamma > 
Load SD Card (page 77) dans le menu 
complet.
Un écran avec la liste des fichiers gamma 
d’utilisateur apparaît.
Vous pouvez sélectionner jusqu’à cinq 
fichiers sur l’écran avec la liste des fichiers 
gamma d’utilisateur.

 [Remarque]
Les cinq opérations de chargement sont effectuées 
ensemble. Les fichiers ne peuvent pas être 
sélectionnés et chargés individuellement.

2 Appuyez sur la molette MENU.
Un écran de confirmation apparaît.

3 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.
Les cinq fichiers sont chargés dans la 
mémoire interne.

Vérification des fichiers User 
Gamma actuellement stockés 
dans la mémoire interne

Sélectionnez Project > User Gamma > Current 
Settings (page 77) dans le menu complet 
pour afficher une liste de fichiers gamma 
d’utilisateur actuellement stockés dans la 
mémoire interne.

[Remarque]
Avant de charger des fichiers gamma d’utilisateur 
depuis une carte SD, « 709(800%) » s’affiche sous 
« Name » lorsque Project > Basic Setting > Input Color 
Space (page 74) est réglé sur Rec.709/User Gamma 
dans le menu complet. « HLG(Natural) » s’affiche pour les 
réglages autres que Rec.709/User Gamma.

Réglage des fichiers User Gamma 
stockés dans la mémoire interne

1 Réglez Project > Basic Setting > Input 
Color Space (page 74) sur Rec.2020/
User Gamma ou Rec.709/User Gamma 
dans le menu complet.

 [Remarque]
Rec.2020/User Gamma et Rec.709/User Gamma 
ne peut être sélectionné que lorsque Technical 
> Special Configuration > RM/RCP Paint Control 
(page 93) est réglé sur On dans le menu 
complet.

2 Sélectionnez un des réglages User 1 à 
User 5 dans Paint > Gamma > Gamma 
Select (page 87) dans le menu complet.

 [Remarque]
Les options User 1 à User 5 dans Gamma Select 
correspondent aux numéros 1 à 5 sur l’écran avec la 
liste des fichiers gamma d’utilisateur.

Réinitialisation des fichiers User 
Gamma stockés dans la mémoire 
interne à l’état d’usine par défaut

1 Sélectionnez Project > User Gamma > 
Reset (page 77) dans le menu complet.
Un écran de réinitialisation du nombre de 
fichiers Gamma apparaît.

2 Tournez la molette MENU pour 
sélectionner le nombre de fichiers Gamma 
à réinitialiser (1 à 5).
Pour réinitialiser tous les fichiers Gamma, 
sélectionnez All.
Un écran de confirmation apparaît.
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3 Sélectionnez Run en tournant la molette 
MENU, puis appuyez sur la molette MENU.
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Connexion d’une unité de télécommande
Lorsqu’une unité de télécommande RM-
B170, un panneau de télécommande RCP-
1001/1501/3100/3501 ou une autre unité de 
commande est raccordée, certaines fonctions 
peuvent être contrôlées depuis cet appareil.

Connexion d’une unité de 
télécommande

Connectez le connecteur de caméra de l’unité 
de commande au connecteur REMOTE (8 
broches) de l’appareil à l’aide d’un câble de 
télécommande.
Lorsque vous mettez sous tension l’appareil 
après le raccordement, l’appareil entre en 
mode télécommande, activant des opérations 
sur les menus et les prises de vue.

[Remarques]
 • Ne connectez pas et ne déconnectez pas l’unité de 

télécommande quand l’appareil est sous tension.
 • Aucun câble de télécommande n’est fourni 

avec le panneau de télécommande RCP-
1001/1501/3100/3501.

Quitter le mode télécommande

Mettez l’appareil hors tension et déconnectez 
l’unité de télécommande.

Réglage de la fonction Paint

Technical > Special Configuration > RM/RCP 
Paint Control (page 93) doit être réglé sur 
On dans le menu complet pour activer la 
fonction Paint.
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Fonctions majeures prises en charge par la RCP-1001/1501/3100/3501 ou la RM-B170/B750

Légende du tableau
Les indications suivantes établissent la prise en charge de la télécommande sur l’écran.
Oui : commande prise en charge
– : commande non prise en charge

Élément Sous-élément Sous-élément Options de sélection RCP-1001 RCP-1501/3501 RCP-3100 RM-B170 RM-B750

Shooting FPS Fixed/Variable Select On/Off – Oui – Oui 1) Oui

FPS Select 1FPS à 120FPS – Oui – Oui 1) Oui

Shutter Select 2) Shutter ON/OFF On/Off – Oui Oui Oui Oui

ECS ON/OFF On/Off – Oui Oui Oui Oui

Shutter Speed Valeurs enregistrées pour Step.
Les valeurs suivantes peuvent être 
affichées.
1/32
1/33
1/48
1/50
1/60
1/96
1/100
1/120
1/125
1/250
1/500
1/1000
1/2000
1/3000
1/4000
1/5000

– Oui Oui Oui Oui

ECS Frequency – – Oui Oui Oui Oui

ND ND Position 1 : (CLEAR)
2 : (0.3 densité)
3 : (0.6 densité)
4 : (0.9 densité)
5 : (1.2 densité)
6 : (1.5 densité)
7 : (1.8 densité)
8 : (2.1 densité)
9 : (2.4 densité)

Oui Oui Oui Oui Oui
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Élément Sous-élément Sous-élément Options de sélection RCP-1001 RCP-1501/3501 RCP-3100 RM-B170 RM-B750

Gain 2) Gain(Step) –6dB/–3dB/0dB/3dB/6dB/9dB/ 
12dB/15dB/18dB

Oui Oui Oui 1) Oui Oui

White Balance 2) Color Temp 2000K à 15000K 3) – Oui Oui 1) – Oui

Color Temp Balance (équivalent 
à Tint)

–99 à ±0 à +99 4) – Oui Oui 1) – Oui

R Gain –99 à ±0 à +99 Oui Oui – Oui Oui

B Gain –99 à ±0 à +99 Oui Oui – Oui Oui

Auto White Balance – Oui Oui Oui Oui Oui

Project Scene File 2) 5) – – – Oui Oui – Oui

Standard File 6) – – Oui Oui – – Oui

Paint 2) Switch Status Gamma On/Off – Oui Oui 1) Oui 1) Oui

Black Gamma 7) On/Off – Oui Oui 1) Oui 1) Oui

Matrix On/Off – Oui Oui 1) – Oui

Knee 7) On/Off – Oui Oui 1) Oui 1) Oui

White Clip 7) On/Off – Oui Oui 1) – Oui

Detail On/Off – Oui Oui 1) – Oui

Flare On/Off – Oui Oui Oui 1) Oui

Test Saw 8) On/Off – Oui Oui Oui 1) Oui

Black Master Black –99 à ±0 à +99 Oui Oui Oui Oui Oui

R Black –99 à ±0 à +99 Oui Oui Oui Oui Oui

B Black –99 à ±0 à +99 Oui Oui Oui Oui Oui

Flare Setting On/Off – Oui Oui Oui 1) Oui

Master Flare –99 à ±0 à +99 – Oui Oui Oui 1) –

R Flare –99 à ±0 à +99 – Oui Oui – Oui

G Flare –99 à ±0 à +99 – Oui Oui – Oui

B Flare –99 à ±0 à +99 – Oui Oui – Oui

Gamma Setting On/Off – Oui Oui 1) Oui 1) Oui

Gamma Category  
(affichage uniquement) 9)

User – Oui – – Oui

Gamma Select User 1/User 2/User 3/User 4/User 5 – Oui – – Oui

Black Gamma 7) Setting On/Off – Oui Oui 1) Oui 1) Oui

Range Low/L.Mid/H.Mid – Oui – – Oui

Master Black Gamma –99 à ±0 à +99 – Oui Oui 1) Oui 1) Oui

Knee 7) 10) Setting On/Off Oui Oui Oui 1) Oui Oui

Point –99 à ±0 à +99 Oui Oui Oui 1) Oui Oui

Slope –99 à ±0 à +99 Oui Oui Oui 1) – Oui
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Élément Sous-élément Sous-élément Options de sélection RCP-1001 RCP-1501/3501 RCP-3100 RM-B170 RM-B750

White Clip 7) Setting On/Off – Oui Oui 1) – Oui

Level –99 à ±0 à +99 – Oui – – Oui

Detail Setting On/Off – Oui Oui 1) – Oui

Level –99 à ±0 à +99 – Oui Oui 1) – Oui

H/V Ratio –99 à ±0 à +99 – Oui – – Oui

Crispening –99 à ±0 à +99 – Oui – – Oui

Level Depend On/Off – Oui – – Oui

Level Depend Level –99 à ±0 à +99 – Oui – – Oui

Frequency –99 à ±0 à +99 – Oui – – Oui

Knee Aperture On/Off – Oui – – Oui

Knee Aperture Level –99 à ±0 à +99 – Oui – – Oui

Limit –99 à ±0 à +99 – Oui – – Oui

White Limit –99 à ±0 à +99 – Oui – – Oui

Black Limit –99 à ±0 à +99 – Oui – – Oui

Matrix Setting On/Off – Oui Oui 1) – Oui

User Matrix On/Off – Oui – – Oui

User Matrix R-G –99 à ±0 à +99 – Oui – – Oui

User Matrix R-B –99 à ±0 à +99 – Oui – – Oui

User Matrix G-R –99 à ±0 à +99 – Oui – – Oui

User Matrix G-B –99 à ±0 à +99 – Oui – – Oui

User Matrix B-R –99 à ±0 à +99 – Oui – – Oui

User Matrix B-G –99 à ±0 à +99 – Oui – – Oui

Multi Matrix Setting On/Off – Oui – – Oui

Area Indication On/Off – Oui – – Oui

Reset Run/Cancel – Oui – – Oui

Axis B/B+/MG–/MG/MG+/R/R+/YL–/YL/
YL+/G–/G/G+/CY/CY+/B–

– Oui – – Oui

Hue –99 à ±0 à +99 – Oui – – Oui

Saturation –99 à ±0 à +99 – Oui – – Oui

Technical Test Signals Color Bars On/Off On/Off Oui Oui Oui Oui Oui

Test Saw 8) On/Off – Oui Oui Oui 1) Oui

Rec – – – – – – Oui Oui

Play – – – – – – Oui Oui

Stop – – – – – – Oui Oui

F.Rev – – – – – – Oui Oui

F.Fwd – – – – – – Oui Oui

Rec Review – – – – – – Oui Oui

Next – – – – – – Oui –
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Élément Sous-élément Sous-élément Options de sélection RCP-1001 RCP-1501/3501 RCP-3100 RM-B170 RM-B750

Prev. – – – – – – Oui –

White Mode 2) Preset ON/OFF – On/Off – – – Oui Oui

Iris Iris Level – (Plage de contrôle de l’objectif cible) Oui Oui Oui Oui Oui

Close – On/Off Oui Oui Oui – Oui

Zoom 11) Remote – On/Off – Oui 1) Oui 1) Oui 1) –

Speed – – – – – – –

Tele to Wide – – – Oui 1) Oui 1) Oui 1) –

Zoom Value[%] – – – Oui 1) Oui 1) Oui 1) –

Focal Length[mm] – – – Oui 1) Oui 1) Oui 1) –

Focus 11) Remote – On/Off – Oui 1) Oui 1) Oui 1) –

Focus Position – – – Oui 1) Oui 1) Oui 1) –

Focus Value[%] – – – Oui 1) Oui 1) Oui 1) –

Focus Length[m] – – – Oui 1) Oui 1) Oui 1) –

Call – – – Oui Oui Oui Oui Oui

1) Peut être contrôlé lorsqu’il est assigné au bloc d’opération du contrôleur.
2) Ne peut être contrôlé que lorsque Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu complet.
3) Comme Color Temp est écrêté à 2000K et 15000K pendant l’opération R/B Gain, il n’est pas possible d’afficher la valeur correcte de Color Temp pour la valeur R/B Gain.
4) Comme Color Temp Balance est écrêtée à ±99, il n’est pas possible d’afficher la valeur correcte de Color Temp Balance pour la valeur R/B Gain.
5) Les fichiers de scène 1 à 5 ne peuvent être sélectionnés ou désélectionnés qu’après avoir été chargés dans l’appareil.
6) Permet de restaurer les réglages de l’appareil à l’état standard depuis le contrôleur sans aucun fichier de scène chargé.
7) Configurable uniquement lorsque Project > Basic Setting > Input Color Space (page 74) est réglé sur HLG(Natural), HLG(Live), Rec.2020/User Gamma ou Rec.709/User Gamma dans le menu complet.
8) Le signal de test ne peut pas être activé/désactivé pendant l’exécution de la balance des blancs automatique.
9) Peut ne pas être affiché selon le modèle et la version du contrôleur.
10) La fonction Knee normale de l’appareil contrôle l’équivalent le Knee à luminance élevée de HDR Knee.
11) Les instructions d’entraînement de zoom et de mise au point depuis une unité de télécommande sont désactivées lorsqu’un objectif à monture E est installé.
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Raccordement de moniteurs externes et de périphériques d’enregistrement
Pour afficher l’image d’enregistrement/de 
lecture sur un moniteur externe, sélectionnez 
le signal de sortie et utilisez un câble correct 
pour le raccordement du moniteur.
Le signal de sortie de l’appareil peut être 
enregistré en connectant un périphérique 
d’enregistrement, tel qu’un magnétoscope.
Des informations d’état et des menus 
identiques à ceux affichés dans l’écran du 
viseur peuvent être affichés sur le moniteur 
externe. Réglez le contenu à afficher en 
fonction du signal de sortie du moniteur, à 
l’aide du menu Monitoring (page 79).

[Remarque]
Lorsque FPS est réglé sur Variable, un décalage 
horizontal de l’image peut se produire avec une sortie 
4K uniquement. Ce phénomène peut être perceptible 
pour des fréquences d’images plus rapides (FPS). 
Cependant, cela n’affecte pas l’image enregistrée et 
l’image en lecture s’affiche correctement.

Connecteur SDI OUT (type BNC)

Réglez le format de sortie à l’aide du menu 
Monitoring (page 79).
Utilisez un câble coaxial de 75 ohms du 
commerce pour le raccordement.

[Remarque]
Vérifiez que le raccordement à la terre entre l’appareil et 
le périphérique externe est correctement effectué avant 
de mettre sous tension. (Nous recommandons de mettre 
sous tension l’appareil et le périphérique externe après 
le branchement d’un câble coaxial de 75 ohms.)
Si l’appareil est sous tension, procédez au raccordement 
à l’appareil après avoir branché un câble coaxial de 75 
ohms au périphérique externe.

Pour commencer l’enregistrement 
synchronisé sur un périphérique externe

Lorsque la sortie de signal SDI est 
sélectionnée, vous pouvez procéder à 
l’enregistrement synchronisé en envoyant 
un signal de déclenchement REC à un 

périphérique d’enregistrement externe 
raccordé au connecteur SDI OUT. Activez 
l’enregistrement synchronisé en réglant 
Technical > System Configuration > SDI Rec 
Remote Trigger (page 89) dans le menu sur 
HD SDI Remote I/F ou Parallel Rec.

[Remarques]
 • Si un périphérique externe raccordé ne prend pas 

en charge le signal de déclenchement REC, le 
périphérique ne peut pas être utilisé.

 • Lors de la sortie d’un signal de moniteur sur SDI 3/4, 
le signal de déclenchement REC n’est pas émis.

 • Lorsque la sortie SDI 1/2 est la suivante, le signal de 
moniteur est émis sur SDI 3/4.
 – Sortie 4K/QFHD 12G/6G
 – Sortie 4K/QFHD Dual

Connecteur MONITOR OUT (type 
BNC)

Émet un signal HD SDI.
Réglez le format de sortie à l’aide du menu 
Monitoring (page 79).
Utilisez un câble coaxial de 75 ohms du 
commerce pour le raccordement.

[Remarque]
L’audio et le code temporel ne sont pas superposés sur 
cette sortie.

Connecteur HDMI OUT (connecteur 
de type A)

Réglez le format de sortie à l’aide du menu 
Monitoring (page 79).
Utilisez un câble HDMI du commerce pour le 
raccordement.
Si le format de sortie possède la même 
résolution que le signal du connecteur 
MONITOR OUT, le même signal vidéo est émis.

Connecteur 12V OUT (sortie 
12 V CC, LEMO 2 broches)

Fournit 12 V CC à un accessoire lorsque 
le commutateur d’alimentation est sur la 
position ON.

N° Signal Entrée/
Sortie

Spécifications

1 UNREG GND – GND

2 UNREG +12 V 
OUT

OUT Sortie de +11 V à 
+17 V CC
Entrée 11 V à 17 V
Tension de sortie : 
identique à la 
tension d’entrée
Courant de sortie 
maximal : 1,0 A
Entrée 22 V à 32 V
Tension de sortie : 
16,8 V
Courant de sortie 
maximal : 1,0 A

Connecteur 24V OUT (sortie 
24 V CC, Fischer 3 broches)

Fournit 24V CC à un accessoire lorsque 
le commutateur d’alimentation est sur la 
position ON. Vous pouvez entrer un signal REC 
Trigger via le connecteur 24V OUT.

N° Signal Spécifications

1 GND

2 24V-OUT Entrée 11 V à 17 V
Tension de sortie : 24 V
Courant de sortie maximal : 
1,0 A
Entrée 22 V à 32 V
Tension de sortie : identique 
à la tension d’entrée
Courant de sortie maximal : 
2,0 A

3 REC 
TRIGGER IN

Ouvert ou +5 V CC : normal
Terre (GND) : active (REC)

Connecteur AUX (type BNC)

Émet le signal de code temporel ou un 
signal d’horloge pour le réglage pendant la 
fabrication/la maintenance.
 • TC OUT
 • Factory Use

Utilisez un câble coaxial de 75 ohms du 
commerce pour le raccordement.
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Lors de la prise de vue avec plusieurs 
appareils, l’enregistrement synchronisé peut 
être réalisé en utilisant un signal de référence 
spécifique pour synchroniser le code temporel 
sur tous les appareils.

Synchronisation de la phase du 
signal vidéo (Genlock)

L’opération Genlock est activée par l’envoi 
d’un des signaux de référence suivants au 
connecteur GENLOCK IN (page 12) de 
l’appareil.
 • HDSDI 1.5G numérique (Entrelacé/PsF/

Progressif)
 • HD Y analogique (Entrelacé/Progressif)
 • SD VBS analogique

Réglez le signal d’entrée genlock à l’aide 
de TC/Media > Genlock > Input Source 
(page 78) dans le menu complet.
Vous pouvez également vérifier l’état genlock 
à l’aide de TC/Media > Genlock > Reference 
Lock Type (page 78) dans le menu complet, 
l’écran d’accueil de l’affichage auxiliaire 
(page 36), et l’indicateur d’état genlock 
(page 14).
Les signaux de référence d’entrée valides 
varient en fonction du réglage de fréquence 
d’images du projet.

Fréquence 
d’images 
du projet

Signal de référence valide

Analogique Numérique

23.98 1920×1080 47.95i 
(23.98PsF)
1920×1080 23.98P

1920×1080 
23.98PsF
1920×1080 23.98P

24 1920×1080 48i 
(24PsF)
1920×1080 24P

1920×1080 24PsF
1920×1080 24P

25 1920×1080 50i
720×576 50i
1920×1080 25P

1920×1080 50i
1920×1080 25PsF
1920×1080 25P

Fréquence 
d’images 
du projet

Signal de référence valide

Analogique Numérique

29.97 1920×1080 59.94i
720×486 59.94i
1920×1080 29.97P

1920×1080 59.94i
1920×1080 
29.97PsF
1920×1080 29.97P

47.95 1920×1080 47.95i 
(23.98PsF)

1920×1080 
23.98PsF

50 1920×1080 50i
720×576 50i

1920×1080 50i

59.94 1920×1080 59.94i
720×486 59.94i

1920×1080 59.94i

Vous pouvez vérifier l’état genlock à l’aide de 
TC/Media > Genlock > Reference Lock Type 
(page 78) dans le menu.

[Remarques]
 • Si le signal de référence est instable, le mode Genlock 

ne peut pas être sélectionné.
 • La sous-porteuse n’est pas synchronisée.

Synchronisation du code temporel 
avec un autre périphérique

Réglez l’appareil fournissant le code temporel 
sur un mode avec lequel le code temporel 
produit avance continuellement (Mode Free 
Run).

1 Réglez TC/Media > Timecode > Mode 
(page 78) dans le menu sur Preset 
F-Run (Ext-Lk).

2 Envoyez un signal vidéo de référence HD 
ou SD au connecteur GENLOCK IN 
(page 12) et un code temporel de 
référence synchronisé sur ce signal au 
connecteur TC IN (page 12).

Le générateur de code temporel intégré de 
votre appareil verrouille le code temporel de 
référence et le message « Ext-Lk » s’affiche sur 
l’écran d’accueil de l’affichage auxiliaire.
Une fois que dix secondes environ se sont 
écoulées après le verrouillage du code 
temporel, l’état de verrouillage externe 
est maintenu, même si la source de code 
temporel externe est déconnectée.

[Remarques]
 • Vérifiez que le code temporel de référence et le signal 

vidéo de référence sont dans un rapport de phase 
conforme aux normes de code temporel SMPTE.

 • Une fois la procédure ci-dessus terminée, le code 
temporel interne est immédiatement synchronisé 
avec le code temporel externe et l’affichage des 
données temporelles indique la valeur du code 
temporel externe. Cependant, avant d’enregistrer, 
patientez quelques secondes le temps que le 
générateur de code temporel se stabilise.

 • Si la fréquence du signal vidéo de référence et la 
fréquence d’image sont différentes, il est impossible 
d’obtenir un verrouillage et l’appareil ne fonctionnera 
pas correctement. Si cela se produit, le code temporel 
ne pourra pas acquérir de verrouillage correct avec le 
code temporel externe.

 • Lorsque la connexion est coupée, l’avance du code 
temporel peut se décaler d’une image par heure par 
rapport au code temporel de référence.

Pour libérer le verrouillage externe

Changez le réglage TC/Media > Timecode > 
Mode (page 78) dans le menu.

Synchronisation externe
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Précautions d’utilisation
Lisez cette section en vous référant également 
aux informations fournies dans le document 
« Avant d’utiliser cet appareil » fourni.

Utilisation et stockage

Ne soumettez pas l’appareil à des chocs 
violents

Ils pourraient endommager les mécanismes 
internes ou déformer le boîtier.

Ne couvrez pas l’appareil pendant son 
fonctionnement

Le fait de couvrir l’appareil d’un tissu, par 
exemple, peut provoquer une surchauffe 
interne.

Après utilisation

Mettez toujours l’interrupteur d’alimentation 
sur OFF.

Avant un stockage prolongé de 
l’appareil

Retirez le pack de batteries.

Ne laissez pas l’appareil avec l’objectif 
face au soleil

La lumière directe du soleil peut entrer dans 
l’objectif, se concentrer dans l’appareil et 
provoquer un incendie.

Transport

 • Retirez les cartes mémoire avant de 
transporter l’appareil.

 • En cas de transport par camion, bateau, 
avion ou par d’autres services de transport, 
emballez l’appareil dans son emballage 
d’expédition.

Entretien de l’appareil

Si le boîtier de l’appareil est sale, nettoyez-le 
au moyen d’un chiffon sec et doux. Dans les 
cas extrêmes, utilisez un chiffon humidifié 
avec un peu de détergent neutre, puis 
essuyez.
N’utilisez pas de produits organiques tels 
que de l’alcool ou des solvants qui peuvent 
provoquer une décoloration ou d’autres 
dommages de la finition de l’appareil.
Évitez de nettoyer l’appareil avec un 
équipement à haute pression, tel qu’un 
aspirateur à air comprimé, car cela pourrait 
endommager les composants optiques.

En cas de problèmes de fonctionnement

Si vous rencontrez des problèmes avec 
l’appareil, contactez votre revendeur Sony.

Remplacement périodique du 
ventilateur et de la batterie

Le ventilateur et la batterie sont des 
consommables qui doivent être régulièrement 
remplacés.
Lorsque vous utilisez l’appareil à température 

ambiante, le cycle de remplacement 
est d’environ 5 ans. Mais, ce cycle de 
remplacement ne représente qu’une 
indication et ne garantit pas la durée de vie 
de ces consommables. Pour plus de détails 
sur le remplacement de ces pièces, veuillez 
contacter votre revendeur.

Durée de vie du condensateur 
électrolytique

La durée de vie du condensateur 
électrolytique est de 5 ans environ, sous des 
températures de fonctionnement normales et 
pour un usage normal (8 heures par jour, 25 
jours par mois).
Si l’utilisation dépasse la fréquence 
d’utilisation normale, la durée de vie peut être 
réduite en conséquence.

Remarque à propos de la borne 
de batterie

La borne de batterie de cet appareil (le 
connecteur pour les packs batterie et les 
adaptateurs CA) est une pièce consommable.
L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de 
batterie sont cintrées ou déformées par 
les chocs ou les vibrations, ou si elles sont 
touchées par la corrosion en raison d’une 
utilisation prolongée en extérieur.
Des inspections périodiques sont 
recommandées pour que l’appareil continue 
à fonctionner correctement et pour prolonger 
la durée de son utilisation. Contactez un 
vendeur ou un technicien Sony pour plus 
d’informations sur les inspections.

Emplacements d’utilisation et de 
stockage

Rangez le caméscope dans un endroit aéré plat.
Évitez d’utiliser ou d’entreposer l’appareil dans 
les lieux suivants.
 • Les endroits excessivement chauds ou froids 

(plage de température de fonctionnement : 
0 °C à 40 °C (32 °F à 104 °F))  
N’oubliez pas qu’en été, dans les climats 
chauds, la température à l’intérieur d’un 
véhicule aux vitres fermées peut facilement 
dépasser 50 °C (122 °F).

 • humides ou poussiéreux
 • où l’appareil pourrait recevoir la pluie
 • soumis à de violentes vibrations
 • à proximité de champs magnétiques 

puissants
 • à proximité d’émetteurs radio ou télévision 

produisant des champs électromagnétiques 
puissants.

 • en plein soleil ou à proximité d’équipements 
de chauffage pendant de longues périodes

Pour éviter les interférences 
électromagnétiques des dispositifs de 
communication portables

L’emploi de téléphones portables et d’autres 
dispositifs de communication à proximité de 
cet appareil peut engendrer des anomalies de 
fonctionnement et des interférences avec des 
signaux audio et vidéo.
Il est recommandé de mettre hors tension les 
dispositifs de communication portables près 
de cet appareil.

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager le 
capteur d’image CMOS. Si vous filmez une 
scène comprenant un faisceau laser, veillez à 
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ce que celui-ci ne soit pas dirigé directement 
vers l’objectif de l’appareil. En particulier, les 
faisceaux laser haute puissance provenant de 
dispositifs médicaux ou d’autres dispositifs 
peuvent causer des dommages dus à la 
lumière réfléchie et à la lumière diffuse.

À propos des écrans

 • Ne laissez pas les écrans face aux rayons 
directs du soleil, car cela risque de les 
endommager.

 • Lorsque vous appuyez/balayez les écrans, 
ne forcez pas et ne laissez pas d’objets 
sur les écrans, car cela pourrait entraîner 
un dysfonctionnement, notamment une 
irrégularité de l’image, etc.

 • Les écrans peuvent chauffer pendant leur 
utilisation. Il ne s’agit pas d’une anomalie.

Écrans LCD

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, 
ce qui permet d’obtenir un taux d’au moins 
99,99% de pixels qui fonctionnent. Ainsi, 
un infime pourcentage de pixels peut être 
« bloqué », c’est à dire toujours éteint (noir), 
toujours éclairé (rouge, vert ou bleu), ou 
clignotant. En outre, après une longue période 
d’utilisation, en raison des caractéristiques 
physiques de l’afficheur à cristaux liquides, 
de tels pixels « bloqués » peuvent apparaître 
spontanément.
Ces problèmes ne sont pas graves.
Notez que ces problèmes n’ont aucun effet sur 
les données enregistrées.

Écrans OLED

L’écran OLED intégré à cet appareil est 
fabriqué avec une technologie de haute 
précision, ce qui permet d’obtenir un taux d’au 
moins 99,99 % de pixels qui fonctionnent. 
Ainsi, un infime pourcentage de pixels peut 
être « bloqué », c’est à dire toujours éteint 
(noir), toujours éclairé, ou clignotant. En outre, 
après une longue période d’utilisation, en 
raison des caractéristiques physiques de la 
diode électroluminescente organique, de 
tels pixels « bloqués » peuvent apparaître 
spontanément. Ces problèmes ne sont pas 
graves. Notez que ces problèmes n’ont aucun 
effet sur les données enregistrées.
En raison des caractéristiques du matériau 
utilisé dans le panneau OLED, des images 
rémanentes ou une réduction de la luminosité 
peuvent survenir.
Ces problèmes ne sont pas graves.

Sur la condensation

Si l’appareil est soudainement déplacé 
d’un endroit froid à un endroit chaud, ou 
si la température ambiante augmente 
brusquement, de l’humidité peut se former 
sur la surface externe de l’appareil et/ou à 
l’intérieur de l’appareil. Ce phénomène est 
connu sous le nom de condensation. Si de 
la condensation se produit, mettez l’appareil 
hors tension et patientez le temps que la 
condensation disparaisse avant d’utiliser 
l’appareil. L’utilisation de l’appareil avec de la 
condensation pourrait endommager l’appareil.

Phénomènes particuliers aux 
capteurs d’image CMOS

Les phénomènes suivants, qui peuvent 
apparaître sur les images, sont particuliers 
aux capteurs d’image CMOS (Complementary 
Metal Oxide Semiconductor). Ils ne signalent 
en rien un dysfonctionnement.

Flocons blancs

Bien que les capteurs d’image CMOS soient 
produits au moyen de technologies de haute 
précision, des petits flocons blancs peuvent 
dans de rares cas apparaître sur l’écran, et 
ont pour origine les rayons cosmiques entre 
autres. Ceci est apparenté au principe de 
capteurs d’image CMOS et ne représente pas 
un dysfonctionnement.
Ces flocons blancs sont surtout visibles dans 
les cas suivants.
 • lors d’une utilisation à température élevée

Crénelage

Lorsque des rayures ou des lignes fines sont 
filmées, elles peuvent apparaître dentelées ou 
peuvent scintiller.

Plan focal

En raison des caractéristiques des éléments de 
captage (capteurs CMOS) concernant la lecture 
des signaux vidéo, les sujets se déplaçant 
rapidement à travers l’écran peuvent 
apparaître légèrement obliques.

Bande flash

La luminance en haut et en bas de l’écran peut 
varier si vous filmez un faisceau de lampe-
torche ou une source lumineuse qui clignote 
rapidement.

Scintillement

Si l’enregistrement est effectué sous une 
lumière produite par des tubes à décharge, 
comme des lampes fluorescentes, au 
sodium ou à la vapeur de mercure, l’écran 
peut clignoter, les couleurs peuvent varier 
ou les lignes horizontales peuvent paraître 
déformées.
Le scintillement peut être réduit à l’aide de 
la fonction de réduction du scintillement de 
l’appareil (page 67).

Remarques concernant l’affichage

 • Il se peut que les opérations suivantes 
déforment les sorties et les images sur 
l’écran du viseur.

 – Modification du format vidéo
 – Changer la fréquence d’images FPS
 – Lorsque le genlock est appliqué

 • Lorsque vous changez la ligne de mire dans 
le viseur, il se peut que vous voyiez des 
couleurs primaires rouges, vertes et bleues, 
mais ceci n’est pas un dysfonctionnement 
de l’appareil. Ces couleurs primaires ne 
sont enregistrées sur aucun support 
d’enregistrement.
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Fragmentation

S’il est impossible d’enregistrer/reproduire 
correctement des images, essayez de formater 
le support d’enregistrement. Lors de la 
lecture/enregistrement répétés d’une image 
à l’aide d’un certain support d’enregistrement 
pendant une période prolongée, les fichiers 
du support risquent d’être fragmentés, 
empêchant le stockage/enregistrement 
corrects. Dans ce cas, effectuez une 
sauvegarde des plans sur le support, puis 
formatez-le à l’aide de TC/Media > Format 
Media (page 78) dans le menu.

Tensions de sortie de l’appareil

La puissance de sortie totale qui peut être 
fournie aux périphériques depuis l’appareil 
varie en fonction de la tension d’entrée vers 
l’appareil et l’état des accessoires connectés. 
Les capacités nominales de sortie maximum 
des connecteurs suivants pouvant fournir 
l’alimentation peuvent ne pas être atteintes en 
fonction des conditions.

Connecteur LENS : 1 A max.
Connecteur 12V OUT (2 broches) : 1 A max.
Connecteur 24V OUT (3 broches) :

2 A max. (Tension d’entrée : 22 V à 32 V)
1 A max. (Tension d’entrée : 11 V à 17 V)

L’alimentation nominale fournie pour les 
accessoires (DVF-EL200 et CBK-3610XS) et 
les périphériques est limitée selon la tension 
d’entrée de l’appareil.

Tension d’alimentation vers l’appareil : X [V]
Puissance nominale totale des 
périphériques : Y [W]
Consommation électrique de l’appareil : 
Z [W]1)

ʓ Consommation électrique du DVF-
EL200 : environ 2,5 W

ʔ Consommation électrique du CBK-
3610XS : environ 3,9 W

Y [W] = X [V] × 9,0 [A]* – (Z + ʓ + ʔ) [W]

* Si X [V] × 9,0 [A] dépasse 220 [W], effectuez le 
calcul en utilisant 220 [W].

Lors de l’alimentation des accessoires et 
périphériques fixés indiqués ci-dessus, 
assurez-vous que la valeur Y donnée par 
l’équation ci-dessus ne soit pas négative. 
Il est recommandé d’utiliser la valeur de 
consommation électrique maximale de 
l’appareil pour la consommation électrique de 
l’appareil.1)

(Notez que l’équation ne s’applique pas si le 
résultat calculé Y est supérieur à la somme de 
la puissance maximale admissible de chaque 
connecteur de sortie de puissance.)
1) MPC-3628 : 

Consommation électrique nominale de l’appareil : 
environ 76 W (enregistrement X-OCN XT, 8.6K 3:2,  
24 FPS)

 Consommation électrique maximale de l’appareil : 
environ 100 W (enregistrement X-OCN ST, 8.2K 17:9,  
60 FPS, environnement 40 °C (104 °F), entrée CC 32 V)

 MPC-3626 : 
Consommation électrique nominale de l’appareil : 
environ 73 W (enregistrement X-OCN XT, 6K 3:2,  
24 FPS)

 Consommation électrique maximale de l’appareil : 
environ 94 W (enregistrement X-OCN ST, 6K 3:2,  
60 FPS, environnement 40 °C (104 °F), entrée CC 32 V)

Remarques relatives à la sécurité

 • Sony ne peut être tenue responsable de 
tout dommage, de quelque nature que ce 
soit, résultant d’une incapacité à mettre en 
place des mesures de sécurité adaptées 
pour les dispositifs de transmission, de 
fuites de données inévitables dues aux 

spécifications de transmission ou de tout 
autre problème de sécurité.

 • Selon l’environnement d’exploitation, il est 
possible que des tiers non autorisés sur le 
réseau puissent accéder à l’appareil. Avant 
de connecter l’appareil au réseau, vérifiez 
que le réseau est bien protégé.

 • Pour des raisons de sécurité, lors de 
l’utilisation de cet appareil connecté au 
réseau, il est fortement recommandé 
d’accéder à la fenêtre de commande via un 
navigateur Web et de modifier la limitation 
d’accès des valeurs d’usine préréglées 
(page 89).  
Il est par ailleurs recommandé de modifier 
régulièrement le mot de passe.

 • Ne consultez aucun autre site Web dans 
le navigateur Web pendant ou après la 
configuration. Étant donné que l’état de 
connexion est conservé dans le navigateur 
Web, fermez ce dernier lorsque la 
configuration est terminée pour empêcher 
tout tiers non autorisé d’utiliser l’appareil ou 
d’exécuter des programmes malveillants.
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Formats de sortie du connecteur SDI OUT

Le signal numérique série d’un connecteur SDI OUT est émis en fonction des réglages de la catégorie Project et de la catégorie Monitoring dans le menu.
Pour en savoir plus sur les combinaisons des réglages de catégorie Project, consultez « Réglages du format d’enregistrement » (page 61).
Vous pouvez régler le format de sortie 3G SDI sur Level A ou Level B à l’aide de Monitoring > Output Format > 3G SDI 1/2/3/4 Output (page 79) dans le menu complet.

Les valeurs par défaut sont soulignées et affichées en gras.

Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

59.94/50 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 12G
1920×1080P Level A1)

4096×2160P  
YPbPr 12G

4096×2160P  
YPbPr 12G

1920×1080P  
YPbPr 3G Level A

1920×1080P  
YPbPr 3G Level A

1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

4096×2160P  
Square Level B2)

4096×2160P  
Square Level B2) 4096×2160P YPbPr 3G Square Level B

4096×2160P  
2SI Level B2)

4096×2160P  
2SI Level B2) 4096×2160P YPbPr 3G 2SI Level B

2048×1080P Level B2)

1920×1080P Level B2)

2048×1080P  
YPbPr 3G Level B

2048×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080P Level B2)

1920×1080P Level B2)

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

Formats d’enregistrement et signaux de sortie
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

59.94/50 7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 HQ QFHD

3840×2160P 12G
1920×1080P Level A1)

3840×2160P  
YPbPr 12G

3840×2160P  
YPbPr 12G

1920×1080P  
YPbPr 3G Level A

1920×1080P  
YPbPr 3G Level A

1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

3840×2160P  
Square Level B2)

3840×2160P  
Square Level B2) 3840×2160P YPbPr 3G Square Level B

3840×2160P  
2SI Level B2)

3840×2160P  
2SI Level B2) 3840×2160P YPbPr 3G 2SI Level B

1920×1080P Level B2)

1920×1080P Level B2)

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080P  
YPbPr 3G Level B

1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i3) 1920×1080i3) 1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

1920×1080i  
YPbPr 1.5G

47.95 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT

4096×2160P  
Square Level B2)

4096×2160P  
Square Level B2) 4096×2160P YPbPr 3G Square Level B

4096×2160P  
2SI Level B2)

4096×2160P  
2SI Level B2) 4096×2160P YPbPr 3G 2SI Level B

2048×1080P Level B2) 1920×1080P
2048×1080P  

YPbPr 3G Level B
2048×1080P  

YPbPr 3G Level B
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

29.97/25 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G
1920×1080P

4096×2160P  
YPbPr 6G 2SI

4096×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G Square

4096×2160P 2SI
1920×1080P

4096×2160P YPbPr 3G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

2048×1080PsF
1920×1080P

2048×1080PsF  
YPbPr 1.5G

2048×1080PsF  
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G
1920×1080P

3840×2160P  
YPbPr 6G 2SI

3840×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G Square

3840×2160P 2SI
1920×1080P

3840×2160P YPbPr 3G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

24 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G 1920×1080P
4096×2160P  
YPbPr 6G 2SI

4096×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G Square

4096×2160P 2SI 1920×1080P 4096×2160P YPbPr 3G 2SI
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

2048×1080PsF 1920×1080P
2048×1080PsF  

YPbPr 1.5G
2048×1080PsF  

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080P
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G 1920×1080P
3840×2160P  
YPbPr 6G 2SI

3840×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G Square

3840×2160P 2SI 1920×1080P 3840×2160P YPbPr 3G 2SI
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080P
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

23.98 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G 1920×1080P
4096×2160P  
YPbPr 6G 2SI

4096×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G Square

4096×2160P 2SI 1920×1080P 4096×2160P YPbPr 3G 2SI
1920×1080P  
YPbPr 1.5G

1920×1080P  
YPbPr 1.5G

2048×1080PsF 1920×1080P
2048×1080PsF  

YPbPr 1.5G
2048×1080PsF  

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080P
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G 1920×1080P
3840×2160P  
YPbPr 6G 2SI

3840×2160P  
YPbPr 6G 2SI

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G Square

3840×2160P 2SI 1920×1080P 3840×2160P YPbPr 3G 2SI
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1920×1080PsF 1920×1080P
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF 

YPbPr 1.5G
1920×1080P 
YPbPr 1.5G

1920×1080P 
YPbPr 1.5G

1) Le signal Level A est émis même lorsque Monitoring > Output Format > 3G SDI 1/2/3/4 Output (page 79) est réglé sur Level B dans le menu complet.
2) Le réglage de menu passe à Level A et le signal Level A est émis lorsque Monitoring > Output Format > 3G SDI 1/2/3/4 Output est réglé sur Level A dans le menu complet.
3) Réglez lorsque Technical > Special Configuration > SD HDMI (page 93) est réglé sur On dans le menu complet.
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Formats de sortie du connecteur MONITOR OUT/connecteur HDMI OUT

Le signal numérique des connecteurs MONITOR OUT et HDMI OUT est émis en fonction des réglages de la catégorie Project et de la catégorie Monitoring dans le menu.
Pour en savoir plus sur les combinaisons des réglages de catégorie Project, consultez « Réglages du format d’enregistrement » (page 61).

Les valeurs par défaut sont soulignées et affichées en gras.

Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

59.94/50 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 12G

1920×1080P Level A1) 1920×1080P Level A
4096×2160P 1920×1080P  

YPbPr 3G Level A
4096×2160P

1920×1080P 1920×1080P

1920×1080i 1920×1080i
4096×2160P 1920×1080P  

YPbPr 3G Level A
4096×2160P

1920×1080i 1920×1080i

4096×2160P  
Square Level B2)

4096×2160P  
Square Level B2)

1920×1080P Level A 1920×1080P
1920×1080P  

YPbPr 3G Level A
1920×1080P

1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

4096×2160P 2SI Level 
B2)

4096×2160P 2SI Level 
B2)

1920×1080P Level A
4096×2160P 1920×1080P  

YPbPr 3G Level A
4096×2160P

1920×1080P 1920×1080P

1920×1080i
4096×2160P 1920×1080i  

YPbPr 1.5G
4096×2160P

1920×1080i 1920×1080i

2048×1080P Level B2)

1920×1080P Level B2) 1920×1080P Level A 1920×1080P
1920×1080P  

YPbPr 3G Level A
1920×1080P

1920×1080i 1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

1920×1080P Level B2)

1920×1080P Level B2) 1920×1080P Level A 1920×1080P
1920×1080P  

YPbPr 3G Level A
1920×1080P

1920×1080i 1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

59.94/50 7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 HQ QFHD

3840×2160P 12G

1920×1080P Level A1) 1920×1080P Level A
3840×2160P 1920×1080P  

YPbPr 3G Level A
3840×2160P

1920×1080P 1920×1080P

1920×1080i 1920×1080i
3840×2160P 1920×1080P  

YPbPr 3G Level A
3840×2160P

1920×1080i 1920×1080i

3840×2160P  
Square Level B2)

3840×2160P  
Square Level B2)

1920×1080P Level A 1920×1080P
1920×1080P  

YPbPr 3G Level A
1920×1080P

1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

3840×2160P  
2SI Level B2)

3840×2160P  
2SI Level B2)

1920×1080P Level A
3840×2160P 1920×1080P  

YPbPr 3G Level A
3840×2160P

1920×1080P 1920×1080P

1920×1080i
3840×2160P 1920×1080i  

YPbPr 1.5G
3840×2160P

1920×1080i 1920×1080i

1920×1080P Level B2)

1920×1080P Level B2) 1920×1080P Level A 1920×1080P
1920×1080P  

YPbPr 3G Level A
1920×1080P

1920×1080i 1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i
1920×1080i  
YPbPr 1.5G

1920×1080i

1920×1080i3) 1920×1080i3) – 720×480P3) – 720×480P3) 4)

47.95 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT

4096×2160P  
Square Level B2)

4096×2160P  
Square Level B2)

1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

4096×2160P  
2SI Level B2)

4096×2160P  
2SI Level B2)

2048×1080P Level B2) 1920×1080P

1920×1080P 1920×1080P
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

29.97/25 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G

1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P Square 4096×2160P Square
1920×1080P 1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF

4096×2160P 2SI

1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

2048×1080PsF
1920×1080P 1920×1080P 1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G

1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P Square 3840×2160P Square
1920×1080P 1920×1080P

1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF

3840×2160P 2SI

1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080PsF
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G
1920×1080PsF
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

24 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G 1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

4096×2160P 2SI 1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

2048×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G 1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

3840×2160P 2SI 1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P
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Project Monitoring > Output Format Format de sortie

Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

23.98 8.6K 3:2/
8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096×2160P 6G 1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

4096×2160P 2SI 1920×1080P 1920×1080P
4096×2160P 1920×1080P 

YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

2048×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X-OCN XT
X-OCN ST
X-OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840×2160P 6G 1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

3840×2160P 2SI 1920×1080P 1920×1080P
3840×2160P 1920×1080P 

YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1920×1080PsF 1920×1080P 1920×1080P 1920×1080P
1920×1080P 
YPbPr 1.5G

1920×1080P

1) Le signal Level A est émis même lorsque Monitoring > Output Format > 3G SDI 1/2/3/4 Output (page 79) est réglé sur Level B dans le menu complet.
2) Le réglage de menu passe à Level A et le signal Level A est émis lorsque Monitoring > Output Format > 3G SDI 1/2/3/4 Output est réglé sur Level A dans le menu complet.
3) Réglez lorsque Technical > Special Configuration > SD HDMI (page 93) est réglé sur On dans le menu complet.
4) Configurable lorsque Imager Mode ou Zoom to Fit est réglé sur 16:9 et que Recording Format est réglé sur X-OCN ST. La sortie HDMI est 720×576P lorsque la fréquence d’images du projet est réglée sur 50.
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Durée d’enregistrement/lecture des plans AXS
Les tableaux suivants indiquent la durée de lecture/d’enregistrement lors de l’utilisation de l’AXS-A1TS66 (Unité : minutes).

[Remarque]
Les durées d’enregistrement et de lecture sont pour l’enregistrement continu sous forme de plan unique. Les durées réelles peuvent être plus courtes, selon le nombre de plans enregistrés. La durée d’enregistrement/de lecture peut varier 
selon les conditions d’utilisation et les caractéristiques de mémoire.

Durée d’enregistrement/lecture X-OCN

MPC-3628

Recording Format Project Frame Rate 8.6K 3:2 8.2K 17:9 7.6K 17:9 5.8K 6:5 5.8K 17:9 5.4K 16:9

X-OCN XT 23.98/24 23 32 32 41 65 65

25 22 31 31 39 62 62

29.97 18 25 25 33 52 52

47.95 – – – 20 32 –

50 – – – – 31 31

59.94 – – – – 26 26

X-OCN ST 23.98/24 34 47 47 60 95 95

25 32 45 45 57 91 91

29.97 27 37 37 48 76 76

47.95 – 23 – 30 47 –

50 – 22 22 – 45 45

59.94 – 18 18 – 38 38

X-OCN LT 23.98/24 58 80 80 102 160 160

25 55 77 77 98 154 154

29.97 46 64 64 81 128 128

47.95 – 40 – 51 80 –

50 – 38 38 – 77 77

59.94 – 32 32 – 64 64
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MPC-3626

Recording Format Project Frame Rate 6K 3:2 6K 1.85:1 6K 17:9 6K 2.39:1 5.7K 16:9 4K 6:5 4K 4:3 4K 17:9 4K 2.39:1 3.8K 16:9

X-OCN XT 23.98/24 47 58 59 75 59 81 93 129 161 129

25 45 56 57 72 57 78 89 124 155 124

29.97 38 46 47 60 47 65 74 103 129 103

47.95 23 29 29 37 – 41 46 64 81 –

50 22 28 28 36 28 39 44 62 77 62

59.94 19 23 23 30 23 32 37 51 64 51

X-OCN ST 23.98/24 69 85 87 109 87 119 135 188 235 188

25 66 81 83 105 83 114 130 180 225 180

29.97 55 68 69 87 69 95 108 150 188 150

47.95 34 42 43 54 – 59 68 94 118 –

50 33 40 42 52 42 57 65 90 113 90

59.94 27 34 35 43 35 47 54 75 94 75

X-OCN LT 23.98/24 117 144 147 185 147 201 229 316 395 316

25 112 138 141 177 141 193 220 304 380 304

29.97 94 115 118 148 118 161 183 254 317 254

47.95 58 72 74 92 – 101 115 159 199 –

50 56 69 71 89 71 97 110 153 191 153

59.94 47 57 59 74 59 81 92 127 159 127

Durée d’enregistrement/lecture ProRes

Project Frame Rate 4K 4444 4K 422 HQ QFHD 4444 QFHD 422 HQ

23.98/24 98 146 104 156

25 94 140 100 150

29.97 78 117 83 125

50 47 70 50 75

59.94 39 58 41 62
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Indications d’erreur/avertissement
Si l’appareil détecte un avertissement, une précaution ou une condition de fonctionnement 
qui nécessite une confirmation, un message s’affiche sur l’affichage auxiliaire, le voyant REC 
commence à clignoter et un avertissement sonore est émis.
Le signal sonore est émis par le haut-parleur intégré ou le casque raccordé par le biais du 
connecteur correspondant.
Lorsque l’appareil est sous tension, un message apparaît sur l’écran de l’affichage auxiliaire, 
vous invitant à exécuter Auto Pixel Restoration si le réglage automatique du capteur d’image 
(Auto Pixel Restoration) n’a pas été effectué depuis un certain moment. Dans ce cas, suivez les 
instructions à l’écran pour exécuter Auto Pixel Restoration (page 89).

Affichage d’erreur

L’appareil arrêtera l’opération si l’un des écrans suivants s’affiche.

Indication d’affichage 
d’erreur

Signal 
sonore

Voyant REC Cause et solution

E + Code d’erreur Intermittent Clignotement 
très rapide

L’appareil peut être défectueux. L’enregistrement 
s’arrête, même si ĆREC s’affiche sur l’écran du 
viseur/du moniteur.
Mettez hors tension et vérifiez les supports, les 
câbles et les équipements raccordés. Si l’erreur 
persiste après avoir remis l’appareil sous tension, 
contactez votre représentant du service après-
vente Sony. (Si l’alimentation ne peut pas être 
coupée en mettant le commutateur 
d’alimentation sur OFF, retirez le pack de 
batteries ou la source DC IN.)

Affichage d’avertissement

Lorsque l’un des messages suivants se produit, utilisez le tableau suivant pour résoudre le 
problème.

Indication d’affichage 
d’avertissement

Signal 
sonore 

Voyant REC Cause et solution

Media Full 1) Continu Clignotement 
très rapide

Les plans n’ont pas pu être enregistrés, copiés ou 
divisés parce qu’il n’y a plus d’espace disponible 
sur la carte mémoire AXS.
Remplacez-la immédiatement.

Indication d’affichage 
d’avertissement

Signal 
sonore 

Voyant REC Cause et solution

Battery End 1) Continu Clignotement 
très rapide

Le pack de batteries est épuisé. L’enregistrement 
est désactivé.
Arrêtez d’utiliser l’appareil et rechargez le pack 
de batteries.

Temperature High 1) Intermittent Clignotant La température interne est élevée.
Mettez l’appareil hors tension et laissez-le 
refroidir avant de le faire fonctionner à nouveau.

Insufficient Voltage 1) Continu Clignotement 
très rapide

La tension DC IN est trop faible. L’enregistrement 
est désactivé.
Raccordez une autre source d’alimentation.

1) Le message ne s’affiche pas sur l’écran du moniteur.

À propos des avertissements de température

L’avertissement Temperature High peut s’afficher lorsque l’appareil fonctionne dans les 
limites de la température de fonctionnement garantie, selon le mode de fonctionnement et 
l’environnement d’utilisation. L’enregistrement ne s’arrête pas immédiatement lorsque ces 
messages sont affichés, mais les suggestions données dans la colonne Cause et solution du 
tableau doivent être mises en œuvre rapidement.

Affichage de mise en garde et de confirmation des opérations

Les messages de confirmation de précaution et de fonctionnement suivants peuvent s’afficher 
sur l’écran du moniteur ou l’affichage auxiliaire, des icônes d’avertissement peuvent s’afficher 
et des messages peuvent être affichés dans la catégorie Info > Camera Condition dans le menu. 
Suivez les instructions fournies pour résoudre le problème.

Indication d’affichage Cause et solution

Backup Battery End
Please Change

La capacité restante de la batterie de secours est 
insuffisante.
Remplacez la batterie de secours.

Cannot Use AXS(A)*
Please Change

Une carte mémoire qui a été partitionnée ou une 
carte mémoire contenant plus de plans que ceux 
pouvant être gérés par l’appareil a été insérée.
La carte ne peut pas être utilisée dans l’appareil 
et doit être remplacée.
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Indication d’affichage Cause et solution

Cannot Use AXS(A)*
Unsupported File System

Une carte utilisant un système de fichiers 
différent ou une carte non formatée a été insérée.
La carte ne peut pas être utilisée dans l’appareil 
et doit être remplacée ou formatée à l’aide de 
l’appareil.

Media Error
AXS(A)* Needs to be Restored

Une erreur s’est produite avec la carte mémoire. 
La carte doit être restaurée.
Restaurez la carte.

AXS(A)* Error
Recording Stopped
Playback Stopped

La lecture ou l’enregistrement s’est arrêté parce 
qu’une erreur s’est produite sur la carte mémoire.
Si le problème persiste, remplacez la carte 
mémoire.

Input AES/EBU is Invalid Emphasis Un signal AES/EBU avec une accentuation non 
prise en charge a été entré.
L’appareil ne prend en charge que les signaux 
avec une accentuation de 50 μs + 15 μs.

Input AES/EBU is not Pro Use Présence au niveau de l’entrée AES/EBU d’un 
signal non professionnel.
L’appareil est uniquement compatible avec un 
usage professionnel.

Fan Stopped Le ventilateur de l’appareil s’est arrêté.
Évitez de l’utiliser à des températures élevées. 
Mettez l’appareil hors tension et contactez un 
représentant du service après-vente Sony.

XXXX License Y days Remaining 
(XXXX : type de licence, Y : nombre de jours 
restants)

La licence de l’option du logiciel va expirer dans 2 
jours.

Lens I/F Error Défaillance de communication I/F de l’objectif 
détectée lorsqu’un objectif à monture E est fixé.
Vérifiez le raccordement à l’objectif à monture E.

Set the "Password" of "Authentication". Technical > Authentication > Password 
(page 90) n’a pas encore été configuré. 
Configurez le réglage.

* « AXS(A) » s’affiche pour la carte mémoire AXS dans la fente A, et « AXS(B) » s’affiche pour la carte mémoire AXS 
dans la fente B.
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Éléments enregistrés dans les fichiers
Légende du tableau
Oui : enregistré
Non : non enregistré
– : non enregistré (réglage temporaire)

Menu Shooting

Élément Sous-élément Type de fichier

All Scene

FPS Fixed/Variable Select Oui Non

FPS Select Oui Non

Shutter 1) Shutter Select Oui Oui

Step/Cont. Select Oui Oui

Add/Change Step – –

Delete Step – –

Flicker Reduce Mode Oui Non

Frequency Oui Non

ND ND Position Oui Oui

Exposure Index EI Select Oui Oui

Gain Gain Select Oui Oui

White Balance 1) Color Temp. Select Oui Oui

Add/Change Step – –

Delete Step – –

Auto White Balance – –

Look Category Oui Non

Preset Look Select Oui Non

User 3D LUT Select Oui Non

ART Select Oui Non

ART Information – –

ASC CDL Process Oui Non

ASC CDL Select Oui Non

ASC CDL Information – –

Élément Sous-élément Type de fichier

All Scene

Look File Load User 3D LUT – –

Reset User 3D LUT – –

Reset All User 3D LUTs – –

Load ART – –

Reset ART – –

Reset All ARTs – –

Load ASC CDL – –

Reset ASC CDL – –

Reset All ASC CDLs – –

LUT Select SDI 1/2 Oui –

SDI 3/4 Oui Non

Monitor Oui Non

HDMI – –

VF LUT Oui Non

ProRes Oui Non

SDR Gain Oui Non

1) Les options de sélection ajoutées ou modifiées par un utilisateur sont également sauvegardées.
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Menu Project

Élément Sous-élément Type de fichier

All Scene

Basic Setting Imager Mode Oui Non

Project Frame Rate Oui Non

Input Color Space Oui Oui

Recording Format Oui Non

Base ISO Oui Oui

Anamo. De-Squeeze Oui Non

Zoom to Fit Oui Non

Assignable Button <1> Oui Non

<2> Oui Non

<3> Oui Non

<4> Oui Non

<VF A> Oui Non

<VF B> Oui Non

<VF C> Oui Non

<User 1> Oui Non

<User 2> Oui Non

<User 3> Oui Non

<User 4> Oui Non

<User 5> Oui Non

Special Recording Cache Rec Select Oui Non

Max Cache Rec Duration Oui Non

All File(Cam Setup) Load SD Card – –

Save SD Card – –

File ID Oui Non

Format SD Card – –

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load SD Card – –

Save SD Card – –

File ID Non Oui

User Gamma Current Settings – –

Load SD Card – –

Reset – –

Menu TC/Media

Élément Sous-élément Type de fichier

All Scene

Timecode Mode Oui Non

Manual Setting – –

Reset – –

TC Format Oui Non

TC Source – –

Time Data Display Oui Non

Genlock Input Source Oui Non

Reference Lock Type – –

Clip Name Format Camera ID 1) Oui Non

Reel Number 1) Oui Non

Camera Position 1) Oui Non

Format Media AXS Slot A – –

AXS Slot B – –

SD Card – –

1) Lorsque vous chargez un fichier All, les données sauvegardées dans la mémoire interne ne sont pas écrasées.
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Menu Monitoring

Élément Sous-élément Type de fichier

All Scene

Output Format SDI 1/2 Oui Non

SDI 3/4 Oui Non

Monitor Oui Non

HDMI Oui Non

3G SDI 1/2/3/4 Output Oui Non

Output Display Flip Image Oui Non

Audio/Video Delay Oui Non

Monitor Magnifier Mode Oui Non

Monitor Magnifier Ratio Oui Non

VF Display VF LUT Oui Non

Overlay Oui Non

Frame Line Oui Non

VF Magnifier Mode Oui Non

VF Magnifier Ratio Oui Non

Color Oui Non

SDR Gain Oui Non

VF Function Double Speed Scan Oui Non

Peaking Frequency Oui Non

Assign<VF A> Oui Non

Assign<VF B> Oui Non

Assign<VF C> Oui Non

Zebra Oui Non

Zebra Select Oui Non

Zebra1 Level Oui Non

Zebra1 Aperture Level Oui Non

Zebra2 Level Oui Non

Overlays/Frame Line VF Oui Non

SDI 1/2 Oui Non

SDI 3/4 Oui Non

Monitor Oui Non

HDMI – –

Overlay A/B Setup Oui Non

Frame Line A/B Setup Oui Non

Élément Sous-élément Type de fichier

All Scene
Frame Line Setup Color Oui Non

Center Marker Oui Non

Aspect Ratio Oui Non

Aspect Ratio Type Oui Non

Surround View Type Oui Non

Mask Level Oui Non

Safety Zone Oui Non

Aspect Safety Zone Oui Non

Frame Line on Playback Oui Non

User Frame Line 1 Select Oui Non

Preset Aspect Ratio Oui Non

Scaling Oui Non

Preset Aspect Ratio Type Oui Non

Aspect Ratio(Pixels) – –

Width Oui Non

Height Oui Non

H Position Oui Non

V Position Oui Non

Variable Aspect Type – –

User Frame Line 2 Select Oui Non

Preset Aspect Ratio Oui Non

Scaling Oui Non

Preset Aspect Ratio Type – –

Aspect Ratio(Pixels) – –

Width Oui Non

Height Oui Non

H Position Oui Non

V Position Oui Non

Variable Aspect Type – –
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Menu Audio

Élément Sous-élément Type de fichier

All Scene

Audio Input Internal Mic Select Oui Non

XLR Audio L Select Oui Non

XLR Audio R Select Oui Non

XLR Audio L Level Oui Non

XLR Audio R Level Oui Non

XLR Mic Reference Oui Non

Audio Monitor Monitor CH Oui Non

Monitor Level Oui Non

Audio Configuration Alarm Level Oui Non

Input Limiter Mode Oui Non

AGC Level Oui Non

AGC Mono/Stereo Oui Non

MIC Input Mono/Stereo Oui Non

Phantom Power +48V Oui Non

Monitor Output CH Pair Oui Non

Headphone Mono/ST Oui Non

Menu Paint

Élément Sous-élément Type de fichier

All Scene

Black Master Black Oui Oui

R Black Oui Oui

B Black Oui Oui

Flare Setting Oui Oui

Master Flare Oui Oui

R Flare Oui Oui

G Flare Oui Oui

B Flare Oui Oui

Gamma Setting Oui Oui

Gamma Category – –

Gamma Select Oui Oui

Black Gamma Setting Oui Oui

Range Oui Oui

Master Black Gamma Oui Oui

Knee Setting Oui Oui

Point Oui Oui

Slope Oui Oui

White Clip Setting Oui Oui

Level Oui Oui

Detail Setting Oui Oui

Level Oui Oui

H/V Ratio Oui Oui

Crispening Oui Oui

Level Depend Oui Oui

Level Depend Level Oui Oui

Frequency Oui Oui

Knee Aperture Oui Oui

Knee Aperture Level Oui Oui

Limit Oui Oui

White Limit Oui Oui

Black Limit Oui Oui
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Élément Sous-élément Type de fichier

All Scene

Matrix Setting Oui Oui

User Matrix Oui Oui

User Matrix R-G Oui Oui

User Matrix R-B Oui Oui

User Matrix G-R Oui Oui

User Matrix G-B Oui Oui

User Matrix B-R Oui Oui

User Matrix B-G Oui Oui

Multi Matrix Setting Oui Oui

Area Indication Non Non

Reset – –

Axis Non Non

Hue Oui Oui

Saturation Oui Oui

Menu Technical

Élément Sous-élément Type de fichier

All Scene

System Configuration Fan Control Oui Non

Shutter Mode Oui Oui

SDI Rec Remote Trigger Oui Non

Level Gauge Adjust – –

Level Gauge Reset – –

Lens Configuration PL-Mt Interface Position Oui Non

PL-Mt Voltage Oui Non

Focus Distance Format Oui Non

Lens 12pin Oui Non

E-Mount Shading Comp. Oui Non

E-Mt Chro. Aber. Comp. Oui Non

Auto Pixel Restore Auto Pixel Restoration – –

Reset – –

Authentication User Name Non Non

Password Non Non

Network Setting Oui Non

LAN Oui Non

Wireless Oui 1) Non

Alerts & Tally Rec Light Oui Non

Rec Start/Stop Beep Oui Non

Media Near Full Alarm Oui Non

Batt./Voltage Alarm Near End:Info Battery Oui Non

End:Info Battery Oui Non

Near End:Sony Battery Oui Non

End:Sony Battery Oui Non

Near End:Other Battery Oui Non

End:Other Battery Oui Non

Detected Battery – –

DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

DC(24V) Low Voltage1 Oui Non

DC(24V) Low Voltage2 Oui Non
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Élément Sous-élément Type de fichier

All Scene

Panel Control Brightness level Oui Non

Lock Operator Side Oui Non

Lock Assistant Side Oui Non

False Color Level Oui Non

Red Oui Non

Red Upper Limit Oui Non

Red Lower Limit Oui Non

Yellow Oui Non

Yellow Upper Limit Oui Non

Yellow Lower Limit Oui Non

Orange Oui Non

Orange Upper Limit Oui Non

Orange Lower Limit Oui Non

Pink Oui Non

Pink Upper Limit Oui Non

Pink Lower Limit Oui Non

Light Pink Oui Non

Light Pink Upper Limit Oui Non

Light Pink Lower Limit Oui Non

Cyan Oui Non

Cyan Upper Limit Oui Non

Cyan Lower Limit Oui Non

Green Oui Non

Green Upper Limit Oui Non

Green Lower Limit Oui Non

Light Blue Oui Non

Light Blue Upper Limit Oui Non

Light Blue Lower Limit Oui Non

Blue Oui Non

Blue Upper Limit Oui Non

Blue Lower Limit Oui Non

Purple Oui Non

Purple Upper Limit Oui Non

Purple Lower Limit Oui Non

Reset – –

Élément Sous-élément Type de fichier

All Scene

Test Signals Color Bars Oui Non

Color Bar Type Oui Non

1kHz Tone on Color Bars Oui Non

Test Saw Oui Non

Test Saw Type Oui Non

Special Configuration RM/RCP Paint Control Oui Non

NR(4K 17:9/16:9) Oui Oui

SD HDMI Oui Non

360˚ Shutter Setting Oui Non

1) Les éléments suivants ne peuvent pas être sauvegardés.
 • Scan Networks
 • SSID
 • Password
 • WPS
 • MAC Address
 • Regenerate Password
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Menu Maintenance

Élément Sous-élément Type de fichier

All Scene

Language Select Oui Non

Clock Set Time Zone Oui Non

Date Mode Oui Non

Date – –

Time – –

Hours Meter Hours (System) – –

Hours (Resettable) – –

Reset – –

Reset to Default Reset – –

Network Reset Reset – –

License Options Install: xxx – –

Anamorphic – –

Full-Frame – –

Unique Device ID – –

Firmware Version – –

Firmware Update – –

[Remarque]
Lorsque Technical > Special Configuration > RM/RCP Paint Control (page 93) est réglé sur On dans le menu complet, 
les éléments suivants de l’unité de télécommande (page 119) sont également sauvegardés dans le fichier All.
 • Black
 • Flare
 • Gamma 1)

 • Black Gamma 1)

 • Gain

1) Sauf si réglé sur S-Log3.
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Liste des métadonnées de sortie et d’enregistrement
Légende du tableau
Opt : inclus si des informations sont disponibles (en option)
Oui : défini
– : non défini

Élément Exemple de notation dans RAW Viewer RAW/X-OCN MXF RAW/X-OCN XML ProRes MXF ProRes XML HD-SDI

Creation Date 2021-10-29 11:04:05 Oui Oui Oui Oui –

Last Update 2021-10-30 11:04:05 – Oui Oui Oui –

UMID 060A2B340101010501010D4313000000070BF4 
1D2F494EB7A16DD045A68CDF2E

Oui Oui Oui Oui –

Start 03:36:29:20 Oui Oui Oui Oui –

End 03:36:32:19 Oui Oui Oui Oui –

Duration 00:00:03:00 Oui Oui Oui Oui –

Poster Frame – – – – –

Recording Mode – Oui – Oui –

Drop Frame NDF Oui Oui Oui Oui –

Camera VENICE/CineAltaV Oui Oui Oui Oui –

Video Codec X-OCN XT Oui Oui Oui Oui –

Resolution 6048×4032 Oui Oui Oui Oui –

Aspect Ratio 3:2 Oui Oui Oui Oui –

Format FPS 23.98p Oui Oui Oui Oui –

Capture FPS 23.98p Oui Oui Oui Oui –

Pixel Aspect 1:1 – Oui – – –

Flip normal – Oui – – –

Number of Audio Channels 4 Oui Oui Oui Oui –

Audio Codec LPCM Oui Oui Oui Oui –

Audio Bit Depth 24 Oui Oui Oui Oui –

Audio Sampling Rate 48000 Oui Oui Oui Oui –

Auto Exposure Mode ManualExposureMode Oui – Oui – Oui

Exposure Index 500 Oui Oui Oui Oui Oui

Auto Focus Sensing Area Setting ManualFocusMode Opt – Opt – Opt

ND Filter Wheel 1/4 Oui Oui Oui Oui Oui

Image Sensor Dimension Effective Width 35925um Oui – Oui – Oui

Image Sensor Dimension Effective Height 23950um Oui – Oui – Oui

Image Sensor Readout Mode ProgressiveFrame Oui Oui Oui Oui Oui

Shutter Speed Angle 172.50deg Oui Oui Oui Oui Oui

Shutter Speed Time 1/50sec Oui – Oui – Oui

Camera Master Gain Adjustment 0.00dB Oui – Oui – Oui

ISO Sensitivity 500 Oui Oui Oui Oui Oui

Electrical Extender Magnification 100% Oui – Oui – Oui
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Élément Exemple de notation dans RAW Viewer RAW/X-OCN MXF RAW/X-OCN XML ProRes MXF ProRes XML HD-SDI

Auto White Balance Mode PresetWhiteBalanceSetup Oui – Oui – Oui

White Balance 5500 Oui Oui Oui Oui Oui

Tint Correction 0.00000 Oui – Oui Oui Oui

Camera Master Black Level 3.0% – – Oui – Oui

Capture Gamma Equation scene-linear Oui Oui Oui Oui Oui

Gamma for CDL rec709 Oui Oui Oui Oui Oui

Color Primaries (Capture Color Primaries) – – Oui Oui Oui

Camera Attributes MPC-36289999999Version5.00 Oui Oui Oui Oui Oui

Effective Marker Aspect Ratio 6048:3202 Oui Oui Oui Oui Oui

User Frame Line 1 1920×1080+0+0 Oui – Oui – Oui

User Frame Line 2 1920×1080+0+0 Oui – Oui – Oui

Active Area Aspect Ratio 6048:4032 Oui Oui Oui Oui Oui

Pixel Aspect Ratio 1:1 Oui Oui Oui Oui Oui

Image Orientation normal Oui – Oui Oui Oui

Raw Black Code 512 Oui Oui – – –

Raw Gray Code 1504 Oui Oui – – –

Raw White Code 5472 Oui Oui – – –

Gamma for Look s-log3-cine Oui Oui Oui Oui Oui

Color for Look s-gamut3-cine Oui Oui Oui Oui Oui

Pre-CDL Transform LUT:SL3SG3Ctos709.cube Oui Oui Oui Oui Oui

Post-CDL Transform none Oui Oui Oui Oui Oui

Look Process Baked false Oui Oui Oui Oui Oui

Monitoring Characteristics rec709 Oui Oui Oui Oui Oui

Monitoring Base Curve rec709 Oui Oui Oui Oui Oui

Monitoring Color Primaries rec709 Oui Oui Oui Oui Oui

Monitoring Coding Equations rec709 Oui Oui Oui Oui Oui

Monitoring Descriptions LUT:SL3SG3Ctos709.cube Oui Oui Oui Oui Oui

Camera Tilt Angle 2.70000 Oui – Oui – Oui

Camera Roll Angle 1.30000 Oui – Oui – Oui

Focus Distance 2296mm Opt – Opt – Opt

Aperture Value 3.14 Opt – Opt – Opt

Aperture Ring T Stop Position 2.8 + 3/10 Opt – Opt – Opt

Current Focal Length 0mm Opt – Opt – Opt

Hyperfocal Distance 219224mm Opt – Opt – Opt

Near Focus Distance 2273mm Opt – Opt – Opt

Far Focus Distance 2319mm Opt – Opt – Opt

Horizontal Field of View 27.9deg Opt – Opt – Opt
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Élément Exemple de notation dans RAW Viewer RAW/X-OCN MXF RAW/X-OCN XML ProRes MXF ProRes XML HD-SDI

Entrance Pupil Position +51mm Opt – Opt – Opt

Normalised Zoom Value 0.000 Opt – Opt – Opt

Lens Serial Number xxxxxxxx Opt – Opt – Opt

Iris F-Number 2.87 Opt – Opt – Opt

Iris T-Number 3.1 Opt – Opt – Opt

Iris Ring Position Opt – Opt – Opt

Focus Position from Image Plane 2.296m Opt – Opt – Opt

Focus Ring Position Opt – Opt – Opt

Macro Setting OFF Opt – Opt – Opt

Lens Zoom 35mm Still Camera Equivalent 85mm Opt – Opt – Opt

Lens Zoom Actual Focal Length 85mm Opt – Opt – Opt

Zoom Ring Position Opt – Opt – Opt

Anamorphic Lens Squeeze Ratio Opt – Opt – Opt

Optical Extender Magnification 100% Opt – Opt – Opt

Lens Attributes xxxxxxxx Opt Opt Opt Opt Opt

Cooke /i technology Opt – Opt – Opt

Cooke /i2 technology Opt – Opt – Opt

Cooke /i3 technology Opt – Opt – Opt

Zeiss eXtended metadata Opt – Opt – Opt

Description – – – – –

Circle – – – – –

Project – – – – –

Director Name – – – – –

Director of Photography Name – – – – –

Production – – – – –

Camera Index – Oui – Oui –

Reel – Oui – Oui –

Scene – – – – –

Cut – – – – –

Take – – – – –

Shot – Oui – Oui –

Mark In – – – – –

Mark Out – – – – –
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Licences

Accès au logiciel auquel 
s’applique la GPL/LGPL

Ce produit utilise le logiciel auquel s’applique 
la GPL/LGPL. Ceci vous informe que vous 
disposez d’un droit d’accès, de modification 
et de redistribution du code source de ces 
logiciels dans les conditions de la GPL/LGPL.
Le code source est disponible sur Internet. 
Reportez-vous à l’adresse Web suivante et 
suivez les instructions de téléchargement.
http://www.sony.net/Products/Linux/
common/search.html

Nous préférerions que vous ne nous 
contactiez pas au sujet du contenu du code 
source.

Pour le contenu de ces licences, raccordez 
l’appareil à un réseau et affichez l’écran 
OSS Information (page 105) sur l’écran de 
télécommande Web.

Licences de logiciels libres

Sur la base des contrats de licence entre 
Sony et les détenteurs des droits d’auteur du 
logiciel, ce produit utilise open software.
Pour satisfaire les exigences des détenteurs 
des droits d’auteur du logiciel, Sony a 
l’obligation de vous informer du contenu de 
ces licences.
Pour le contenu de ces licences, raccordez 
l’appareil à un réseau et affichez l’écran 
OSS Information (page 105) sur l’écran de 
télécommande Web.

http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
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Caractéristiques techniques

Spécifications générales

Poids MPC-3628 : environ 4,3 kg (9 lb 7,7 oz)
  MPC-3626 : environ 4,2 kg (9 lb 4,2 oz) 

(sauf la poignée, la fixation du 
viseur)

Dimensions
  Consultez page 155.
Exigences d’alimentation
  12 V CC (11 V à 17 V)
  24 V CC (22 V à 32 V)
Consommation électrique
  MPC-3628 : 

Consommation électrique 
nominale de l’appareil : environ 
76 W (enregistrement X-OCN XT, 
8.6K 3:2, 24 FPS, sans le viseur et 
les périphériques) 
Consommation électrique 
maximale de l’appareil : environ 
100 W (enregistrement X-OCN ST, 
8.2K 17:9, 60 FPS, environnement 
40 °C (104 °F), entrée CC 32 V, sans 
le viseur et les périphériques) 
Consommation électrique totale 
maximale : environ 220 W (entrée 
CC 22 V à 32 V, avec le viseur et les 
périphériques)

  MPC-3626 : 
Consommation électrique 
nominale de l’appareil : environ 
73 W (enregistrement X-OCN XT, 
6K 3:2, 24 FPS, sans le viseur et les 
périphériques) 
Consommation électrique 
maximale de l’appareil : environ 
94 W (enregistrement X-OCN ST, 
6K 3:2, 60 FPS, environnement 
40 °C (104 °F), entrée CC 32 V, sans 
le viseur et les périphériques) 

Consommation électrique totale 
maximale : environ 220 W (entrée 
CC 22 V à 32 V, avec le viseur et les 
périphériques)

Température de fonctionnement
  0 °C à 40 °C (32 °F à 104 °F)
Température de stockage
  –20 °C à +60 °C (–4 °F à +140 °F)
Durée de fonctionnement continu
  Environ 35 minutes (lors de 

l’utilisation du BP-GL95B)
Format d’enregistrement (vidéo)
 X-OCN XT
 X-OCN ST
 X-OCN LT
 ProRes 4444 4K
 ProRes 4444 QFHD
 ProRes 422 HQ 4K
 ProRes 422 HQ QFHD
Format d’enregistrement (audio)
 LPCM 8 canaux (enregistrement/lecture sur 

2 canaux), 24 bits, 48 kHz
Fréquence d’images de projet d’enregistrement
 X-OCN XT/ST/LT (MPC-3628) :
  8.6K 3:2
   29.97P/25P/24P/23.98P
  8.2K 17:9/5.8K 17:9
   59.94P/50P/47.95P/29.97P/25P/ 

24P/23.98P
  7.6K 16:9/5.4K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  5.8K 6:5
   47.95P/29.97P/25P/24P/23.98P
 X-OCN XT/ST/LT (MPC-3626) :
  6K 3:2/6K 1.85:1/6K 17:9/6K 2.39:1/4K 

6:5/4K 4:3/4K 17:9/4K 2.39:1
   59.94P/50P/47.95P/29.97P/25P/ 

24P/23.98P

  5.7K 16:9/3.8K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  4K 4:3 Surround/4K 17:9 

Surround/3.8K 16:9 Surround
   29.97P/25P/24P/23.98P
 ProRes 4444
  4K : 4096×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  QFHD : 3840×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
 ProRes 422 HQ
  4K : 4096×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  QFHD : 3840×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
Durée d’enregistrement/lecture
  Consultez page 138.

Caméra

Dispositif d’image
  Capteur d’image CMOS à puce 

unique, plein format 35 mm
Nombre de pixels
  MPC-3628 : 50,0 M (total)
  MPC-3626 : 24,8 M (total)

Filtres intégrés

Filtre ND A

Clear 0.3  
(1/2)

0.6  
(1/4)

Filtre ND B Clear Clear 0.3  
(1/2)

0.6  
(1/4)

0.9  
(1/8)

0.9  
(1/8)

1.2  
(1/16)

1.5  
(1/32)

1.8  
(1/64)

1.8  
(1/64)

2.1  
(1/128)

2.4  
(1/256)

Sensibilité ISO
  MPC-3628 :
   ISO 800
   ISO 3200
  MPC-3626 :
   ISO 500
   ISO 2500
Monture d’objectif
  Monture PL (avec adaptateur de 

monture d’objectif)
  Monture E (sans adaptateur de 

monture d’objectif)
Longueur focale de collerette
  Monture PL : 52 mm
  Monture E : 18 mm
Latitude MPC-3628 : 16 paliers
  MPC-3626 : 15+ paliers

Entrée/Sortie

Entrée audio
  CH-1/CH-2 : Type XLR à 5 broches 

(femelle) (1), LINE / AES/EBU /  
MIC / MIC+48V sélectionnable

Entrée CC Type XLR à 4 broches (mâle) (1), 11 V à 
17 V ou 22 V à 32 V CC
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Sortie CC (12 V)
  LEMO à 2 broches (1), 

11 V à 17 V CC (Tension de sortie : 
identique à la tension d’entrée, 
courant de sortie maximal : 1,0 A), 
22 V à 32 V CC (Tension de sortie : 
16,8 V, courant de sortie maximal : 
1,0 A), avec adaptateur de batterie

[Remarque]
Raccordez au connecteur 12V OUT uniquement les 
dispositifs avec une consommation de courant de 1,0 A 
ou moins.

Sortie CC (24 V)
  Fischer 3 broches (2), 

11 V à 17 V CC (Tension de sortie : 
24 V, courant de sortie maximal : 
1,0 A), 
22 V à 32 V CC (Tension de sortie : 
identique à la tension d’entrée, 
courant de sortie maximal : 2,0 A)

[Remarque]
Connectez uniquement au connecteur 24V OUT des 
périphériques dont la consommation de courant est 
égale ou inférieure à 1,0 A lorsque la tension d’entrée 
est de 11 V à 17 V, ou égale ou inférieure à 2,0 A lorsque 
la tension d’entrée est de 22 V à 32 V.

Sortie SDI Type BNC (4)
  3G-SDI : SMPTE ST424/425  

Level B-DL/DS
  HD SDI : conforme à SMPTE ST292
AUX Type BNC (1)
Sortie du viseur
  LEMO 26 broches (1)
Réseau Type RJ45 (1)
Télécommande
  8 broches (1)
Sortie MONITOR
  Type BNC (1)
  HD SDI : conforme à SMPTE ST292
Entrée de code temporel
  TC IN : type BNC (1)

Entrée GENLOCK
  Type BNC (1)
Sortie HDMI
  Type A (1)
Connecteur du périphérique externe
  Hôte USB : type A (1)
Sortie casque
  Mini-prise stéréo (1)
Sortie haut-parleur
  Monaural

Fentes pour support

Type Carte AXS-A (2)
  Cartes SD (1)

Accessoires fournis

Fixation du viseur (1)
Poignée (1)
Câble du viseur (1) (A-2203-745-A)
Cale (circulaire) (1) (4-730-328-11)
Cale (tiers de cercle) (15) (4-730-328-21)
Capuchon d’objectif à monture E (1)
Capuchon d’objectif à monture PL (1)
Cache pour bloc d’imageur 6K (1) (A-5040-737-A) 

(MPC-3628 uniquement)
Avant d’utiliser cet appareil (1)

Accessoires connexes

Viseur 0,7 pouce
  DVF-EL200, DVF-L700

Système d’extension de caméra
  CBK-3610XS
Adaptateur LAN sans fil
  CBK-WA02
Unité de télécommande
  RM-B170/B750
  RCP-1000/1500/1530/3500
  RCP-1001/1501/3100/3501
Lecteur de carte
  AXS-AR3
Adaptateur d’épaule (se fixe au VCT-14 grâce au 

sabot en V)
  VCT-FSA5
Objectif à monture E
  SELP28135G, SEL1224GM, SEL1635GM,
  SEL2470GM, SEL70200GM,
  SEL100400GM, SEL24F14GM,
  SEL35F14GM, SEL50F12GM,
  SEL85F14GM, SEL100F28GM
Pack de batteries
  BP-GL95B
Microphone
  ECM-680S, ECM-678*, ECM-674*

* Câble adaptateur EC-0.5X3F5M XLR 
3 broches à XLR 5 broches requis

Adaptateur de batterie double
  BKW-L200 (branchement grâce à 

l’adaptateur de branchement de 
batterie)

Moniteur SDI/HDMI
  Série BVM, série PVM, série LMD

La conception et les caractéristiques 
techniques sont sujettes à modification sans 
préavis.
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Dimensions

27,7 (1 1/8)

13 (17/32)

Ø5,2, Profondeur : 5
UNC 1/4-20, Profondeur : 9

2-UNC 3/8-16, 
Profondeur : 9

M3, Profondeur : 5,5

2-UNC 3/8-16, 
Profondeur : 9

UNC 1/4-20, Profondeur : 9

0,5 (1/32)
25 (1)

25 (1)

25 (1)
25 (1)

15,2 (5/8)
25 (1)
25 (1)
25 (1)
25 (1)

25 (1)
25 (1)

25 (1)
25 (1)

25 (1)
25 (1)

77 (3 1/8)

77  
(3 1/8)

16,5 
(21/32) 61,5 

(2 1/2)

61,5 
(2 1/2)

4,45 
(11/64)

14 
(9/16)

84 
(3 3/8)

22,6 (29/32)

61,4 (2 1/2)

25 
(1)

25 
(1)

25 
(1)

25 
(1)

25 
(1)

8,75 
(11/32)

50 
(2)

24 
(31/32)

25 
(1)

25 
(1)

25 
(1)

61,1  
(2 1/2)

20  
(13/16)

20  
(13/16)

30  
(1 3/16)

30,6 (1 1/4)
18 (23/32)

30  
(1 3/16)

M2.6, Profondeur : 8,5
(Contre-alésage Ø2,75 ; Profondeur : 3,3)

10-UNC 3/8-16, 
Profondeur : 10

10-UNC 1/4-20, 
Profondeur : 10

M3, Profondeur : 
5,5

64,6 (2 5/8)
176,3 (7)

250 (9 7/8) 216 (8 5/8)

19 (3/4)

2-M3, 
Profondeur : 5

4-M3, 
Profondeur : 5,5

4-M3, Profondeur : 5,5

2-M3, Profondeur : 5

Unités : mm 
(pouces)

135 (5 3/8)

UNC 1/4-20, 
Profondeur : 9

UNC 3/8-16, 
Profondeur : 79,25 

(3/8)

2-UNC 1/4-20

3-UNC 3/8-16

10-UNC 1/4-20, 
Profondeur : 11

8-M3, Profondeur : 5

152 
(6)

120 (4 3/4)
165 (6 1/2)

134 (5 3/8)

57,1  
(2 1/4)

57,1  
(2 1/4)

76 (3)

91,1  
(3 5/8)

80  
(3 1/4)

50,2  
(2)

73  
(2 7/8)

236,5  
(9 3/8) 158  

(6 1/4)
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Marques commerciales

 • Les termes HDMI et High-Definition 
Multimedia Interface ainsi que le logo 
HDMI sont des marques commerciales ou 
des marques déposées de HDMI Licensing 
Administrator, Inc. aux États-Unis et dans 
d’autres pays.

 • Tous les noms de système et les noms de 
produit sont des marques déposées ou des 
marques commerciales de leur propriétaire 
respectif. Les éléments de marques 
commerciales ne sont pas indiqués par les 
symboles ® ou ™ dans ce document.
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